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Preface

Welcome to the Oracle Service Contracts, Release 11i. This Concepts and 
Procedures provides information and instructions to help you work effectively with 
Oracle Service Contracts.

This preface explains how Concepts and Procedures is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

� Technical Service Representatives (TSR)

� Customer Service Representatives (CSR)

� System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

This guide assumes you have the following pre-requisites:

1. Understanding of the company business processes.

2. Knowledge of products and services as defined by your marketing policies.

3. Basic understanding of Oracle and Developer/2000.

4. Background in SQL, PL/SQL, SQL* Plus programming.

Document Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
xi



documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program web site at 
http://www.oracle.com/accessibility/. 

Structure
This document contains the following chapters:

Chapter 1 “Understanding Oracle Service Contracts” provides overviews of the 
application and its components, explanations of key concepts, features, and 
functions, as well as the application’s relationships to other Oracle applications.

Chapter 2 “Using Oracle Service Contracts” provides process-oriented, task-based 
procedures for using the application to perform essential business tasks. 

Chapter 3 “Implementing Oracle Service Contracts” provides general descriptions 
of the setup and configuration tasks required to implement the application 
successfully.

Related Documents
For more information, see Oracle Contracts Core Concepts and Procedures Release 11i.

Conventions
The following conventions are used in this manual:

Convention Meaning

    .
    .
    .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted

boldface text Boldface type in text indicates a term defined in the text, the glossary, 
or in both locations.
xii



< > Angle brackets enclose user-supplied names.

[ ] Brackets enclose optional clauses from which you can choose one or 
none.

Convention Meaning
xiii
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Understanding Oracle Service Contracts

This chapter provides overviews of the application and its components, 
explanations of key concepts, and features as well as the application’s relationships 
to other Oracle applications. Topics covered in this chapter include:

� Overview of Service Contracts on page 1-2

� Integration with Oracle Applications on page 1-6

� Overview of Authoring Contracts on page 1-9
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Overview of Service Contracts
1.1 Overview of Service Contracts
Oracle Service Contracts enables users to design, manage, and bill for service 
offerings tailored to their customers’ needs. All contracts are held centrally; 
subscriptions, warranties, extended warranties, or complex service agreements, 
thus providing the service provider visibility to all service entitlement information.

Oracle Service Contracts automates the contract process and provides access to 
information contained in other Oracle applications.

In addition to defining service line items in a contract, Oracle Service Contracts 
helps you define usage line items. For example, if a customer is renting a 
photocopier, the business can charge either on a per-copy basis or a fixed price. The 
business may set a minimum charge, and vary the price depending on volume.

Oracle Service Contracts provides support for businesses that manage 
subscriptions. This functionality tracks agreed upon terms, conditions, prices, 
discounts, billing schedule payment terms, renewal options, and fulfilment.

Oracle Service Contracts leverages functionality provided in Oracle Contracts Core 
to support common contract management activities such as contract renewal, 
versioning, article management, and change management. However, not all features 
that are available in Contracts Core are available in Service Contracts. Functionality 
such as subcontracting is provided by Contracts Core, but it is not supported in 
Service Contracts.

Service Contracts builds upon the foundation and adds functionality to meet the 
specific needs of the Service industry, such as coverage terms and entitlement 
checking. This modularized approach allows the Contracts suite to scale while 
leveraging common functionality in the foundation component.

Oracle Service Contracts supports multiple organizations, multiple currency, and is 
euro compliant.

The following list describes key features for Oracle Service Contracts:

Parties to a Contract
The primary focus in a service contract is the customer. While focusing on 
customers, Service Contracts enables the user to define additional parties. For each 
party on the contract, any number of contacts can be defined on the contract. Users 
can assign a role to each party, for example contract administrator, by selecting from 
the roles supplied with Oracle Contracts and can then further modify roles to suit 
specific business requirements. 
1-2 Oracle Service Contracts Concepts and Procedures



Overview of Service Contracts
Install Base Integration 
To simplify selecting the products covered by a contract, Service Contracts 
accommodates an expandable/collapsible set of data from the Install Base. Users 
can select any node or data item for inclusion in or exclusion from coverage. Once 
the products to be covered have been identified and included in a contract, any 
changes to them in the Install Base (transfer of ownership, replacement, or upgrade) 
will be reflected in the contract, ensuring that the information contained in the 
contract is in line with that in the Install Base.

To ensure a Subscription item is trackable within the Install Base, it is flagged in the 
item master as both Install Base Trackable and Subscription. Entries are added to 
the Install Base by Service Contracts during contract creation. A new item instance 
is created when an item with the Subscription category is saved on a contract. 
Currently no integration is provided from Install Base back to Contracts. Processes 
such as transfers and terminations, that are done in Install Base, have no effect on 
the contract. These actions should be handled within Service Contracts authoring.

Selling Usage
Service Contracts can contain definitions and selections of usage item—consumable 
items (paper for printers, cash for ATM machines) that customers may want to have 
replaced at regular intervals along with descriptions of service coverage (field 
service, customer support) to customers. Service Contracts integrates with a 
customer's installed base to obtain actual usage information for products covered in 
a contract. 

Billing Usage
Customers can choose to pay for actual quantities of products they use, pay for a 
fixed quantity, or value each billing period. If a customer chooses to be billed for 
actual usage but usage numbers are not received in time to issue an invoice, default 
values can be used in place of actual numbers. Default values can be defined based 
on an average of historical readings, otherwise known as the Average Monthly 
Counter Volume.

Service Contracts can contain usage price breaks for varying the price applied 
depending on the volume used and can also specify a minimum quantity. For 
example, customers are charged for a minimum of 1,000 units, regardless of the 
actual quantity they use. 

Bill Settlement 
Service Contracts can handle tasks such as complex billing scenarios using a flexible 
billing schedule that enables you to create billing periods of any duration, and bill 
Understanding Oracle Service Contracts 1-3



Overview of Service Contracts
or not bill for the period as necessary, controlling the amount billed at every step. 
Users can customize the billing process further by defining bill settlement, invoice 
averaging, and billing profiles. 

Billing Profile 
Oracle Receivables allows the setup of billing information at the customer level, 
however, the billing profile in Service Contracts enables customization of billing 
requirements at the contract level. It includes such details as how customers wish to 
be billed, by fax or mail, and whether bills should be summarized. 

Billing Interface 
For both contract and usage billing for agreements authored in Service Contracts, 
users can send invoice amounts directly to Oracle Receivables, which then 
generates invoices from the pricing at the header level and line, based on the 
invoicing rules. Users can retrieve invoice information back from Oracle 
Receivables for updating contract billing histories. Customers can also have direct 
visibility to invoice information through Oracle iReceivables

Events 
The Events component is a combination of actions, conditions, and outcomes that 
allows users the flexibility of handling a diverse range of event-related scenarios. 
This component is available not only to Oracle Contracts, but to any Oracle Service 
application. For example, if an important event happens, the user may want to 
automatically initiate a task, service request, workflow, or other type of procedure if 
certain conditions are met. 

Using product and service counters, the events component can track product and 
service usage. Users can define events at periodic intervals or events that depend on 
a particular counter usage to specify when required actions should occur. Events 
can initiate workflow processes or any other predefined functions for example, a 
preventive maintenance visit could be scheduled when a product counter reaches 
1,000, or a support contract may cover a certain number of free calls, that can be 
tracked by using a service counter, or when milestones in call volumes are reached, 
defined events can trigger a change in billing rate or terminate a customer’s 
contract. Events can be based on actions for example, a contract signed, terminated, 
a change request initiated, or date-based for example a contract expiration date. 

Entitlement Processing 
The contract service line defines the resource, support, or service to which a 
customer is entitled to. Depending on the type of service required when the 
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Overview of Service Contracts
customer calls, this may include access to tangible or intangible resources, 
maintenance, repair, or replacement. In addition to the basic functionality of 
checking entitlements, such as finding out if customers are calling during covered 
hours or finding agreed reaction times, a separate component of Service Contracts 
allows other applications to view the coverage for particular contracts. Entitlement 
information is available to any Oracle application such as, Customer Support, Field 
Service, and Depot Repair. 

Contract Management
Service Contracts provides contract management features for streamlining and 
proactively controlling contract actions such as renewals and terminations. 

The auto renewal feature enables users to specify a period of time prior to 
expiration for renewing a contract. For example, the renewal process can be set up 
to automatically pick up a contract prior to its expiration date and begin the 
renewal process.

Once a contract is terminated, certain actions need to be taken. Service Contracts 
lets users enter the reasons for termination and any other notes that need to be 
tracked regarding the circumstances of the termination. It calculates the final credit 
or debit, allows the user to override that value if necessary and sends it to Oracle 
Receivables for issue to the customer.
Understanding Oracle Service Contracts 1-5
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1.2 Integration with Oracle Applications
The following diagram illustrates the integration of Oracle Service Contracts with 
other Oracle applications.

Figure 1–1 Oracle Contracts Integration with other Oracle Applications

1.2.1 Product Dependencies
Oracle Contracts Core provides the foundation for Oracle Service Contracts and is a 
required product. Oracle Order Management is required for subscription, warranty, 
and extended warranty management as it provides information from the sales order 
on associated services that have been purchased. Oracle Quoting is included as part 
of the CRM Foundation and is necessary to interface product and service 
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Integration with Oracle Applications
information from Oracle Order Management to the Install Base and to Service 
Contracts. Oracle Pricing is required to retrieve pricing information for services or 
usage purchased on the contract as well as to use advanced features such as 
modifiers. Oracle Bills of Material provides information on any warranties that are 
to be included as contracts. Oracle Inventory is required to define service and usage 
items. Oracle Service Core provides installed base information for the covered 
products of the contract. Oracle Contracts also integrates directly with Oracle 
Receivables for contract billing and Oracle iReceivables for self service visibility to 
invoice information. For tax calculation, Oracle Service Contracts integrates with 
Oracle Receivables Global Tax engine and make the sales tax amount readily 
available when authoring a contract. Integration of Oracle Service Contracts with 
Oracle iReceivables provides drill down capability and enables customers to view 
the invoice details online. Integration of Service Contracts with Oracle Advanced 
Service Online enables you to view the history and activities of any Preventative 
Maintenance program.

1.2.2 Contract Creation Via Install Base
When a new product, with associated warranty, is added to Install Base, a Warranty 
contract is created. To view the contract in Install Base, query the product number 
and select the Contracts link. The Contact Detail page displays the covered 
products. 

1.2.3 Integration with Order Management

1.2.3.1 Warranty
A Warranty contract is created when a Serviceable product is shipped. A Warranty 
contract is created when serviceable product with bill of material contains a 
warranty. You can view the new contract in Install Base and Service Contracts. The 
contract start date is set to ship date plus any delay time that is defined for the 
warranty in the Item Master. Whenever possible, where multiple products are sold 
on one order, one warranty is created for all the products. Each different warranty 
item creates a separate warranty line on the contract. 

1.2.3.2 Extended Warranty
An Extended Warranty contract is created when an Extended Warranty is sold on a 
sales order. You can modify certain fields on Extended Warranty contracts, though 
changes to the contract will not impact the value or billing for the contract. 
Extended warranty contracts can also be consolidated.
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1.2.3.3 Subscription
Fulfillment starts after the contract approval process. Driven by each subscription 
line’s instantiated fulfillment template, a concurrent program creates a sales order in 
Oracle Order Management for each delivery. The order details are  populated with 
information from the subscription agreement. Once the order is created in Order 
Management, you can release and ship them using Oracle Order Management.

The integration to Oracle Order Management is bidirectional. Item and fulfillment 
details are sent to Order Management to create a sales order. Delivery and status 
details are sent from Order Management, when the order is ship confirmed, to be 
stored in the Subscription contract.
1-8 Oracle Service Contracts Concepts and Procedures
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1.3 Overview of Authoring Contracts
Contract authoring involves the creation of a contract from defining an offering to 
obtaining customer approval on the pricing, coverage, and other terms and 
conditions set up in the contract. 

See Creating Contracts for the procedure to author a contract.

1.3.1 Contract Definition
Contract definition involves the authoring of the contract from scratch or by using 
an existing contract as a starting template. Defining a contract requires the 
following steps:

1. Select customer information, including bill-to and ship-to addresses.

2. Define the duration of the contract and the price list used for pricing services in 
the contract. The total price of the contract is the sum of the prices of individual 
service lines. The amounts are automatically applied to services rolled up in the 
total contract price.

3. Assign billing information such as the schedule of when and how much to bill 
the customer. The billing engine can calculate amounts or you can define it 
manually as well as decide when it is sent to Oracle Receivables. If a contract 
line is terminated, then the billing engine automatically adjusts the amount that 
needs to be sent to Oracle Receivables.

4. Select and price the service, usage and subscription lines, provided as part of 
the contract and identify the products covered.

5. If applicable for service lines, edit the coverage times, response, and resolution 
times and customer entitlements that defaulted from the coverage template. For 
example, the time of coverage could be 9 to 5, five days a week, with a two hour 
response and eight hours to resolve the issue. The discounts are defined on 
transactions that can be handled through a service that the customer has 
purchased, for example, a 9 to 5, 10 percent discount on material. The service 
includes a replacement transaction that includes the labor and material being 
used. The customer would then receive a 10 percent discount, defined in the 
coverages, for the material used in the replacement transaction and no 
discounts on labor charges. For subscription lines, verify or modify the delivery 
schedule defaulted from the subscription template.

6. Approve the contract.
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Using Oracle Service Contracts

This chapter provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. Topics covered include:

� Defining Offering Management on page 2-2

� Defining Services and Usage on page 2-7

� Pricing Service and Usage on page 2-11

� Selling Products and Services in Order Management on page 2-17

� Authoring on page 2-30

� Billing on page 2-70

� Reviewing Entitlements on page 2-84

� Managing Contracts on page 2-86
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Defining Offering Management
2.1 Defining Offering Management
Your customers are unique. To define an individual contract from scratch for every 
customer is not practical. To balance efficient contract creation with the unique 
needs of your customer, Oracle Service Contracts provides Offering management. 
This permits standard service offerings to be defined in advance, while allowing 
them to be tailored to a customer’s needs in the actual contract. For example, you 
can offer gold, silver, and bronze support options, each of which represents a set of 
available offerings. 

Offering selection involves determining which offering most closely matches the 
customer’s needs from all the current offerings, then configuring it for the 
customer’s needs.

You can add or update offerings any time. The offering updates affect only new 
contracts authored from the offerings; they do not affect existing contracts.

This section includes the following information:

� Service Coverage

� Coverage Templates

� Defining Warranty Inheritance for Coverage

� Coverage Process Flow

2.1.1 Service Coverage
Service coverage describes the situation under which the customer is covered for 
service. Services are broken down into business processes that can apply to the 
service (such as customer support, depot repair, and field service). Coverage terms 
are then defined for these business processes.

Coverage reflects the service request reporting time stated in days or hours, and the 
repair expenses. By setting effective start and end dates, you can phase in or phase 
out a particular coverage. You can specifically define covered monetary amounts for 
each service. 

2.1.2 Coverage Templates
Oracle Service Contracts enables you to define a standard set of templates, to create 
contracts for a common set of agreements used by your organization, or create new 
and modified types of contracts to meet your customers’ requirements. The 
coverage template defines the times of coverage, days of coverage, reaction and 
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resolution times for a service request, preferred resources, and the bill types and bill 
rates that are covered.

For example, you can have a Gold coverage template which covers hotline support 
and onsite support business processes. The hotline support includes 24 hours, 7 
days a week support with 2-hour reaction time for high priority requests and the 
onsite support includes 9-to-5 coverage, 5 days a week. As part of defining 
coverages, you also define the coverage for entitlements. For example, the onsite 
coverage covers a transaction type of replacement and for a replacement 
transaction, the customer is charged for material and labor. You define coverage that 
you want to give to a customer, such as a 10 percent discount on material, and a 5 
percent discount on labor up to $500.

In addition, a Preventive Maintenance (PM) program may optionally be linked to a 
coverage template which, when instantiated in a contract, includes the schedule 
(Date or Date Ranges) to perform activities associated to the PM program as part of 
preventive maintenance. The preventive maintenance schedule is created in a 
manner similar to the billing schedule using one or more streams.

If appropriate, prior confirmation from the customer may be required to schedule 
the preventive maintenance service request. This is executed via a check box 
provided as part of program schedule definition in the coverage.

See Coverage Process Flow for flow diagrams.

See Defining Coverage Templates for setting up coverages.

2.1.3 Defining Warranty Inheritance for Coverage
In the Service Contracts Coverage Template window you can set inheritance criteria 
that determines how warranty coverage should behave when a product has been 
replaced. This is applicable only to Warranty lines so Warranty must be checked 
before you can enter this field. Inheritance type R (Replacement) means the 
warranty on the replacement part is good for the remainder of the original warranty 
duration. Type F (Full) means the replacement part receives a new warranty for the 
full duration of the covered period.

Example Warranty Line:

Desktop Warranty 1/1/2001 - 12/31/2001

CUSTOMER PRODUCT ID - 100

1/1/2001 - 12/31/2001

Scenario 1: Warranty inheritance type is R
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Customer Product ID 100 was returned for a replacement with Customer 
Product ID 894 on 3/3/2001.

Then the above warranty line is updated as follows:

Desktop Warranty 1/1/2001 - 3/2/2001 (Expired)

CUSTOMER PRODUCT ID - 100

1/1/2001- 3/2/2001 (Expired)

Desktop Warranty 3/3/2001 - 12/31/2001

CUSTOMER PRODUCT ID - 894

3/3/2001 - 12/31/2001

Scenario 2: Warranty inheritance type is F

Customer Product ID 100 was returned for a replacement with Customer 
Product ID 894 on 3/3/2001.

Then the above warranty line is updated as follows:

Desktop Warranty 1/1/2001 - 3/2/2001 (Expired)

CUSTOMER PRODUCT ID - 100

1/1/2001 - 3/2/2001(Expired)

Desktop Warranty 3/3/2001 - 3/2/2002

CUSTOMER PRODUCT ID - 894

3/3/2001 - 3/2/2002

2.1.4 Coverage Process Flow
The following diagrams highlight the difference between a coverage template and 
an actual instance of coverage. The first diagram highlights the different process 
steps involved in both, and the second diagram highlights the structural differences 
between both.
2-4 Oracle Service Contracts Concepts and Procedures



Defining Offering Management
Figure 2–1 Coverage Process Flow
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Figure 2–2 Structure for Instance of Service Contracts
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2.2 Defining Services and Usage
Services are items defined in the item master that determine the coverage terms that 
are given or sold to a customer. Coverage Templates must be defined before you can 
create a service item. Services that are given to the customer free of charge, since the 
price is assumed to be included in the price of the associated product, are called 
Warranties. All other services may have a price associated with them and can be 
sold on a sales order or via the contract authoring form. If a service item is sold via 
the sales order process, the resulting contract is termed an Extended Warranty. If a 
service item is sold via the contract authoring process, the contract is termed a 
Service Agreement.

A service that can be provided as a warranty is distinguished from other services by 
the attributes that are set on the item master.

2.2.1 Warranties
After a warranty has been defined, it must be associated with a serviceable product 
in the Bill of Materials for a warranty contract to be automatically created (refer to 
the Oracle Bills of Material Concepts and Procedures Guide for further information). 
When that product is shipped or is otherwise created in the installed base 
(manually), the warranty is automatically created in Oracle Service Contracts. 
Warranties allow a support service to be automatically associated with a product. 
The warranty record is automatically associated with the customer product in the 
installed base upon ordering and shipment of the product to the customer. 

Each serviceable product can be shipped with one or more base warranties defined 
as components in the product’s bill of material. The table below highlights the main 
differences between warranties and extended warranties.

Warranties Extended Warranties

Non-orderable and managed automatically Can be ordered as an immediate or 
delayed service

Cannot be authored, can only be created by 
integration with Order Management or 
Instal Base

Can be authored or created via the 
Order Management interface

Do not have a cost Have unit or percentage based pricing

Associated with serviceable items in Bill of 
Materials (BOM)

Are not included in a BOM

Have warranty inheritance rules Do not have warranty inheritance rules
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2.2.2 Defining Serviceable Products
For a product to be covered on a service agreement, subscription, warranty, or 
extended warranty, the product item has to be classified as a serviceable product. 

Prerequisites
Product items must be created using Oracle Inventory.

To Define a Serviceable Product:
1. From the Responsibilities menu select, Inventory > Items > Master Items (T) 

Service.

2. Select the Serviceable Product check box to identify this product as being 
serviceable.

3. Select the Coverage Template that should be associated with this product.

4. Optionally, enter the number of days after shipping that the service goes into 
effect in Service Starting Delay.

5. Identify whether this item is material, labor, or expense in Billing Type.

6. If defects for this item are to be tracked, then select Defect Tracking Enabled.

7. Select the speed in which an item is returned for Recovered Part Disposition.

8. Save your changes. The product item is now a serviceable product.

2.2.3 Defining Subscription Products
A tangible subscription item may be setup like any other inventoried product.  You 
may enable Work In Process, Bill of Materials and other options for the product.  In 
addition to setting the item up as a tangible product, define the Contracts-related 
properties listed below.

Prerequisites
A Subscription template must be created. 

Cannot be renewed, can be extended or 
terminated

Can be renewed, extended or 
terminated

Warranties Extended Warranties
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To Define a Subscription Product:
1. From the Responsibilities menu select, Inventory > Items > Master Items (T) 

Service. 

2. Select the Serviceable Product check box to identify this product as being 
serviceable.

3. Select the Subscription Template that should be associated with this item.

4. Identify the Bill Type as Material.

5. For both Tangible and Intangible subscription items, select the Install Base 
Trackable check box.

6. If defects for this item are to be tracked, then select Defect Tracking Enabled

7. Select the speed in which an item is returned for Recovered Part Disposition

8. Save your changes. The subscription item is now an inventory part as well as a 
serviceable product.

2.2.4 Master Item Field Definitions
The table below displays the field descriptions for master service items.

Field Description

Main Tab - 

Unit of Measure The unit of measure must be time based, since a service 
is to cover a set period of time.

Service Tab  -

Contract Region  Information for creating Service Items

Contract Item 
Type

Select Service, Subscription, Usage or Warranty from the 
LOV.

Duration Period Select the Service Duration Unit of Measure (e.g. hour, 
day, month, etc.). 

Duration Enter the default duration of the service. For example, if 
the service should default to 1 year, set the duration 
period as year and the duration as 1. This may be 
overridden when selling the service on a sales order or 
on the contract.
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Template Select the template to be associated with the service, 
subscription or warranty from the list of values. (Do not 
select a template for a usage item.) For Service items, 
this creates a one to one relationship between the service 
item and the coverage so that the service can be priced 
appropriately. For example, you may wish to charge 
more for a 24X7 type of coverage than you would for a 
9X5 coverage. For Subscription items this defines the 
fulfillment schedule defaults.

Subscription 
Dependency 
Enabled

This check box is specific to items being created for use 
with the Service for Communications module. Check 
this box to identify the item as one which is eligible to be 
a parent item which can have children assigned to it.

Serviceable 
Product Region

 Information for creating Serviceable Items

Serviceable 
Product

Mark this check box if the item being created is a 
product that is eligible to receive service.

Billing Type Indicate whether the customer is charged for the 
following:

Material: material usage expenses your support 
organization incurs while providing the service.

Labor: labor expenses your support organization incurs 
while providing the current service.

Expense: incidental expenses your support organization 
incurs while providing the current service.

Defect Tracking 
Enabled

Check this box if defects should be tracked for this 
product.

Recovered Part 
Disposition

Indicate if replaced parts are to be recovered and how 
quickly.

Starting Delay 
(Days)

Enter the number of days after the product is shipped 
that the warranty or extended warranty should become 
active. 

BOM Tab - 

BOM Allowed Ensure the BOM allowed check box is selected if the 
service is a warranty.

Invoicing Tab  -

Field Description
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For additional information see the Oracle Inventory User’s Guide chapter on Items, 
Service Attribute Group.

2.2.5 Defining Usage
As well as selling services on a service agreement, usage can be sold, such as copies 
on a printer or supports calls to be made. Usage must be defined as an item in the 
item master to be priced and sold on a contract.

Steps
1. From the Responsibilities menu, select Inventory > Items > Master Items (T) 

Service.

2. Check the usage item check box to identify this item as a usage item.

3. Save your changes.

2.3 Pricing Service and Usage
This topic group includes the following:

Service Pricing

Usage Pricing

Usage Item Price Breaks

Defining Usage Price Breaks

Invoicing 
Enabled

Select this check box if the item is to be sold to 
customers (not a warranty) such as, an extended 
warranty contract, a subscription, or a service 
agreement.

Order 
Management 
Tab

- 

Customer Orders 
Enabled

Select this check box if the service can be ordered 
externally.

Internal Orders 
Enabled

Select the check box if the service can be ordered 
internally.

Field Description
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2.3.1 Service Pricing
The list price of a service is defined in Oracle Pricing through price lists. Fixed or 
variable values can be assigned to each service program. Fixed prices are expressed 
as actual prices on the price list. Variable prices are expressed as a percentage of the 
list price of the serviceable product. When sales orders are entered in Oracle Order 
Management for ordered service programs, Oracle Order Management references 
the appropriate price list to find or dynamically calculate the price of the ordered 
service program. Service can be in multiple price lists for example, corporate, 
standard, seasonal list with different list prices. However, only one price list can be 
associated with a contract at any given time. There are two main methods for the 
pricing of services:

� Unit-Based Pricing: Prices are based on a fee per period for service

� Percentage-Based Pricing: Prices are based on a percentage of the list price of 
the product(s) that is being covered

The mechanism works as follows: first, a price list is associated with a contract. 
Then, when services are entered into a contract, a price can be retrieved from Oracle 
Pricing either in the form of a list price (for unit-based pricing) or a percentage (for 
percentage-based pricing). In computing an extended price, a number of factors 
must be considered whether:

� Price needs to be applied to the number of products covered

� Price needs to be applied to the duration of the contract or service

For example, consider a service priced using unit-based pricing at $100 per month. 
If the service duration is 12 months, and the coverage is for 50 pieces of equipment, 
then the extended price is:

� $100 per month x 12 months x 50 installed base items = $60,000

In the same example, priced using percentage-based pricing at 10% per month 
where the list price is $1,200. For the same duration of 12 months and coverage for 
50 pieces of equipment, then the extended prices is:

($1,200 x 10%) x 12 months x 50 installed base items = $72,000

Once a price has been retrieved from the price list, you can manually override that 
price by entering a value in the subtotal field for that subline.  Prices entered 
manually can be positive or negative values. 
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2.3.1.1 Discounting and Applying Surcharges
Prices on a contract may also be discounted or increased using Oracle Pricing by 
applying modifier lists either automatically or manually. Qualifier lists may be used 
to determine when to automatically apply certain modifier lists. Modifiers can 
uplift as well as discount pricing. 

Please refer to Oracle Pricing User’s Guide for information on setting up and using 
Modifiers and Qualifiers. 

Also refer to the Oracle Service Contracts Concepts and Procedures Guide for 
information on Pricing Adjustments.

2.3.1.2 Covered Levels and Pricing
Covered Levels define the level of product coverage and include the following 
types:

� Covered Site: Cover all products at a particular customer site.

� Covered Item: Cover all products of a particular item type for the customer (for 
example, all Dell PC’s, Model: OptiPlex GXa). Items are defined in the 
inventory item master.

� Covered Product: Cover a particular product from the customer’s installed base 
(for example, Dell PC, Model: OptiPlex GXa, Serial #123456789).

� Covered System: Cover a particular system configuration.

� Covered Customer: Cover products for that customer account.

� Covered Party: Cover products for that party.

If the covered level is Covered Product or Covered Item, then the price of the 
product is obtained from the price list. In all other cases you must manually enter 
the price. 

2.3.2 Usage Pricing
Usage is an item in the item master and is priced on a price list defined in Oracle 
Pricing. Usage tracks the customer’s use of a product or service. You can define 
counters to monitor the usage of customer products and services and execute 
business processes based upon the usage information. Common everyday objects 
that have counters are automobiles (the odometer), gas meters, and photo copy 
machines. Examples of service counters include the number of calls made to a help 
desk or visits to a health club. Counters provide a mechanism for tracking new 
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product warranties, service contracts, support agreements, and similar business 
needs. 

Counter group templates are defined for groups of counters and are associated with 
products or services. A product or service can only have one Counter Group 
association. Once the Counter Group is created it can be modified for an instance or 
for all instances. Counters are automatically made when a customer product is 
created in Install Base or when service item that is associated with a counter group 
template in the item master is placed on a contract line. Counters cannot be 
manually created.

Counters may be defined in any of four types:

� Regular: These represent the physical counters found in tangible objects like 
automobiles, gas meters, photo copy machine, etc. But counters can also track 
events that take place but they are not associated with a piece of equipment. For 
example, if the number of service calls per customer is tracked manually you 
would setup a counter of type Regular and have the agents increment the 
counter after each call.

� Group function: This type enables you to derive counters using SUM and 
COUNT. Group Function counters can be used in Formula Counters.

� Formula: Formula type counters enables you to use simple math to derive the 
counter value. For example you may have a photocopy machine that provides 
black & white copies and color copies. You may wish to track the total number 
copies. You would create a Counter Group with three Counters:

� A Regular counter for total black & white copies

� A Regular counter for the total color copies

� A Formula counter for the total black & white + the total color copies

� Time Based: Time based counters are updated by a concurrent program, Time 
Based Counters Engine, based upon the unit of measured assigned. For 
example, you may wish to count the number of months since the product or 
service was purchased, the number of weeks since the last maintenance, etc. 

Product counters are created when you create a customer product instance in Install 
Base through the Create Customer Product form of Oracle Customer Support or 
from the Add a Product feature of Oracle iSupport. In the same manner service 
counters may be created upon the creation of a service contract, such as warranty, 
extended warranty, and service agreement.
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The Counters readings can be captured manually from the Capture Counters User 
Interface (UI). The Capture Counter reading UI is available from the Service 
Request UI, Field Service UI, or the Service Contracts Authoring UI. 

The pricing for usage of products and services (tracked by counters) involve the 
following:

� Products and services that are priced and tracked by counters should be 
defined as items in Oracle Inventory.

� The pricing of usage is defined in Oracle Pricing using price lists via price 
breaks. Usage can be in multiple price lists (i.e. corporate, standard) with 
different list prices. 

� In Oracle Service, counter templates (groups, counters, properties) should be 
defined and associated with either products or services.

� While authoring contracts, it is necessary to select the price list at the contract 
header level. This price list is used to price usage and service lines. If selected 
from the price list Oracle Service Contracts creates a pricing rule and stores the 
price for a service line. However, this is not the case for usage lines. While 
billing, the amount to be billed is calculated through Oracle Pricing. Oracle 
Service Contracts also supports overriding the price break by entering a 
negotiated amount which supersedes the calculated amount based on price 
breaks.

2.3.3 Usage Item Price Breaks
Similar to any items defined in the item master, usage items are set up in the price 
list. Price breaks are set up by defining the line as Price Break Header that allows 
the entry of price breaks. In addition, the Price Break Type is defined as either Point 
or Range method. Point method designates that pricing is based on a specific range 
in the price break. Range designates that pricing is based on all the price break 
ranges up to the level corresponding to the counter reading. 

The following example distinguishes the difference between Point and Range price 
break types for a net counter reading of 3500 copies:

Break Price

0-1000 $.05

1001-3000 $.04

3001-5000 $.03
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2.3.4 Defining Usage Price Breaks
After setting up the usage item, price breaks are set up in a price list that will be 
used for contract pricing.

Prerequisites
The usage item must be created using Oracle Inventory. The price list must be 
defined using Oracle Pricing.

To define a price list:
1. From the Responsibility menu select Pricing > Price Lists and Discounts > Price 

Lists > Price List Set Up.

2. Query the applicable price list. Navigate to the List Lines tab to enter the usage 
price breaks.

3. Enter Item for Product Context.

4. Enter Item Number for Product Attribute.

5. Enter the item name, i.e. QP-LPTR-U, for Product Value.

6. Enter Ea as the Unit of Measure (UOM).

5001-10000 $.02

Point Amount

3500 Xs $.03 $105.00

Total Invoice $105.00

Range Amount

1000 Xs $.05 $50.00

2000 Xs $.04 $80.00

500 Xs $.03 $15.00

Total Invoice $145.00

Break Price
2-16 Oracle Service Contracts Concepts and Procedures



Selling Products and Services in Order Management
7. Enter Price Break Header for Line Type.

8. Enter Point or Range for Price Break Type.

9. Click Price Break to enter the price breaks.

10. Enter the break ranges as required in the Value From and Value To.

11. Enter the price for each range.

12. Click Save to commit and close the window.

References
� Refer to the Oracle Service Concepts and Procedures for instructions on how to 

create the a counter group template and the different types of counters. 

� Refer to the Oracle Service Concepts and Procedures for instructions on how to 
manually create a customer product.

� Refer to the Oracle iSupport Concepts and Procedures for instructions on how 
to manually create a customer product.

2.4 Selling Products and Services in Order Management
When ordering a serviceable product in Oracle Order Management, if it has an 
associated warranty it will be automatically created as a contract when the product 
is shipped. At the same time a serviceable product is placed on a sales order, 
associated services may also be sold which will be interfaced to Oracle Service 
Contracts as Extended Warranties. 

This section covers the following information:

� Automated Creation

� Flexible Service Programs

� Activating Service

� Service Coverage

� Controlled Service Availability

� Ordering Service Programs

� Cotermination

� Warranties and Extended Warranties

� Warranty and Extended Warranty Process Flow
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� Contract Details at Order Management

� Order Cycle

� Warranty and Extended Warranty Consolidation

2.4.1 Automated Creation
Warranties and extended warranties can be automatically created with the act of 
selling goods or services. Integration with Oracle Order Management facilitates this 
process. When a product is ordered, if it has an associated warranty in the bill of 
materials, then the warranty contract is automatically created. Likewise, if a 
customer chooses to buy extended service on their products, then the information 
regarding the service to be supplied is passed to Service Contracts.

Additionally, warranties can be created automatically when a product that includes 
a warranty is added to the Install Base manually. 

2.4.1.1 Serialized Products
When products are serialized, a separate item instance in Install Base is created for 
each item ordered. For example, when quantity of three is ordered of a product, for 
each serial number an item instance is created in Install Base. A single Warranty 
contract is created with one warranty line and one subline for each item instance. In 
this case three sublines are created under that one line. A separate Extended 
Warranty contract is created for the order with one subline for each item instance.

Note: The CSI Auto-split Instances During Instantiation profile option does not 
apply when products are serialized. The reason is, serialized products already 
create separate item instances. 

2.4.1.2 Partial Shipments
When partial quantity of a booked order are shipped, only one contract is created. 
At the time the remaining items are shipped, new sublines are created for the 
additional products under the appropriate line (or if the item is covered by a 
different warranty, a new warranty line is created). The Warranty or Extended 
Warranty contract is signed and the Active or Hold status is updated. If the 
Warranty or Extended Warranty is expired when the remainder of the order is 
shipped, the contract duration is extended to accommodate the subsequent 
shipments by adding new lines and sublines. If the Warranty or Extended 
Warranties is terminated or canceled, a new agreement is created.

All of your contractual commitments, whether from warranties, extended 
warranties, or detailed service contracts, are gathered together in one central place. 
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By including warranties and extended warranties within Oracle Contracts, all the 
flexibility, automation and entitlement processing functionality is available to be 
fully leveraged

2.4.2 Flexible Service Programs
Oracle Service Contracts can be used to create, maintain, and administer as many 
service programs as are necessary to meet the service needs and price expectations 
of each market segment.The following scenarios describe how service programs can 
be used to provide customer support:

2.4.2.1 Provide targeted support based on product characteristics.
To support a low-priced, high-volume product you can define a service 
program for hotline support. To support a more complex, higher-priced product 
you can define a service program for onsite support.

2.4.2.2 Provide multiple service programs to support the same product.
A customer who uses your product for critical applications can purchase a 
service program that ensures support 24 hours a day, seven days a week, while 
a customer who uses the product for less critical applications can purchase a 
service program that limits support to weekdays.

2.4.2.3 Allow customers to purchase multiple service programs for the same 
product.

One service program may not satisfy all of a customer’s needs, so a customer 
can purchase multiple service programs for the same product. Should your 
customer want both hotline support and regular preventive maintenance, you 
can define two different service programs that can be attached to the same 
customer product.

Defining service programs that support the unique needs of each market segment 
allows you to meet all customer expectations. For example, using Oracle Order 
Management, each service program can be priced to achieve the market penetration 
and volume that needed to sustain the growth of your organization. 

Service programs also let you design mass customizing solutions. You can provide 
service solutions that not only satisfy customers but also help to retain and generate 
additional business. To ensure better administration, the availability of service 
programs can be controlled by product, by customer, or a combination of both. To 
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simplify the management of service programs, a group of service programs can be 
coterminated at the same time, so that they can also be renewed at the same time.

Oracle Service Contracts enables status tracking of each service program purchased 
by a customer regardless of the time of its purchase. Customers can order service 
programs at the same time as a product order, or later when the customer requires 
support. Expiring service programs can also be identified and customers notified, in 
order to prevent any breaks in the support services they receive by using Events.

2.4.3 Activating Service
Oracle Service Contracts offers several ways to activate the support services 
customers receive. During order entry, start and end dates can be specified for 
service programs, or the start date alone can be specified, with Oracle Order 
Management determining the end dates from service program duration 
information.

The Service Starting Delay can be defined as an attribute of the serviceable products 
when they are defined in Oracle Inventory. The Service Starting Delay represents 
the time, in days, a service program or warranty should commence after the 
shipment date. For example, a radio has a service starting delay of five days. If the 
radio ships on January 15, five days are added to the shipment date and the service 
program starts on January 20. The start date of the warranty is the ship date plus 
the starting delay. The end date is calculated by adding the duration to the start 
date of the support service.

2.4.4 Service Coverage
Service coverages list the actual days during the week and hours during the day 
when customers are covered under their contract for services they request. The 
definition of a service coverage also determines what percentages of labor, material, 
and expenses are covered, and whether a maximum limit exists for each. As many 
coverages as necessary can be defined, then each associated with a service program 
or warranty. Because service personnel have on-line access to all customer service 
information, they can easily verify whether customers are contacting them at 
authorized times, or whether material, labor, and expenses are covered by a support 
service.

2.4.5 Controlled Service Availability
By default, a service program is available to be assigned to any serviceable product. 
If necessary, the availability of a service program can be restricted by product, party, 
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or both. For example, your company still sells Product ABC because it has 
refurbished products in stock. However, since the items are refurbished, you do not 
want people to sell your extended warranty package A123. You can define the 
Service Availability form to identify that package A123 can be sold on any product 
except ABC, or you may wish to create a special support service, X23, for product 
ABC and define Service Availability to indicate that service X23 is only available for 
product ABC. 

By default, a serviceable product does not include a warranty unless the warranty is 
specified as a component in the product’s bill of material. 

Service availability by product is available regardless of whether the product is in 
the installed base. It is applicable for the covered levels of covered item as well as 
covered product. These restrictions will be highlighted when the QA check is 
executed in the Service Contract Authoring form.

2.4.6 Ordering Service Programs
As sales orders are entered for serviceable products, one or more service programs 
can be selected to cover each serviceable product. Ordering service at the same time 
as ordering the serviceable product is termed Immediate Service. For immediate 
service the reference type on the sales order line for the service is ORDER. The 
service is associated with the appropriate serviceable product by selecting the order 
number and the line number where the product is sold. The product may be on a 
different order than the service. The serviceable product and its service programs 
will then be on the same sales order and the same invoice. 

Service programs can also be sold after the sale of the serviceable product. This is 
termed Delayed Service. For delayed service, the reference type on the sales order 
line for the service is CUSTOMER PRODUCT. The service is associated with the 
appropriate serviceable product by selecting the product from the installed base. 
For example, you sell a telephone with a warranty that expires after 90 days. After 
90 days, the customer decides to purchase extended service coverage for the 
telephone. You can then sell the extended coverage as a service program three 
months after the original sale.

Note: : Service programs must always apply to a serviceable 
product and cannot be sold without referencing a serviceable 
product. 
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Regardless of how a service order is started, there are a variety of order processing 
options from which to choose, including dynamically calculated service program 
prices, sales credits, and approval cycles that can be applied to the entire order or 
specific order lines.

2.4.7 Cotermination
Oracle Service Contracts enables a common expiration date (cotermination date) to 
be specified for all service programs for a specific customer or system. This date can 
be set at the customer level so that all service programs for products ordered by a 
particular customer end simultaneously, or at the system level so that all service 
programs for products associated with a particular system end simultaneously.

Cotermination is used to determine the end date for service programs that are 
ordered in Oracle Order Management or in Oracle Service Contracts. When the 
cotermination check box is selected on an order or cotermination is clicked on a 
contract, the system cotermination date is checked first; if none is found, then 
Oracle Service Contracts checks the customer cotermination date.

As an example, suppose you set a cotermination date at the system level for October 
31, and a customer cotermination date for December 1. Service programs first check 
for the system cotermination date and set the end dates to October 31. If no date 
had been set at the system level when the system was defined, then the customer 
level cotermination date is used. Another customer has five systems, each with a 
different cotermination date. For each system, the individual cotermination date 
becomes the cotermination date for that system only. In turn, if the system had not 
been assigned a cotermination date, the customer cotermination date would be 
used.

A customer is notified late in December that the current service programs covering 
their power generators will be replaced on December 1 of the following year with a 
more comprehensive service program, and the current service program will not 
longer be valid. A cotermination date is set at the customer level of November 30. 
The same customer renews a current service program in January for an existing 
power generator. In March, the customer orders three more power generators and 
service programs for other sites. All service programs are checked for 
cotermination. All four service programs will coterminate on November 30, so the 
new service programs can start on December 1.

When a service program is ordered, if there is no cotermination date set at either the 
customer or system level and if the Coterminate check box or button has been 
selected when ordering the service program, then the cotermination date is the end 
2-22 Oracle Service Contracts Concepts and Procedures



Selling Products and Services in Order Management
date of the service program and the duration is one year. For example, if a service 
start date is June 26, 2003, then the cotermination date is June 25, 2004.

Any service programs applied to customer products use the cotermination date that 
is current at either the system level or the customer level. If the cotermination date 
is changed at either the customer or system level, then services ordered after the 
change use the new cotermination date. For example, if a customer level 
cotermination date is August 31, and five service programs are ordered for 
customer products in February, the cotermination date is August 31. If the date is 
then changed to July 31, and new service programs are ordered, then the 
cotermination date for the existing five service programs remains August 31, but the 
cotermination date for the new service programs is July 31. All subsequent new 
service programs have the July 31 cotermination date until the date is changed.

A minimum service duration (in days) can be applied. For example, you have a 
cotermination day and month of December 31, and a minimum service duration of 
30 days. All services ending on or before December 1 coterminate on December 31 
of the current year, and services ending after December 1 coterminate on December 
31 of the following year. If coterminating a service program sets its duration to less 
than the minimum duration, then the service program will be set to coterminate 
during the following year.

References
See OKS: Minimum Service Duration profile option.

2.4.8 Warranties and Extended Warranties
Warranties and extended warranties are service contracts. When a customer orders 
a product that has an associated warranty or the customer orders an extended 
warranty with the product, Oracle Service Contracts automatically creates the 
warranty contracts based on the information from the sales order. When products 
are returned, replaced, upgraded, or transferred, the warranty and extended 
warranty are updated appropriately.

Manage your warranties and extended warranties with the following activities:

� Define serviceable products in the item master.

� Define warranties and extended warranties in the item master with a 
corresponding coverage template.

� Associate or link warranties to the serviceable product in the bill of materials.

� Create warranties as service contracts when serviceable products are ordered.
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� Create extended warranties as service contracts when serviceable products are 
ordered or added to an existing order line or serviceable product that has 
already been sold.

� Update warranties and extended warranties when customer products are 
upgraded, replaced, transferred, returned or split.

� View warranties and extended warranties in the Service Request window.

2.4.9 Warranty and Extended Warranty Process Flow
A sales order creates a contract that can be viewed (in read only mode for 
warranties) using the Oracle Service Contracts Authoring window. Oracle Order 
Capture is notified by Oracle Order Management through the Process Order 
API/Update Notice API about any changes occurring in the orders such as header 
and line attributes. Oracle Order Capture in turn passes the information on to 
update the Installed Base and to create or update the warranties and extended 
warranties in Oracle iStore. This integration happens behind the scenes. 

The following diagram illustrates the process flow for the integration between 
Oracle Order Management and Oracle iStore and the logic that is involved in 
creating a warranty and extended warranty. 
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Figure 2–3 Process Flow - Integration Between OC/OM to OKS
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Figure 2–4 Process Flow - Integration Between OC/OM to OKS

2.4.10 Contract Details at Order Management
Using the Order Management Actions button on the Line tab, contracts details may 
be defined which specify the renewal rules, PO required, pricing method, cap price 
list, markup/markdown, and customer contact. In addition, merging rules may be 
specified to determine to which contract an order line is to be merged. An order line 
may be merged to an existing contract or to a contract on the current order. This 
window is available to the service line only.

To add contract details:
1. From the Order Management Responsibility navigate to Orders, Returns > Sales 

Orders > Line Items
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2. Click Actions. The Contract Details window is displayed. The upper region of 
the form displays the order details.

3. If applicable, select the Apply All check box. If an order has multiple service 
lines, subsequent lines may inherit the same renewal and merging attributes as 
specified in the initial order line. 

4. Select a Line Renewal Type. If an order line is merged to an existing contract, its 
duration may be less than the target contract. In order to facilitate renewals, the 
order line will coterminate with the target contract header. The Duration 
Inheritance attribute determines the desired duration of the service line. The 
valid values are:

� Full: The service contract line inherits the duration of the renewed contract.

� Remaining: The service contract line retains its original duration and 
coterminates with the renewed contract.

� Do Not Renew: The service contract line is allowed to terminate and will 
not be processed by the renewal event.

5. If the order line is to be merged with the current order, click New Option. The 
Existing option button is disabled.

6. Select a Renew Type from the list of values. The Renewal Type determines how 
the renewal is to be processed and whether the sales rep is to be notified to 
select the renewal type. The valid values are:

� Notify Sales Rep: The renewal event sends a notification to the sales rep, 
based on the territory in which he/she resides, to facilitate the renewal, i.e. 
the sales rep negotiates the pricing with the customer prior to send the 
contract for approval. 

� Submit for Approval: This will create a renewed contract in an entered state 
awaiting review and approval before it can become active. If the 
autorenewal process has been implemented, a contract with an Active 
Contract renewal type will either become signed or active, depending on 
whether the start date has passed. If the contract has not passed QA 
however, it will remain in the entered state.

� Evergreen: The renewal event automatically approves and activates the 
contract.

� Do Not Renew: The contract is allowed to expire.

7. If applicable, select the PO Required check box if a PO is required for contract 
renewal.
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8. Select a Renewal Pricing Type from the list of values within the Repricing 
Details region. These attributes determine how the renewed contract is going to 
be priced. The valid values are:

� Price Book: Renewal pricing is based on the current price list.

� Index: Renewal pricing is based on a markup percentage (%) and a cap 
price list. For example last year’s negotiated markup% is subject to cap list 
price. The fields Markup% and Price List are enabled. Enter the markup 
percent. This may be a positive or negative percent. Select the price list from 
the list of values.

� Manual: Renewal pricing uses last year’s negotiated price. 

9. Select a Role from the list of values within the Customer Contacts region. One 
or more customer contacts may be associated with the new contract. 

10. Select the Contact Name from the list of values. The customer address is 
automatically displayed.

11. If the order line is to be merged to an existing contract, click Existing Option. 
The New option button is disabled along with all the renewal and pricing 
attributes. This specifies the type of merging to take place and the valid values 
are:

� Order: Merge the current order line to the contract to be created for the 
current order. The list of values displays the applicable contracts for the 
current order.

� Contract: Merge the current line to a contract with the same customer, 
service line and end date.

12. If type is Order, select the contracts from the current order from the list of 
values.

13. If type is Contract, select the contract from the list of values. The Contract 
Number, Contract Line No, Service, Start Date and End Date entries are 
displayed.

2.4.11 Order Cycle
After the sales order has been booked, it should progress through the order cycle 
that has been defined (please refer to Oracle Order Management Concepts and 
Procedures for further information).

For orders that include shippable items, the order cycle will typically involve a pick 
release process and ship confirm. The ship confirm process includes a process that 
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updates the installed base with the details of the newly shipped product. This 
program will also initiate the transfer of contract information from Order 
Management to Oracle Service Contracts if the product has associated services or 
warranties.

For orders that do not include shippable items, like delayed service orders, the ship 
cycle does not apply. In this case, the order should be progressed from Order 
Management. To initiate the transfer of contract information, the Service Contracts 
Order Capture Integration concurrent program should be run.

2.4.12 Warranty and Extended Warranty Consolidation
Large sales orders may contain many products and services, which in turn means 
many warranties and extended warranties may be generated. Wherever possible, 
these agreements are consolidated into a single warranty or extended warranty per 
sales order. 

For each different warranty that is include with the products from the order, a 
separate warranty line will be created within the single warranty that is generated 
for a given sales order. Depending on how the products are created in Oracle 
Installed Base (serialized or non-serialized with Auto Split on or off) each of these 
warranty lines may have multiple sublines to represent the various products under 
that coverage. If partial shipments are made from an order, the original warranty 
will be updated whenever possible. New lines or sublines will be added to the 
warranty originally created for that sales order unless that agreement is in 
terminated status. This would require a new warranty to be generated. Because 
dates and durations may vary from one warranty line to the next, the agreement 
will begin on the earliest start date and end on the latest end date of all the lines.

Extended warranties are consolidated in the same way as, but separately from, the 
warranties. All those sold on a single sales order are captured on one agreement 
with separate lines for each different extended warranty. The products under each 
line create one or more sublines based on how they are created in the installed base. 
As with the warranties, the extended warranties are updated by subsequent 
shipments from that order unless the agreement is in terminated status, when a new 
agreement is generated. Start and end dates for extended warranties are also 
handled the same way as warranties.
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2.5 Authoring            
Service Contracts provides an authoring feature for recording and tracking each 
contract, the end goal being enhanced customer service and responsiveness. In 
addition, the following features are available in the Authoring form:

� Specifying contacts and bill to and ship to addresses

� Recording sales credits at the service line level

� Cascading the total of a service line amount to product level

� Interfacing sales credits to Oracle Sales Compensation

� Supporting contract multi-currency repricing

� Maintaining pricing attributes for a covered product

This topic group consists of the following topics:

Contract Templates

Contract Authoring and Pricing

Creating Contracts

Contract Header 

Using the Summary Tab

 Summary Parties Tab

 Summary Pricing/Billing Tab

 Summary Renewals Tab

 Summary Administration Tab

 Summary Security/Text Tab 

 Summary Articles Tab 

 Summary Sections Tab 

Using the Lines Tab

 Lines Accounts Tab

 Lines Effectivities Tab

 Lines Pricing/Products Tab

 Lines Billing Button
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Lines Exemptions Tab

 Lines Counter Tab

 Lines Events Tab

Using the Tools Menu

Revenue Distribution

Create New Version

Change Status

Pricing Qualifier

Price Adjustment

e-mail Quote

Update Service

Using the Action Menu

Sales Credits

Pricing Attributes

Cascade Attributes

Event Details

Show Index

2.5.1 Contract Templates
You can define an offering using the contract authoring feature and then saving the 
contract as a template for later use. Define the general terms and conditions of the 
contract using the following attributes:

� Subscription: A subscription template contains certain attributes, that can be 
associated to a subscription item. The attributes include Subscription type, 
Media and Property type, Fulfillment Channel, and Subscription Frequency. A 
subscription item can be a tangible item, like newsletters and compact disks or 
an intangible item like membership, digitized assets, and ’software as a service’. 
Subscription type specifies the type of subscription item such as Magazines, 
Journals, and Memberships. You can modify the list of available subscription 
types. Media and Property type specifies the subscription’s property identifier 
such as print material, audio, and digital image. You can edit the list of 
available media and property types. Currently Oracle Order Management is 
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supported as the fulfillment channel. If no fulfillment channel is specified, it is 
considered an intangible item, and no delivery schedule is created for that item. 
Subscription Frequency such as Yearly, Monthly, Weekly, and Daily identifies 
how often an item should be delivered.

� Services: This attribute refers to user defined services that are to be provided in 
the contract. For example, you can define a 9-to-5 service coverage, with a 10 
percent discount for materials, which could include field service transactions 
and hotline support transactions. 

� Times of coverage: This attribute defines days of the week, hours, and the start 
and end dates for coverage. For example, you can set up 9-to-5 coverage as in 
the above example. You have flexibility in defining times based on the service 
coverage’s needs. 

� Reaction times: The reaction time refers to the time in which the service 
provider must respond to a service request such as, a two-hour reaction time. 
Reaction times may be defined differently for each user-defined severity level. 
The reaction times are automatically enforced through Oracle Service. 

� Resolution times: In addition to indicating how long the service organization 
has to respond to a request, you may wish to define the maximum amount of 
time available to bring the open issue to a resolution. For example, the customer 
may wish to have any issues for a critical system completely resolved within 
four hours

� Discounts: This attribute refers to discounts that can be given based on the type 
of transaction performed. Using the example above, you could set up a discount 
of 10 percent for material when a service is performed.

� Levels of coverage: These can be for a customer, customer site, party, system, 
item, or customer product. 

� Counters associated with the contract: These apply to counters tied to the 
service. You can also have events tied to counters. For example, you can have a 
preventative maintenance scheduled for a copier if its counter reading reaches 
10,000 copies, or you can track the number of calls a customer has made to a 
customer support center.

� Preventive maintenance program: This would identify the preventive 
maintenance program and the corresponding schedule of program activities. 
You can define preventive maintenance programs at both Program and Activity 
levels.
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2.5.2 Contract Authoring and Pricing
After you define the appropriate template, you can use it as a basis to create a 
contract from an offering and obtain customer approval on the pricing, coverage, 
and other terms and conditions defined in the contract. You can also create a 
contract from scratch. In general, contract authoring and pricing entails the 
following steps:

1. Select the contract template that best matches the customer’s needs. If you are 
using a template, define customer information.

2. Define the contract’s terms and coverages.

If you have created a contract using a template, you can either use the existing 
terms and conditions, or modify them as necessary. For a new contract, you 
need to define the following:

� Parties: This covers the customer’s name, bill-to address, and ship-to 
address. Also identifies additional parties to the contract and contacts for 
any party.

� Billing information: Billing profiles, dates, frequencies and amounts. You 
can create a billing schedule at the header which, when scheduled, will roll 
down to all the levels below it. Or you can create billing schedules for lines 
individually which will roll down to the sublines.

� Pricing: Price list for calculating the price of the contract. Also remember 
any modifier lists from Advanced Pricing that have been set up to take 
effect automatically as well as use Pricing Adjustments to include any 
manual discounts or surcharges.

� Services to be provided: You can use either the default services, if you are 
using a contract template, or you can define and update services. Set start 
and end dates for each service which can be different from the contract’s 
dates, as long as the service’s start and end dates do not exceed the 
contract’s.

� Level of coverage: This can be for a customer, customer site, system, item, 
or customer product.

� Coverage details: You can update the coverage details of a service, which 
can default from the offering. Coverage details include information such as 
times and terms of coverage, reaction and resolution times and preventative 
maintenance schedules. By default the preventive maintenance schedule is 
defined for specific dates based on the stream levels defined in the coverage 
template. If required, the dates may be changed to a date range. 
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� Counters: Oracle Service Contracts lets you reference counters in the 
contract for tracking. For example, you can measure the number of calls 
made by a customer or the number of copies from a photocopier. You can 
include events in your contracts, which are automatically generated actions 
that occur based on conditions you define in the contract. For example, an 
event could be set up for a preventative maintenance service to be 
performed on a photocopier after every 10,000 copies.

3. QA Check the contract.

The QA Check is an automated process that verifies the contract contains the 
required and correct information. Some of the information that the QA checks for is 
defined in the application and cannot be changed or removed. Other information is 
optional and can be added or removed during implementation. Additional QA 
checks can also be written and included in the process. For additional information 
see the  Creating QA Checklists section of Oracle Service Contracts Concepts and 
Procedures Guide.

You can launch the QA Check from one of three places. On the Summary 
Administration tab, there is a Submit button that launches the QA check and then 
allows the contract to progress through the Approval workflow if it passes. This is 
useful for checking a single contract at the time you author it. Results of the QA 
check are returned to you on the screen immediately so you can make any necessary 
corrections. You can also launch the QA check from the Actions menu when you are 
in the contract you wish to check. This will also return the results to your screen 
immediately, however if the contract passes, it will not launch the approval 
workflow. The third alternative is use the concurrent program Contracts QA Report. 
This allows you to select a range of contracts and run QA for all of them at one time. 
The process produces a report listing the results of each contracts outcome. This 
process does not launch the Approval workflow after the QA is complete.   

4. Approve the contract.

Oracle Workflow processes the contract approval and signing. After the contract 
has been signed it becomes active.

2.5.3 Creating Contracts
To create a new contract, you need to provide general information regarding the 
customer (such as the customer’s identification, shipping, and billing addresses), 
define the services you are providing for the customer, and define the coverage 
terms associated with each service. Use this procedure to create a contract:
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Prerequisites
None

To create a contract:
1. From the Navigator, choose Launch Contracts. The Oracle Contracts window 

appears.

2. In the Contract Navigator tab, right-click anywhere and choose New. The 
Create New Contract window appears.

3. Select Create a New Contract Manually.

4. Select a category.

5. Click the Create button to open the Service Contracts Authoring window.

6. Enter the header information for the contract.

7. Save your work.

8. In the Summary tab, enter summary information that will act as default 
information throughout the contract unless overridden at the line level.

9. In the Lines tab, choose Usage, Service, or Subscription for the line type, and 
enter line information for each.

10. Save your work.

Guidelines
You can save your contract at any time as a template.

References
See Contract Header for field descriptions for the header section of the window.

See Using the Summary Tab for the procedure to enter summary information.

See Using the Lines Tab for the procedure to enter line information.

2.5.4 Contract Header 
While authoring a contract, the top portion of the Service Contracts Authoring 
window includes the following fields as listed in the table below:
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2.5.5 Using the Summary Tab
The Summary tab in the Service Contracts Authoring window provides a summary 
of the contract data. The summary information sets defaults used throughout the 

Field Description

Contract Number The contract number may be entered manually or is system 
generated the moment the contract is saved.

Order The Order Number is populated when a contract is 
automatically created from Order Management via the Installed 
Base Interface, such as for warranty and extended warranty 
contracts.

Version Displays the contract version number. You can choose to create 
a new version by using the version option from the popup 
menu within the Navigator or applying a change request. The 
history of versions can be reviewed by double clicking on a 
contract within the Navigator to open the contract summary.

Short Description Enter a short description of the contract.

Start Date Enter the contract start date.

End Date Enter the contract end date. The end date is automatically 
calculated when either the period or the duration is changed.

Category Select Service Agreements from the list of values presented.

Known As Provides an alternative, free format reference for the contract. 
Can be used to enable an easy search for the contract at a later 
date.

Duration Enter the duration in whole numbers. The duration is 
automatically calculated if the start and end dates are entered.

Period Select a period type from the list of values (e.g. month, year)

Status The status is always defaulted to Entered or the status that you 
select as your default entered status.

Subtotal Displays the sum of all line level subtotals after the contract has 
been saved.

Tax Displays the sum of all line level estimated taxes after the 
contract has been saved.

Currency and Total The Currency and Total of a contract are updated after the 
contract has been saved. The Total represents the sum for all the 
service lines including estimated taxes.
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contract, many of which can be overridden at the line level. Use this procedure to 
enter your contract summary information.

Prerequisites
None

To enter contract summary information:
1. Navigate to Summary > Parties tab.

2. Select the persons or business entities who have a business relationship to the 
contract. You can only enter one customer but can select any additional parties 
which have been defined in setup.

3. Select any contacts that relate to a selected party.

4. Select the correct bill and ship addresses for the customer.

5. Select the Pricing/Billing tab.

6. Enter the default pricing and billing rules for the contract.

7. Select the Renewals tab. Enter renewal rules to be used for the contract.

8. Select the Administration tab. 

9. Enter control information association with the contract.

10. Select the Articles tab.

11. Reference standard articles or create nonstandard articles.

12. Select the Sections tab.

13. If desired, change the article formatting.

14. Select the Security/Text tab.

15.  Optionally enter free form text for description or comments.

16. Save your work.

Guidelines
The billing schedules are based on Contract Billing parameters set in the Pricing 
and Billing tab. Click Schedule to update the billing schedule if any billing 
parameters have changed.
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Workflow processes can be launched from the Administration tab. Highlight the 
desired process and click Launch. Click Monitor to view the progress of workflows 
in process. Click Stop to stop the workflow process.

References
See Summary Parties Tab for field explanations.

See Summary Pricing/Billing Tab for field explanations.

See Summary Renewals Tab for field explanations.

See Summary Administration Tab for field explanations.

See Summary Security/Text Tab for field explanations.

See Summary Articles Tab for how to explanations.

See Sections Tab for how to explanations.

2.5.6 Summary Parties Tab 
The following table displays the fields and field descriptions for the Parties tab:

Field Description

Party region  

Role The valid values for role that are supplied with Oracle Service 
Contracts are vendor, customer, or third party. User defined 
roles can also be used. The vendor role will default to your 
company name. You must also enter a role of Customer. A role 
of Third Party can optionally be entered. You can only have one 
occurrence of each role for a contract. 

Name Select the party name from the list of values. Your company 
name automatically defaults as the vendor. 

Party No The party number is automatically displayed when the party 
name is entered.

GSA This designates the contract as a government supply agency 
contract. This flag is set up in the party and is automatically set 
as soon as the party is identified.
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2.5.7 Summary Pricing/Billing Tab
The following table displays the fields and field descriptions for the Pricing/Billing 
tab. Many of these fields are also found on the Billing tab for lines.

Contacts region  -

Role Enter the role that the contact is expected to play from the list of 
values. Individuals can be assigned to the contract along with 
the specific role each person has for the contract, depending on 
their legal relationship to the contract parties.

Name Enter the contact name from the list of values.

e-mail Enter an e-mail address in this free form text field.

Start Date Effective start date for a party contact

End Date Effective end date for a party contact

Bill To Address and 
Ship To Address 
regions

- 

Bill to Address This includes the Account/Party and Location fields.This is 
defaulted from the customer bill to address if it is flagged as 
Primary. Optionally, select another bill to address from the list 
of values.

Ship to Address This includes the Account/Party and Location fields. This is 
defaulted from the customer ship to address if it is flagged as 
Primary. Optionally, select another ship to address from the list 
of values.

Field Description

Agreement Optionally, select an agreement. Information from the 
agreement will appear in price list, accounting rule, invoicing 
rule, and payment terms.

Price List Specify the price list to be used from the list of values.

Accounting Rule If an agreement was not selected, then specify a rule from the 
list of values. The accounting rule determines when revenue is 
recognized for service performed.

Field Description
Using Oracle Service Contracts 2-39



Authoring
Payment Terms Enter the payment terms from the list of values. This field is 
used by AR to determine when the payment is due on the 
invoice.

Invoicing Rule Choose the invoicing rule from the list of values for the contract 
header.

Service Charges region  -

Pre-Payment Required This feature is reserved for future functionality

Purchase Order 
Required

Select if using a purchase order for payment of charges for 
services rendered.

PO Number Enter the purchase order number to be used for payment.

Note: If the Purchase Order Required check box is selected but 
no PO Number is entered, you can still save the contract. The 
QA check will only alert you that the PO number must be 
entered.

Currency Conversion 
region

(This region is read only for Euro countries)

From Currency Enter the currency that the currency is to be converted from.

To Currency Enter the currency that the currency is to be converted to.

Type Enter the conversion type from the list of values.

Date Enter the date for the entered conversion rate.

Rate Enter the conversion rate.

Contract Billing region  -

Transaction Type Select the Transaction Type from the list of values to be 
associated with billing for the contract.

AR Interface Controls which contracts are eligible to be interfaced to AR. The 
default setting is checked.

Hold Billing You can use the Hold Billing check box to place a hold on credit 
memos until the next billing cycle. This setting does not hold 
invoices. The default setting is unchecked which allows changes 
in the billing amount to be picked up immediately. 

Field Description
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2.5.8 Summary Renewals Tab
The renewal rules defined on this tab will be applied during manual or automatic 
renewal of the contract. If rules are not defined at the contract level, the rules will be 
retrieved from the Global Contracts Defaults. The following table displays the fields 
and field descriptions for the Renewals tab: 

Summary Transaction If checked, the system profile OKS: Summary Transactions will 
be ignored for that contract and only summary level 
transactions will be sent to AR for that contract. If left 
unchecked, the system profile will be used to determine how 
the contract should be billed. By default, this check box will be 
unchecked. 

Note: when unchecked it does not mean that detailed 
transactions will be sent to AR. The check box is only 
considered when it is checked. When unchecked, it is ignored

Summary Print Can be used by a customized invoice print program to control 
printing the invoice. If check box is selected, it will print at 
summary level or brief invoice. If check box is cleared, it will 
print a detailed invoice. 

Purchase Order 
Required

Select if using a purchase order to pay for the contract.

PO Number If you want the to reference the PO number on the invoice, enter 
the purchase order number in this field. The Contract Billing 
process sends the purchase order number along with billing 
transactions to AR.

Note: If the Purchase Order Required check box is selected but 
no PO Number is entered, you can still save the contract. The 
QA check will only alert you that the PO number must be 
entered.

Billing Button Opens the Billing Schedule window to allow creation of header 
level billing schedule which can be rolled down to the lines and 
sublines. 

Tax Exemption region  

Status Specify the tax status such as exempt when applicable.

Number Enter the tax exempt certificate number.

Reason Enter the reason for tax exemption.

Field Description
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Field Description

Renewal region  

Type The type of renewal process such as sending for approval, 
notifying sales representative to facilitate renewal, etc.

Renew Up To Only available for contracts with renewal type of Active 
Contract (Evergreen). This records the date when the automatic 
renewal process should stop renewing the contract. This will be 
the end date of the final renewed contract. 

Notification If a renewal event has been setup, this field identifies who was 
notified of an impending renewal.This field will not be 
populated until after the renewal event has picked up the 
contract and has sent the notification. 

Pricing Method This determines how pricing is to take place during contract 
renewal, such as list price or last year’s negotiated price. 

Price List Shows the price list to be used to compare and cap the price 
change during renewal.

Markup If a pricing method of markup was selected, enter the 
percentage (positive or negative) that should be used to adjust 
the price of the renewed contract. The new price will be 
compared to the cap price list to ensure the customer will not be 
charged more for the renewal than for a new contract.

PO Required check box This specifies that a purchase order is required during renewal 
process. If selected, the renewal cannot be sent for approvals 
without a purchase order.

PO Number During contract renewal, the user enters the PO number, if the 
PO Required check box is selected in the Renewal Rules Used 
region.

Estimated Percent This is used to give some measure of the percentage revenue 
that will be closed for the renewal within the specified time 
before the contract expires.

Duration The duration before the contract expires for which the estimated 
percentage revenue is planned to be achieved.

Period Enter the period from the list of values.

Renewal Rules Used 
region

 -
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2.5.9 Summary Administration Tab 
The following table displays the fields and field descriptions for the Administration 
tab: 

The Renewal Rules Used 
region is display only 
and is updated when the 
contract is renewed.

-

Quote To region - 

Account/Party Select a party from the list of values. This list of values refers to 
parties identified on the Parties tab. 

Contact Select an individual from the list of values.These contacts are 
associated with the party selected above. 

Address Select the street address from the list of values that is applicable 
to the individual contact listed above.

e-mail This field will default from the contact setup. It can be 
overridden.

Phone This field will default from the contact setup. It can be 
overridden

Fax This field will default from the contact setup. It can be 
overridden.

Field Description

Quality Assurance 
Checklist

Enter the QA checklist that is to be used for this contract.

Effective region  This area is read-only information

Date Approved The date that the contract was approved appears.

Date Signed The date that the contract was signed appears.

Date Canceled The date that the contract was canceled appears.

Date Terminated The date that the contract was terminated appears.

Date Renewed The date that the contract was last renewed appears.

Payment Details region  -

Field Description
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2.5.10 Summary Security/Text Tab 
Contract access is a combination of security granted both by the responsibility and 
at the individual contract level. You do not restrict access at the contract, you can 
only grant additional access. For example, if a user logs in with a responsibility that 
grants modify access to contracts they will not be restricted on a particular contract 
by a Read Only security level for a particular contract. However, someone logging 

Credit Card Number Enter the credit card number if the customer chooses to pay for 
the service agreement by this method. 

The level of validation to be applied to the number can be 
controlled by Contracts profile options OKS: Credit Processing 
QA Level. 

The minimum amount to be held in the event the event that the 
card is validated by authorization is set in the profile option 
OKS: Minimum Authorized Amount. 

The card details are passed to AR during the billing process.

Expiry Enter the credit card expiration date.

Estimation region - 

Percent Enter the percentage revenue that is estimated to be achieved 
for this contract. This can be used by a salesperson to give some 
measure of the revenue that may be generated for a new 
contract.

Date Enter the date by which the estimated revenue is predicted to 
close.

Contract Groups region - 

Group Name Select one or more contract groups to which this contract 
belongs. A contract is visible in the Launchpad only if a contract 
group has been specified here. 

Description The group description appears when the group name is 
selected.

Process region  -

Type Enter the type of process to run.

Workflow Name Choose the workflow process name from the list of values.

Workflow Process This is the workflow process system name and appears when 
the workflow name is specified.

Field Description
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in with a responsibility of Read Only may be granted Modify access for a particular 
contract.

The following table provides descriptions of the fields on the Security/Text tab:

2.5.11 Summary Articles Tab
Service Contracts supports article management in the same manner as Contracts 
Core. For guidance on how to do the following:

Referencing a standard article

Modifying an existing article

Creating an article

For guidance on how to use Articles see, Oracle Contracts Core Concepts and 
Procedures.

2.5.12 Summary Sections Tab
You can use the Sections tab to format the way you display Articles that were 
selected on the Articles tab. For each Section, you may enter subsections and place 
the Articles in the correct sequence. For guidance on how to use the Sections tab see, 
Oracle Contracts Core Concepts and Procedures.

2.5.13 Using the Lines Tab
Contracts that are authored (versus those that are automatically created) may 
contain service, subscription or usage type lines. Services, subscriptions and usages 
are all items that have been created in the item master (see Defining Service 

Field Description

Security region  -

Type Identifies Group or User access.

Group or User Name Enables you to choose either a group or user name.

Level Enables you to select either modify or read only access level.

Text region - 

Description This is free formatted text. Enter contract details, if applicable.

Comments This is free formatted text. Enter additional contract comments, 
if applicable.
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Programs, Usage and Serviceable Products). The line types available for a contract 
will depend on the contract category that has been selected.  If the Category is 
Service Agreement or Extended Warranty, two line types will be available - Service 
and Usage.  For a subscription Agreement, line types are Service, Usage and 
Subscription.

When a service line is added to a contract, the coverage terms associated with that 
service are defaulted onto the contract line. The default coverage terms can be 
customized as necessary on the contract, but the price is unaffected. For example, 
you could choose a service for 9x5 (nine hours a day for five days a week), and 
increase the coverage to 24x7, but the price will not increase because it was a 9x5 
service that was selected on the contract.

Prerequisites
None

To enter a contract line:
1. Navigate to the Lines > Accounts tab.

2. Enter a service, subscription or usage line, customer contact, and address 
information.

3. Select the Effectivities tab. 

4. Make any changes necessary to the effectivity dates for the lines.  For a 
subscription line, enter the quantity of items being sold.  

5. Select the Pricing/Products tab.

6. For service lines, enter the covered levels and pricing information.

7. If you want to review details about the product from Installed Base for a 
serviceable product, then click Product Details.

8. If you want to view the components of the price calculation, then click Price 
Calculation.

9. Click Billing. 

10. Enter billing information for the line item.

11. Select the Counters tab. 

12. Review counter information.
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13. If you want to review the counter, then right-click the counter line and choose 
Counter Setup. The Setup Counters window appears.

14. If you want to edit counter values, then right-click the counter line and choose 
Counter Capture. The Capture Counter Reading window appears.

15. Select the Events tab.

16. Review event information.

17. Save your work.

Guidelines
There is no limit to the number of contract lines that can be defined for a contract. 
However, only one set of coverage terms can be defined for a service, although it 
may include several business processes. For each business process (for example, 
Depot Repair) a unique set of terms can be defined (for example, coverage times, 
reaction times, or bill rates.) 

There is no limit to the number of business processes that can be defined for a 
coverage terms contract line. Also there is no limit on the number of billing types 
that can be defined for a business process.

The contract values defined in the Summary tab (header) govern the terms and 
conditions of the entire contract. However, these may be overridden by explicitly 
entering alternative values in the Lines tab.

Counters that track usage of products and services are defined in Oracle Service. 
For instance black and white copies and color copies made on copy machines are 
examples of product counters. Total number of support calls and total number of 
service requests are examples of service counters. To enter a usage type of product 
and service line, it must be defined as an item in the Item Master and flagged as a 
Usage Item serviceable product. Usage information is entered on the Effectivities 
tab.

References
See Lines Accounts Tab for field explanations for the Customer Account 
information.

See Lines Effectivities Tab for field and button explanations.

See Lines Pricing/Products Tab for field and button explanations.

See Lines Billing Button for field explanations for Billing.

See Lines Exemptions Tab for field explanations for Exemptions. 
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See Lines Counter Tab for field explanations for Counters.

See Lines Events Tab for field explanations for Events.

2.5.14 Lines Accounts Tab 
The following table displays the fields and field descriptions for the Accounts tab:

Field Description

Line Number The line number is automatically generated.This number is 
unique to the contract and will not be reused even if the line is 
deleted and new lines are added.

Line Type Select either Service, Subscription or Usage.

Name Select the name of the item from the list of values.

Line References Allows entry of free format line reference for each contract line. 
This may be used to represent the customer’s reference, e.g. a 
PO line number or a CLIN reference. This field is not system 
generated.

Order/Line Number If service contract has been interfaced with Order Management, 
this shows the order number. If a service contract is created 
manually, this field is disabled.

Account Select the customer account from the list of values. The 
Customer account is defaulted from the bill to address of the 
contract header. Since the bill to address at this point is known, 
the customer account can be defaulted. However, you can 
override the customer account.

Account Name The account name appears after the customer account is 
selected.

Bill To If different from the Summary tab, enter the bill to name from 
the list of values. If there is no bill to at the line level, you can 
use the Actions menu option Cascade Attributes to copy the bill 
to address from the header.

Ship To If different from the Summary tab, enter the ship to name from 
the list of values. If there is no ship to at the line level, you can 
use the Actions menu option Cascade Attributes to copy the 
ship to address from the header.

Customer Contacts 
region

 For each line entered on the contract, the following information 
can be entered:
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2.5.15 Lines Effectivities Tab
The following table displays the fields and field descriptions for the Effectivities tab:

Role Enter the role from the list of values. Similar to the header 
contacts, customer contacts can be created for the party which 
the customer account is associated with.

Name Enter the party name from the list of values. The address will 
populate automatically.

Start Date and End Date For each contact, enter the start and end dates to indicate the 
effectivity of that contact, if applicable.

Bill To and Ship To 
Address

The bill to and ship to addresses in this portion of the tab are 
those addresses that belong to the customer account as entered 
or defaulted above. 

Field Description

Status Defaulted from the header status.

Start Date Enter the service line start date.

End Date Enter the service line end date. If a duration and period are 
entered, then the end date is calculated.

Duration Enter the duration in whole numbers.

Period Enter the period from the list of values such as month or year.

Qty Enter the quantity per delivery (available only for Subscription 
lines)

UOM Select the unit of measure from the list of values. (available only 
for Subscription lines)

Renewal Type This determines line duration for renewal such as full duration, 
and remaining, This value would normally be automatically 
initialized from OM, however, it may be manually changed 
during the renewal review.

Description This displays the service description (Service or Usage).

Invoice Text This text is defaulted based on the item description and effective 
dates, but can be overridden. The text is sent to AR during the 
billing process.

Field Description
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Coterminate (button) Sets the end date of the currently selected contract line to be the 
same as the end date established by the Service Cotermination 
setup. 

Coterminate All (button) Sets the end date of all of the lines on the contract to be the same 
as the end date established by the Service Cotermination setup. 
For additional information see Defining Service Cotermination 
in the Implementing Service Contracts portion of the Oracle 
Service Contracts Concepts and Procedures Guide.

Coverage region for 
service line

Every service item defined in inventory is associated with a 
coverage template. When you select a service item in authoring 
and save it, the associated coverage template is used. The 
coverage name and description appear. Click Edit Coverage to 
view or edit the coverage.

Name Displays the coverage name

Description Displays a description of the coverage.

Exception Coverage If a coverage has an exception coverage defined, then the 
exception coverage name and description appear.

Template region for 
subscription line

-

Name Displays the name for the Subscription template.

Description Displays a short description for the Subscription template.

Edit Schedule button Click the Edit Schedule button to open the Subscription 
Schedule form. This form displays the order details and order 
fulfillment history for each schedule delivery. You can also use 
this form to update the subscription schedule by editing the 
patterns.

The patterns specify the schedule for the subscription item 
delivery. The Schedule patterns consist of Year, Month, Week, 
Weekday and Day. For each of these components, you can enter 
individual values or range of values separated by commas(,). 
Use a hyphen(-) to specify a range by entering a hyphen 
between the lowest and highest values. For example, the value 
1,3-6,9 in the month component would mean January, March to 
June and September. 

A value of * in any of the component means ’ALL’. For example, 
a ’*’ in the month field would mean January to December. 

Field Description
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2.5.16 Lines Pricing/Products Tab 
The Pricing/Products tab is where each of the sublines are created for each service 
line to add the items that are covered for the particular service. The Effectivity tab is 
where you will select the coverage level and associated product(s) for each subline. 
If the products to be selected are not already in the Install Base, they can be added 

Usage Type region  -

Fixed Per Period Select this usage type if the customer will pay for the same 
number of units each month regardless of the actual counter 
reading. This usage type can only be billed arrears. 

Actual Per Period Select if billing is based on an actual usage by period.This is the 
actual usage quantity for a defined period. However, this usage 
type allows the set up of default and minimum counter values. 
In addition, usage averaging is enabled where an average 
billing is allowed if no counter readings are captured for a given 
period.

Period Enter the period in which billing is to take place.

Actual by Quantity Select if billing is based on an actual usage by quantity.

Negotiated Price Negotiated price is selected if the customer is going to pay a 
fixed dollar amount regardless of the usage reading. Negotiated 
Price usage type can be billed in advance, as can Fixed Per 
Period usage type.

Average and Settlement (Actual per Period Usage Type.)

Averaging Allowed Select if averaging is allowed across invoices. If the Averaging 
check box is checked, the averaging interval is mandatory entry. 

Averaging Interval 
(Bills)

The averaging interval is a whole number and is based on the 
period defined in the Usage Type region.

Settlement against actual 
usage allowed

Select if settlement against actual usage is allowed.If checked, 
the Settlement against Actual Usage concurrent request 
compensates or settles billing against actual usage. If a 
minimum or default invoice amount is generated, this may be 
executed after the counter reading is taken. If the counter 
reading is greater than the previously billed amount, an invoice 
is generated to compensate for the under billing. If the counter 
reading is less than the previously billed amount, a negative 
invoice is generated to make up for the over billing. In addition, 
this generates an additional billing history line in the Lines / 
Billing tab.

Field Description
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from the Covered Product Selection window’s New button. On the Pricing tab, you 
can view, enter, or override the price of each subline as appropriate. Once the 
sublines are priced, billing schedules can be established. The following table 
displays the fields and field descriptions for the Pricing/Products tab:

Field Description

Line Number Line number was automatically generated when the line was 
created on the Lines Accounts tab

Line Type Defaulted from the Lines Accounts tab

Name Defaulted from the Lines Accounts tab

Line Ref Defaults from the Lines Accounts, view only

Duration Defaulted from the Effectivities tab.

Period Defaulted from the Effectivities tab.

Price (Last Contract) Displays the price of the contract line on the previous contract, 
prior to renewal.

Currency (Last Contract) Displays currency type.

Subtotal This field displays the total price of all the covered levels.

Tax This field displays the estimated line level tax amount for all the 
covered levels.

Total The Total represents the sum of the line level Subtotal and 
estimated Tax fields.

Invoice Print Flag This flag is used by a custom print program, not the standard 
Receivables invoicing process. The Invoice Print Flag check box 
is available for each contract line to indicate whether the line 
item should be printed on an invoice. There may be practices 
which require that an invoice is not printed. The default setting 
for this check box is set to print the invoice. Deselect the check 
box when you don’t want to print the invoice for the 
corresponding line item. 

Show All Products 
(Button) Service Line 
Only

Lists Covered Product items for all sublines under a particular 
Service Line. Items under other coverage levels (covered site, 
covered item, etc.) will not display. Only enabled for 
Warranty/Extended Warranty contracts. 

Billing (Button) This button enables creation of a line level billing schedule. 

Effectivity Subtab (Service Line)
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Level This identifies the level at which the service line is covered. 
When searching for covered items in this field, there are two 
different LOV formats available. The standard Oracle 
Applications window will open if you enter a partial name or 
number with the wildcard (%). Oracle Service Contracts has 
created a special search form which can be accessed by clicking 
LOV in the Covered Level field. This form allows you to search 
using the fields and filters described below. If the item to be 
covered is not already in the installed base, clicking New in the 
Cover Products Selection window will open the Install Base to 
allow new products to be added. The covered levels are:

� Site: Covers all products at a particular customer site 
(references install base). You can search for sites of the 
Customer named on the contract, any parties that are 
related to that Customer, both the Customer and their 
related parties or get a list of sites for every company in the 
customer master. 

� Item: Covers all products of a particular item type 
(references inventory items). 

� Product: Covers a particular product from install base. You 
can search the installed base of the named Customer, any 
parties related to that Customer, both the Customer and 
their related parties or get a list of the installed bases for 
every company in the customer master. You can filter your 
search to look for just items, models or systems. Or you can 
search all installed products for a site, party, or customer. 

� System: Covers a particular system configuration for the 
Customer and/or related parties as well as all customers. 
(references install base)

� Customer: Covers all products for a given customer 
account (references install base). You can search for the 
Customer and/or parties related to the Customer as well as 
all customers.

� Party: covers all products for a given party (references 
install base). You can search for the Customer and/or 
parties related to the Customer as well as all customers.

Field Description
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Name For the Covered Item level this is the product name.

For the Covered Party level this is the list of customer names.

For the Covered Product level this is the list of installed base 
items. If the desired product is not in the installed base, click 
New from the Covered Product Selection window to add it.

For the Covered Site level this is the list of available sites for the 
customer.

For the Covered System this is the list of systems in the installed 
base.

For the Covered Customer this is the list of customers names.

With the Covered Product level, you can select one or multiple 
entries from the Covered Product search window. Upon 
selecting the products and clicking the OK button, the covered 
products are automatically added to the contract and priced 
accordingly. For all other covered levels, you can designate the 
coverage of multiple products on a single subline without using 
the search window. However, the pricing for this entry would 
be manual.

Line Ref Allows entry of free format reference for each contract subline. 
This may be used to represent the customer’s reference, e.g. a 
PO line number or a CLIN reference. This field is not system 
generated.

Start Date Covered Level start date.

End Date Covered Level end date.

Price UOM Allows the user to choose what unit of measure to price for 
service, regardless of the unit of measure of the service itself. 
For example, the service may be 450 days duration, but the user 
may choose to price in years. This will ensure that a consistent 
price is retrieved per unit of time, for different lengths of 
service.

Duration Defaulted from the Effectivities tab.

Period Defaulted from the Effectivities tab.

Date Terminated The date at which the covered level was terminated.

Renewal Type Identifies contract renewal type such as Full duration or do not 
renew.

Description Displays product description.

Field Description
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Invoice Text Free format invoice text. Defaults based on the name of the 
covered level but can be overridden. This text is sent to AR 
during the billing process.

Product Details (Button) Access to the Customer Products window showing details such 
as product name and quantity.

Pricing Subtab (Service Line)

Line Number The line number is automatically generated.

Level Defaulted from the Effectivities tab.

Name Defaulted from the Effectivities tab.

Line Reference Display of the sub-line reference set on the Effectivity Tab.

Quantity For covered items, enter the quantity to be covered. The default 
quantity is 1.

UOM For covered items, select a unit of measure from the list of 
values.

Unit Price If the covered level is Covered Product or Covered Item, then 
Oracle Pricing is called to get the price of the product.  In all 
other cases, you must manually enter the price for servicing the 
product.

Extended Price The extended price is the unit price times quantity.

Price (Last Contract) Displays the price of the covered level on the previous contract, 
prior to renewal.

Currency (Last Contract) Default from contract line.

Subtotal The Subtotal is normally equal to the extended price. For 
covered levels of Covered Product and Covered Item, the price 
is obtained from Oracle Pricing, including any discounts and 
surcharges. The price retrieved is the price as of the date 
determined by the profile option Pricing Default Date. The price 
is defaulted into the Subtotal field. You can manually override 
the price if desired. The subtotal field is also used to enter prices 
manually for contract lines that are not priced automatically 
(see Pricing Service and Usage).

Tax Displays the covered level estimated tax.

Total The Total represents the sum of the covered level Subtotal and 
estimated Tax fields.

Description Displays product description.

Field Description
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Billing (Button) This enables creation or modification of a product-level billing 
schedule.

Reprice (Button) Enables the repricing of service items in a contract when a new 
price list is selected. Repricing can be done at any time not just 
while Renewal, at Contracts level, or Covered Product Level.

Price Calculation 
(Button)

Enables you to review the how the price derived.

Products region  (Usage Line)

Name Select the name of the product for a usage line. Source Details is 
automatically displayed.

Source Details Identifies counter: 

CP: Product counter

Service: Service counter

Line Ref Allows entry of free format line reference for each contract line.

Fixed If the usage type is Fixed, enter the fixed amount to be billed 
every month.

Minimum If the usage type is Actual per Period, enter the minimum 
counter value. If a counter reading is taken and is less than the 
minimum, a minimum invoice will be generated, i.e. the 
minimum counter value defined on the contract would be used 
to determine the invoice amount.

Default If the usage type is Actual per Period, enter the default counter 
value. If a counter reading is not taken for a given period, a 
default invoice will be generated, i.e. the default counter value 
defined on the contract would be used to determine the invoice 
amount.

UOM Regardless of the usage type, the UOM is automatically 
defaulted to the counter UOM.

Period Regardless of the usage type, the period is defaulted from the 
usage type period.

AMCV AMCV (average monthly counter volume) is applicable to the 
Actual per Period usage type only and determines if averaging 
is to be used for billing when a counter reading is not taken. If 
checked, based on the averaging period defined in the contract, 
the Service Contracts Main Billing calculates an average invoice 
amount which is used for billing the current period. If the 
number or previously billed period is less than the averaging 
interval, a default billing is generated.

Field Description
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2.5.17 Lines Billing Button
The Lines Billing button gives you the ability to determine a flexible billing amount 
and schedule. This billing schedule gives the liberty to bill whatever amount you 
want to bill for a given period of time. For example, you can choose not to bill in the 
first month and adjust that amount in the billing for the subsequent months. The 
billing schedule can be set up at the header and rolled down to the line level or 
created individually for each line on the contract. 

You have an option of conveniently billing for different billing periods. This can be 
decided by choosing the Billing Type from the Schedule header. The three choices 
are:

� Equal Amount

� Top Level (not available for Subscription type contracts)

� Covered Level (not available for Subscription type contracts). 

You can select one of these levels as the default so that each time you create a billing 
schedule, that choice will appear automatically. The billing level default is selected 
in the OKS: Billing Schedule Level profile option.

For Equal Amounts the user can bill for equal amounts over the billing period and 
has full control over the amount to be billed and the billing periods. Or by using the 
Prorate button, the amount can be spread across the billing periods.   The start and 
end dates of all top lines and their sublines must be the same. The schedule form, 
once generated, cannot be modified for the covered product line.

Level If multiple counters are defined on a contract and one or more 
counter readings are significantly higher than the others, usage 
leveling can be used to equalize or distribute the readings across 
all the counters for a given billing period. This simplifies the 
customer’s invoice by showing an even billing distribution 
across all the counters. If applicable, check Level for each 
applicable counter.

Reading Enter the initial base reading of the counter. The monthly net 
counter reading will be based on this base reading.

Net Reading This is a calculated field that tracks all historical activity for the 
counter such as roll overs. 

Final Price If the billing type is Negotiated Price, enter the final price which 
would be used for each billing period.

Field Description
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For Top Level users can define the billing periods and the billing engine calculates 
the bill amounts (therefore the amount fields will be disabled). Line level start and 
end dates can differ from the sublines.   The Prorate button will be disabled. When 
creating billing schedules at this level, the total stream level amounts from the 
sublines will roll-up to the line levels. Also, once a line level billing schedule exists, 
all new sublines added automatically without needing to revisit the line level and 
click Schedule again. 

Also, for Top Level bill schedules, whenever the duration of the line is increased, an 
additional billing stream will be created.   If the contract has a later end date, the 
unit of measure of the billing stream is taken from the previous stream. If the 
duration is reduced, billing streams may be removed, as long as those streams are 
entirely outside of the new contract duration. If these changes are cascaded to the 
sublines, those billing schedules will be updated when the cascade is initiated. If the 
changes are not cascaded, only the line level billing schedule will be automatically 
updated.

For Covered Level, the user can define the billing periods and the amount to be 
charged. Top line effectivities may differ from the sublines. Amounts can be entered 
for every period or the Prorate button may be used. For sublines where start and 
end dates match their top line, the billing schedule is created by the billing engine. 
When the dates differ from the top line the user goes to the schedule form and 
creates the subline schedule manually. For the Covered Product line, the schedule 
form is not read only so changes can made there directly. This level of billing 
schedule is not available when you are creating a header level billing schedule.

When creating a header level billing schedule, it will become the default 
information for all service and usage lines in the contract. Usage lines which fall 
under the header level billing schedule only have the option of selecting the Arrears 
invoicing rule. If changes are made to the line level billing schedules, it is important 
to note that refreshing the header level billing schedule will overwrite these changes 
since the header schedule is rolled down to the lines each time the schedule is 
refreshed. A warning message will appear reminding you that this is about to 
happen. The header billing schedule does not receive billing history information.  It 
cannot be updated or used to schedule lower levels once billing has happened.

Stream Level Window
A billing schedule may have many billing streams. Each stream level being a set of 
billing periods. For example: A contract starts on 17 December 2003 and runs till 31 
December 2004, duration of 380 days. Due to this irregular duration, the billing 
period would have been calculated at a daily rate and would have given varying 
billing amounts, depending on the length of each calendar month. Billing stream 
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levels allows the user to set up a separate stream for the irregular period of 15 days, 
followed by a second stream of 12 months. The stream level in this case would be 
“bill for 1 period of 15 days at $500 followed by 12 periods of 1 month at $1,000.”

Schedule and History Tabs
It provides the ability to define billing schedules for individual covered levels on 
the contract, and contract lines. The Schedule tab window opens once the Billing 
button is clicked from Lines > Pricing/Products.

Field Description

Schedule Tab -

Invoicing Rule. Choose the invoicing rule from the list of values for the contract 
line. The invoicing rule is defaulted from the contract header 
invoicing rule

Accounting Rule Defaults from the contract header accounting rule. The 
accounting rule determines when revenue is recognized for 
service performed.

Level Select a level from the list of values: Equal Amount, Top Level 
or Covered Level. Note: The Covered level is not available for 
usage lines and only the Equal Amount level can be used for 
Subscription contracts.

Start Date This field is display only and shows the start date of the 
contract line.

Amount Displays contract price.

End Date Enter the end date of the contract.

Stream Level Region  -

Seq No Enter the sequence in which you wish to have the billing stream 
levels billed.

Periods Enter the number of billing periods to be included in this stream 
level. E.g. to set up a stream level of “bill for 1 period of 15 days 
at $500,” the value in this field should be “1.”

UOM/period Enter the number of periods to be included in this stream level, 
e.g. in the above example, the value in this field should be “15.”

UOM Enter the unit of measure for the billing period, e.g. in the above 
example, the value in this field should be “Days.”
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Amount Enter the amount to be billed for each period in the stream level. 
For a level of Equal Amount, you must enter a value in this field 
or use the Prorate button to create the value. For a level of Top 
Level, this field is grayed out as Oracle Contracts can calculate a 
value automatically based on the price of the contract line. 
When viewing a Top Level billing schedule, the stream level 
values for the sublines beneath it will be rolled up and 
displayed in this field.

Invoice Offset For an invoicing rule of Advance, the invoice date can be 
determined by Oracle Contracts. Enter the number of days (plus 
or minus) from which the invoice date should be set from the 
bill from date. The invoice date must be on a later date than the 
current date but may be prior to the start date of the contract.

Interface Offset Enter the number of days from which the Interface date should 
be set from the bill from date. The Billing program uses the 
information to determine the date for sending the billing 
records to Oracle Receivables. Oracle Contracts will enforce that 
the interface date is the earlier of either the Invoice Date or the 
Bill from Date. As the result, only offsets less than 0 will have 
any affect on the interface date. Using the interface offset to 
create an interface date prior to the start date of the billing 
period may, during the first billing cycle, result in the interface 
date being prior to the start date of the contract. The billing 
engine will find any billing stream where the interface is on or 
before the date specified. Therefore, an interface date in the past 
will not prevent billing from running successfully.

Cascade Dates After making a change in the start or end dates of the billing 
sequences, click this button to automatically set the dates to 
cascade from one to the next, so that the billing schedule does 
not have any gaps or overlapping dates.

Prorate Use this button for Equal Amount billing to have Oracle 
Contracts automatically calculate the invoice amounts based on 
the billing sequences that have been defined. 

Schedule Use the Schedule button to display the billing schedule after 
creating or making any changes to the billing schedule or 
contract effectivity dates at any level which affect the billing 
schedule. It creates schedules for sublines (where applicable) 
and must be clicked to save the schedule.

Schedule Region All fields in this region are display only and show the result 
of the values that have been entered in the previous region.

Seq No This field shows the sequence number of the billing schedule 
from the previous region.

Field Description
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2.5.18 Lines Exemptions Tab
The following table displays the field names and descriptions for the Exemptions 
tab:

Level Seq This field shows the sequence number of each stream level.

Invoice Date This field displays the invoice date that is sent to AR. However, 
for the Advance invoicing rule, this date can be changed by 
using the Invoice Offset field in the previous region.

Bill From This field shows the start date of the billing period. This date is 
used to derive the accounting period for which revenue is to be 
recognized for the contract line.

Bill To This field shows the end date of the billing period.

Interface Date This field shows the date when Oracle Contracts Billing 
program will pick up the record to send to AR. This date can be 
changed by using the Interface Offset field in the previous 
region.

Amount This field shows the amount that will be billed in the billing 
period.

History Tab This tab displays the billing history. Information is 
brought in first by the Contracts main billing and then 
updated by the Fetch to display actual amounts billed 
including tax and invoice numbers. Only the line level 
billing schedule histories will be populated with actuals. 
Header level billing schedules will not show any billing 
history. If summary transactions are selected with either 
the profile option or the contract check box, the history 
will contain one transaction line per billing period. 
However, if detail transactions are being sent to AR, the 
billing history will show the details for each subline per 
billing period. By right clicking on a line in the billing 
history, you can view the details of that billing 
transaction.

Field Description

Line Type Indicates Service or Usage line

Name Identifies the Service or Usage item

Field Description
Using Oracle Service Contracts 2-61



Authoring
2.5.19 Lines Counter Tab
The following table displays the fields and field descriptions for the Counters tab:

2.5.20 Lines Events Tab 
Events are normally linked to a counter, whether it be a unit based or time based 
counter. Events are defined in the Condition Template form. The Events tab shows 
the anticipated outcome which is a PL/SQL procedure that executes some business 
logic. For example XYZ Company wants to schedule a preventive maintenance 
service request after a time based counter has elapsed 3 months. In this case, the 
outcome is a custom PL/SQL procedure that uses the Create/Update SR API to call 
a Service Request template. 

The following table displays the fields and field descriptions for the Events tab:

Status Select the tax status for the item selected (e.g. Exempt)

Number Enter the tax exemption certificate number from the list of 
values (if applicable). Not available if Status is other than 
Exempt.

Reason Indicates the reason this item is tax exempt (e.g. Reseller). Not 
available if Status is other than Exempt.

Tax Code If Status referenced above is other than Exempt, this field 
provides a list of values from which to select the appropriate tax 
code for this item.

Field Description

Name Review counter name

Type Review counter type

UOM Code Review unit of measure

Net Reading The difference between the current counter reading and the last 
reading that was billed.

Timestamp The date the net reading was recorded.

Field Description

Name Event name such as counter update.

Field Description
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2.5.21 Using the Tools Menu Functions
The following functions can be accessed from the Tools menu

� Revenue Distribution

� Create New Version

� Change Status

� Pricing Qualifier

� Price Adjustment

� e-mail Quote

� Update Service

� Terminate Subline

2.5.22 Revenue Distribution 
This provides the ability of distributing revenue for service items on a contract into 
accounts other than the default account that has been setup. You can enter new 
revenue information for some lines without changing others. You can change the 
default revenue distribution of an Entered status contract or you can open an Active 
contract for update (or create a change request). You can change the revenue 
distribution for a contract even after a line has been billed but this will only change 
the revenue distribution for future billing. If the contract is copied, renewed or used 
as a template these distributions will also be copied to the new agreement.

To distribute revenue:
1. Navigate to Service Contracts Authoring > Tools > Revenue Distribution.

2. Review the account defaulted in the GL Account field. 

Description Event description

Date Active Date event becomes active.

Date Inactive When event has become inactive.

One Time Identifies whether the event will be evaluated once only, rather 
than potentially being triggered on a recurring basis.

Field Description
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3. Select the Override account field. A list of values is displayed with the different 
account aliases.

4. You can choose the overriding account by selecting the segment values, or by 
choosing from the list of combinations. 

5. Enter the percentage to be allocated to the account in the Percent field. The Total 
Percentage should equal 100%.

6. Save your work.

2.5.23 Create New Version
 Provides the ability to create a new version of an existing contract.

To create a new version of an existing contract:
1. From the Contract Navigator, click the contract to be versioned.

2. Navigate to Contracts Authoring >Tools > Create New Version.

3. The new version of that contract is created.

4. In order to view the new version or any previous versions, from Contract 
Navigator go to Launch Contracts > Contract Navigator > Service. Double click 
the contract. A window will open. On the bottom of the window click the 
History tab. The different versions of the contract would be listed there and you 
can pick any version for read-only access.

2.5.24 Change Status
Provides the ability to change the current status of the contract to another status. 

To change the contract status:
1. Navigate to Service Contracts Authoring > Tools > Change Status. 

2. The Change Status window will open. 

3. Select the new status from the list of values. The status of the contract will be 
changed.

2.5.25 Pricing Qualifier
This provides the ability to define the pricing qualifiers that are eligible for the 
contract. This information is passed to Oracle Pricing to calculate the appropriate 
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discounts or surcharges. For more information about Qualifiers and Modifiers, 
please refer to the Oracle Pricing User’s Guide.

To define pricing qualifiers:
1. With the cursor at the line level, navigate to Tools > Pricing Qualifier.

2. The Pricing Qualifier window will open.

3. Select segments from the list of values. 

4. This will qualify if the contract is eligible for any discounts or surcharges.

2.5.26 Pricing Adjustment
Price adjustments that have been applied automatically can be reviewed using this 
feature, and also additional adjustments can be applied manually. If done manually, 
make changes and save them. Then apply the changes and reprice the contract for 
the changes to appear. You can enter price adjustments at the contract header, line 
or subline. 

For header level pricing adjustments:

� If the price adjustment is a percentage, that percentage would be applied to 
each subline.

� If the adjustment is a fixed amount, the adjustment would be applied to each 
subline. For example, if the amount entered in the Adjustment window is a $10 
discount, each subline would be reduced by $10 with lines above reflecting the 
cumulative effect of those discounts. For a line containing three sublines, each 
subline is discounted by $10. As the result, the cumulative effect on the price of 
the line would be a $30 reduction.

To perform pricing adjustments:
1. Highlight the price to be adjusted.

1. Navigate to Service Contracts Authoring > Tools > Pricing Adjustments.

2. The Pricing Adjustment window will open. 

3. Select a modifier number from the list of values. The modifier number is a type 
of pricing adjustment set up in Oracle Advanced Pricing. 

4. Apply the changes.
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2.5.27 e-mail Quote
Quote letters can be generated and e-mailed to a customer as part of the renewal 
process. The person who receives this e-mail quote is specifically identified on the 
Summary Renewals tab, as described previously. 

Prerequisites
The following profile options must be setup in order to use the e-mail Quote 
functionality:

OKS: SMTP Domain

OKS SMTP Host

OKS: SMTP Port

Refer to the Implementing Oracle Service Contract Concepts and Procedures for 
more information regarding these profile options.

To generate an e-mail quote:
1. Navigate to Service Contracts Authoring > Tools > e-mail Quote

2. Select the quote printing report to be run (these will be specific to the 
environment).

3. The “To” field will default from the Quote To field in the Summary Renewals 
tab. Enter a Reply To/Copy e-mail address of the sales representative or other 
individual who should be copied or replied to about this e-mail. This field is 
free-format text.

4. Add additional recipients if necessary.

5. Enter any text for the body of the e-mail.

6. Click Send.

Clicking Send creates two concurrent requests. The first generates the quote using 
the quote printing report specified above and the second creates and sends the 
e-mail. 

2.5.28 Update Service
This form enables users to review existing service information and choose one or 
more new replacement services for the covered products on the contract line. It 
allows users to assign a percentage of the price of the former service to the new 
service line(s).  It is intended as a tool for use on entered status contracts, generally 
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during the renewal process. For example, a customer has a contract with a line that 
covers 500 laptops for Bronze service which covers Monday through Friday from 
8am to 5pm. After restructuring their service offerings, Bronze service is no longer 
offered but Level II support is the comparable offering. In order to make contracts 
reflect the new offering, rather than having to add a new line and add all the 
covered products to that line, simply select the old service line, click Update 
Service, choose the new service and indicate what percentage of the existing 
service’s price should be applied to the new service. This amount does not need to 
equal 100% it can be more or less depending on the appropriate value for the new 
service. Contract value and billing schedules are adjusted accordingly. Coverages 
and invoice text are not changed.  The Update Service function is not available for 
Subscription lines.

To review and update services:
1. Navigate to Service Contracts Authoring for the contract being updated.

2. From the Lines - Pricing/Products tab, place cursor on the Service Line item 
that is being updated.

3. From the Tools menu select Update Service.

4. Under Contract Line at the top of the form, review the information to make sure 
this is the line that should be updated.

5. Under Update Service select from the List of Values the new service item that is 
replacing the item shown at the top of the form.

6. In the Prorate column, indicate the percentage of the price from the existing 
service item that should apply to the new service item. For example, if the 
existing item is $150 and the new item should cost $75, enter 50 to see a final 
price on the new line that is equal to 50% of the old line.

7. Enter additional service lines as necessary. The prorate column does not need to 
total 100%. You will receive a message indicating that the total is more or less, 
select OK to proceed or cancel to return to the form. 

8. When all of the new lines have been entered, click Apply. The existing service 
item will be gone and the new service items will appear instead. The new price 
will be reflected for the line item. The billing schedule will reflect the new 
pricing as well.

2.5.28.1 Terminate Subline
Refer to the Termination procedures in Oracle Service Contracts Concepts and 
Procedures guide for information on this topic.
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2.5.29 Using the Action Menu Functions
The following functions can be accessed from the Actions menu:

� Sales Credits

� Maintaining Pricing Attributes

� Cascade Attributes

� Event Details

� Show Index

2.5.30 Allocating Sales Credits
Contract authoring allows the allocation of sales credits to multiple sales reps. Sales 
credits can be assigned at the header level and/or the line level (for either service or 
usage lines). If a contract containing sales credits is copied, renewed or used as a 
template the sales credits are also copied to the new agreement.

To allocate sales credits:
1. Navigate to Service Contracts Authoring > Actions > Sales Credit.

2. Review the Contract Number, Service Name, Party Name, Modifier, and Start 
and End dates. These are display only.

3. Select the Salesperson from the list of values.

4. Select the Credit Type from the list of values. The valid values are:

� Quota Sales Credit

� Non Quota Sales Credit

5. Enter the percent allocated to the given salesperson.

6. Review the Revenue Total which is a running total of revenue credits. This is a 
read-only field and must equal 100%.

7. Review the Non Revenue Total which is the running total of non revenue credit. 
This is read-only field and may not exceed 100%.

8. Select OK to save.
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2.5.31 Maintaining Pricing Attributes
The pricing attributes may be maintained for any of the covered products. To access 
these attributes, the covered product should be highlighted and select Pricing 
Attributes from the Action menu.

To maintain pricing attributes:
1. From the Authoring window navigate to Actions > Pricing Attributes.

2. Select the Pricing Context from the list of values. For each Pricing Context, the 
pricing attributes may be entered in the corresponding descriptive flexfield. 

3. Click Apply to save the pricing attributes

2.5.32 Cascade Attributes
Provides the ability to cascade contract attributes from each level, header to lines 
and lines to sublines. For example, changes to the start and end dates can be rolled 
down to the next level in the contract. Attributes that can be cascaded from header 
to line are Date, Accounting Rule, Bill to Address, Bill to Contact, Ship to Address, 
Invoice Rule, Tax Status, Exemption Number, Billing Profile ID, Recalculate Tax, 
and Sales Credit. Attributes that can be cascaded from line to subline are Date, 
Invoice Text, Renewal Type, Invoice Print Flag, and Coverage Effectivity. After 
selecting the attribute to be cascaded, you can select the lines or sublines to receive 
the changes.

To cascade attributes:
1. From the Authoring window navigate to Action > Cascade Attributes

2. Select Cascade type ‘Header to Lines’ or ‘Lines to Sublines’ from the Cascade 
field.

3. Select the attributes to be cascaded by selecting the appropriate check box.

4. When cascading line to sublines, the sublines can be viewed by double clicking 
the line indicator box. This will open a window displaying all the sublines for 
that line. The sublines to be selected can be indicated with a check box.

5. Review the lines or the sublines to be changed and identify any to be excluded 
from the change by clearing the check box.

6. Click Submit.

7. Review the transaction log to check for errors.
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8. Apply the changes.

9. For date-related changes, check the billing schedule and Refresh as necessary to 
keep the billing schedule dates in synch with the effectivity dates.

2.5.33 Entering Event Details
When you are on a contract line, you can go to the Actions menu and select Event 
Details. The Condition Template form appears where you can enter either action 
(e.g. counter updated) or date based (e.g. contract signed) conditions. Events 
(conditions) that are already associated with the contract can be viewed on the 
Events tab. See Defining Condition Templates in the Oracle Contracts Core 
Concepts and Procedures. 

2.5.34 Show Contract Index
At any point once the contract has been created, you can use the Show Index feature 
from the Actions Menu to see some of the high-level details of the agreement. The 
index shows the parties, line level service items, the covered level products at the 
sublines and the names of any rules or articles attached to the contract. By selecting 
an item on the index and clicking Go, you can navigate to that point in the contract. 

2.6 Billing
Contract billing involves determining the exact amount to be charged for services 
provided against a contract. Oracle Service Contracts lets you set up flexible billing 
cycles. For example, you can set up a monthly billing cycle for a contract and bill 
the customer when they want to be billed. Oracle Service Contracts would calculate 
the amounts each month and execute them through an invoicing system, such as 
Oracle Receivables.

In addition to billing for services, contract billing is also able to support flexible 
usage or meter billing based upon minimum usage, defaults, AMCV.

This topic group consists of the following:

Billing for Contract

Billing for Services

Automatic Service Program Billing

Bill Settlement

Bill Termination
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Service Settlement

Executing Main Billing

2.6.1 Billing for Contract
Billing for Contract enables users to define billing schedules and the recurring 
billing amounts are determined in Oracle Service Contracts and executed through 
Oracle Receivables. 

For example, suppose you create a $10,000 service agreement for a customer 
starting from April 1, 2003 to March 31, 2004. The customer wants to pay 
monthly on the first of every month. The billing schedule can be set up so the 
amount of the first bill is $1,000 for the payment on April 1, 2003, and prorate 
the balance evenly over the remaining months. It then sends the calculated 
amounts to Oracle Receivables for invoices to be processed. The bill dates do 
not necessarily need to be the same every month or even on regular intervals. 
You can offer the customer no payments the first month (or any point in the 
contract) and schedule the subsequent billing dates and amounts for anytime 
you choose.

In addition to interfacing billing transactions to Oracle Receivables, you can send 
the billing transactions to special “preview” tables. From these tables, you can 
create custom reports that reflect the information which is used in your customer 
invoices. This allows you to see the information that the customer will see on their 
invoice before billing is run. If there are any problems with the billing information, 
it can be corrected easily in the contract before it is interfaced with Oracle 
Receivables.

To stop a contract from being billed as a result of finding errors on the pre-invoice 
process, the status of the contract should be set to one where the operation 
Invoicing Allowed is not selected. After corrections have been made, the status of 
the contract should be changed by the user to one that allows invoicing to occur.

2.6.1.1 Using Advance and Arrears Billing Schedules
The Interface date enables you to determine the date that the billing information is 
interfaced to AR. The Interface and Invoice dates in the schedule can be adjusted 
using the Invoice Offsets field. The Invoicing Rule and the Payment Terms on a 
contract are interfaced to Oracle Receivables when the contract is billed.

The Invoicing Rule determines the accounting period for recording the receivable 
amount. It is used to determine the GL date of the transaction. It cannot be used to 
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determine the date for sending records from Oracle Contracts to Receivables. It can 
be either Advance or Arrears for service lines, and only Arrears for usage lines:

� If Advance, the earliest accounting rule start date is used as the invoice GL date.

� If Arrears, the latest accounting rule start date is used as the invoice GL date.

In a situation where the billing program is run later than the scheduled Invoice 
date, the invoice date will be set to the current date. When the invoice date is in the 
future, this date will remain unchanged when interfaced to AR. The Service 
Contracts Main Billing program sends the invoice dates to AR Interface Tables for 
both Advance and Arrears billed contracts. However, for Advanced Billed contracts 
you can use the Invoice Offset field to adjust the invoice date. 

The following table shows an example of a billing schedule when the billing 
program is run after the start of a contract and has to catch up billing for the first 
few billing periods. The contract effective dates are 01/01/03 to 12/31/03 and is to 
be billed monthly. 

Today is 03/15/03 and the default date that is entered when running the billing 
program is 04/01/03. The first 3 months that should have already been billed 
would have their bill on (invoice) date set to 03/15/03 since their original bill on 
date is in the past. The fourth month has a bill on date of 04/01/03 which is later 
than today’s date, but since the default date when running the billing program is 
04/01/03, then the invoice for April would also be sent to Accounts Receivable, 
with an invoice date of 04/01/03. The Interface Date will default to the Bill From 
Date unless adjusted using the offsets. This means that the billing transaction is 
eligible to be sent to AR on or after the first day of the billing period.

Invoicing Rule - Advance Invoice

Invoice Date Bill From Bill To

03/15/03 01/01/03 01/31/03

03/15/03 02/01/03 02/28/03

03/15/03 03/01/03 03/31/03

04/01/03 04/01/03 04/30/03

05/01/03 05/01/03 05/31/03

06/01/03 06/01/03 06/30/03

07/01/03 07/01/03 07/31/03

08/01/03 08/01/03 08/31/03
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For the Arrears Invoicing Rule, the Invoice Date defaults to the Bill To Date unless 
adjusted using the offsets. The Interface Date will default to the Bill To date plus one 
day. This means that the transaction is eligible to be sent to AR the day after the 
billing period ends.

The following table shows an example of a billing schedule for arrears.

09/01/03 09/01/03 09/30/03

10/01/03 10/01/03 10/31/03

11/01/03 11/01/03 11/30/03

12/01/03 12/01/03 12/31/03

Invoicing Rule - Arrears Invoice

Invoice Date Bill From Bill To

01/31/03 01/01/03 01/31/03

02/28/03 02/01/03 02/28/03

03/31/03 03/01/03 03/31/03

04/30/03 04/01/03 04/30/03

05/31/03 05/01/03 05/31/03

06/30/03 06/01/03 06/30/03

07/31/03 07/01/03 07/31/03

08/31/03 08/01/03 08/31/03

09/30/03 09/01/03 09/30/03

10/31/03 10/01/03 10/31/03

11/30/03 11/01/03 11/30/03

12/31/03 12/01/03 12/31/03

Invoicing Rule - Advance Invoice

Invoice Date Bill From Bill To
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2.6.1.2 Revenue Tracking in AR
In order for all unearned, unbilled revenue for the contract to be recognized in AR, 
all billing transactions for the contract should be interfaced to AR. Postings need to 
be made into the correct period.

To meet this requirement, the Bill From date on the contract billing schedule will 
become the invoice rule start date which will take the accounting rule into 
consideration and will determine the date for the transaction. If it is required that all 
bills are interfaced at the start of the contract, when running the Service Contracts 
Main Billing program, the default date parameter should be set far enough in 
advance to pick up all bills for the contract.

2.6.2 Billing for Services
The exact amount to be charged to a customer is determined by the services 
provided against a contract.

For example, suppose you have created a 9-to-5, 100 percent material 
coverage, and you define a 10 percent discount on labor. When a service 
technician replaces parts for a customer, the customer is charged only for 
labor with a 10 percent discount. The customer is not charged for parts 
replaced. 

The entitlement engine determines the coverage for each billing line based on the 
combination of type of billing transaction and the billing type associated with the 
part on the line. It applies the pricing, discounts, and other parameters defined in 
the contract for each billing line to derive the actual price to be billed as per the 
contract.

2.6.3 Automatic Service Program Billing
Customers can automatically be billed for Extended Warranties they purchase. 
Oracle Order Management uses Oracle Receivables, via the Receivables Interface, to 
create invoices for service programs on sales orders. In this case, the service 
programs are extended warranties. Billing can be done either in advance or in 
arrears using Oracle Receivables invoicing rules.

2.6.4 Bill Settlement
It may be necessary to settle the billing with customers because of usage limits, 
fixed usage billing, or termination. Settlement billing creates an invoice or credit 
memo based on the difference between the actual readings and what was billed. 
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The following diagram illustrates how the service contract billing engine calculates 
the billing amount. Regardless of the line type, billing details are calculated and 
stored. When the invoices are ready to be generated and sent to Oracle Receivables, 
the customer billing profile is accessed to determine if summarized or detailed 
billing is to occur.
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Figure 2–5 Oracle Service Contract Billing Engine
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2.6.5 Bill Termination
A service contract can have one or more service and usage lines with different 
effectivity dates. A customer can choose to terminate the whole contract or 
individual contract lines (service or usage). The termination of contract lines can be 
post dated (Services only) or future dated. When service lines are terminated post 
dated, the customer can be credited as needed for any overpayment. When service 
lines are terminated future dated, billing is handled by the billing engine. 

The following diagram is process flow for bill termination:
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Figure 2–6 Process Flow for Bill Termination

2.6.6 Service Settlement
Service settlement is based on whether a service or usage line is to be settled and 
involves the generation of a credit memo or invoice depending on the time frame in 
which the service is terminated. Settlement of a service line type is straight forward. 
On the other hand, settlement for a usage line type is based on attributes that are set 
up for usage lines. The following diagram highlights the logic for determining the 
amount of the settlement:
2-78 Oracle Service Contracts Concepts and Procedures



Billing
Figure 2–7 Service Settlement
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2.6.7 Executing Main Billing
Billing Execution procedures consist of the following topics:

Overview

Running the Billing Program

Running the Fetch AR Program

Running Usage Averaging and Settlement Program

2.6.8 Overview
The procedures for executing service contract billing involves the following 
concurrent requests:

� Service Contracts Main Billing: According to pricing attributes set up in the 
contract and billing schedule, detailed transactions are generated in OKS billing 
interface table.

� Autoinvoice Import Program: The billing transactions are then imported into 
AR.

� Service Contracts Fetch Receivables Info for Billing. This concurrent request 
fetches the invoice number and tax from AR and accordingly updates the 
contract billing history. This information is displayed in the contract’s billing 
history.

Depending on the usage type, the following occurs when Service Contracts Main 
Billing is executed:

� For Fixed and Negotiated Price usage types, billing may be submitted without 
any counter updates. The actual invoice amount is based on the fixed counter 
value or the negotiated price defined on the contract.

� For Actual by Quantity, the counter reading should be updated prior to any 
billing using price breaks.

� For Actual by Period.

� If a counter reading has not been taken, Service Contracts Main Billing uses 
a default counter value defined on the contract to determine the invoice 
amount. If AMCV is set and the prerequisite billing periods have passed, 
the invoice amount is the average over the defined interval, otherwise it is 
the default.
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� If the counter is updated and it is less than the minimum, the invoice 
amount is the minimum counter value, otherwise it is the actual counter 
reading using price breaks.

� If a minimum counter value has been set up on a usage contract, and the 
consumption for a billing period falls below the minimum, the customer 
will be charged the minimum amount. For the following billing period, the 
consumption is calculated without regard to the previous under-usage. The 
usage calculation for each billing period should be independent, that is, if 
the minimum usage is not used, then the customer loses the consumption 
shortfall.

� If one or more billing periods have passed without any counter updates, the 
Settlement concurrent request should be run after the counter is updated. 
Settlement compensates or makes up for the estimated invoice value for 
each period after the counter readings have been taken for each period. This 
is displayed as another line in the billing history.

Prerequisites
You must define the following:

� Transaction Types (AR) - Invoice and Credit memo

� Batch Source (AR)

� Grouping Rules (optional) (AR)

� Service and Usage items Inventory (Inventory)

� Applicable service and usage items must be included on one or more price lists 
(Order Management) 

� Party and customer accounts must be defined (AR)

� If Billing profiles are to be used they must be defined, i.e. bill to address, 
summarized billing, billing frequency, advanced or arrears billing 

2.6.9 Running the Billing Program
You define the billing schedule in the Contract Authoring form. Use this procedure 
to run the billing program.

Prerequisites
None
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To run the Billing program:
1. In the Navigator, choose Control > Requests > Run. The Submit New Request 

window appears.

2. Choose Single Request and click OK. The Submit Request window appears.

3. In the Request region, select Service Contracts Main Billing.

4. In the Parameters window, specify the following:

� Contract Number: Enter the numbers of the contracts to be billed.

� Default Date: Enter the date you want as the default. (The default offered is 
the system date on your computer.)

� Organization Id.: Enter the organization id for which all the contracts are to 
be billed.

� Customer Name: Enter the name of the customer for which all the contracts 
are to be billed.

� Category: Enter the category for which all the contracts are to be billed.

� Group: Enter the name of the group for which all the contracts are to be 
billed.

� Preview: Change this option to yes if you wish to send these transactions to 
special preview tables. Leave it at no if you want the transactions interfaced 
to Accounts Receivable.   

5. Click OK.

6. In the Submit Request window, click Submit Request. 

The billing program sends the invoice amount to Oracle Receivables, which 
then generates the invoice. The process also populates some billing transaction 
history information in the History tab of the Billing Schedule. Since the invoice 
number is assigned and tax calculated by Oracle Receivables neither of these 
pieces of information can be populated until after the Service Contracts Fetch 
Receivables Info for Billing program is run. The tax amount will be left blank 
and the invoice number will be populated with -99. 

References
For more information on invoicing, see the Oracle Receivables User’s Guide. 
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2.6.10 Running the Fetch AR Program
The Service Contracts Fetch Receivables Info for Billing program retrieves the 
invoice number and tax amount from AR and updates the contract’s billing history 
accordingly. The tax amount is nonzero if tax is “required” in the contract.

Prerequisites
In Oracle Accounts Receivables, run the AutoInvoice program to generate the 
invoicing. The user who runs AutoInvoice must have the profile option AR: Define 
Document Sequences set to Partially Used at either the user level or at the 
responsibility level.

To run the AutoInvoice program:
1. From the Navigator, choose Other > Control > Requests > Run. The Submit a 

New Request window appears.

2. Choose Single Request and click OK. The Submit Request window appears.

3. In the Name field of In this Request area, select Fetch Receivables Info for 
Billing.

4. Click OK.

5. In the Submit Request window, click Submit Request. This updates the 
invoicing information in the customer’s contract.

2.6.11 Running Usage Averaging and Settlement Program
Use this procedure to run the Usage Averaging and Settlement for Billing program.

Prerequisites
None

To run the Usage Averaging and Settlement for Billing program:
1. In the Navigator, choose Other > Submit Requests. The Submit New Request 

window appears.

2. Choose Single Request and click OK. The Submit Request window appears.

3. In the Name field of In this Request area, select Usage Averaging and 
Settlement for Billing.

4. In the Parameters window, enter the number of the contract. If you leave this 
field blank, all contracts will be used.
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5. Click OK.

6. In the Submit Request window, click Submit Request.

2.7 Reviewing Entitlements
Along with the usual functionality of checking entitlements, for example, finding 
out if a customer is calling during his coverage hours, or to find the agreed reaction 
time, a separate component of Oracle Service Contracts allows other applications to 
view the coverage for a particular contract.

Entitlement information is made available to any application that requests it such 
as, Oracle Customer Support, Field Service, Service Core, Depot Repair, and 
Charges.

2.7.1 Sharing Contract Information
Oracle Service Contracts provides detailed contract information through other 
Oracle modules:

� Customer Support

� Contract details for a given customer such as account, end date, status, 
contract type, and contract number

� Retrieval of all active, terminated, and expired contracts for a given 
customer

� Preferred engineers for a service

� Coverage time for a service request or customer call

� Coverage levels associated with a service

� Reaction and resolution times for coverage

� Billing rate for a specified coverage

� Billing types

� Retrieves the list of contract lines with Preventive Maintenance program 
attached and an existing schedule

� Retrieves preventive maintenance schedules for a contract line

� Retrieves the confirmation flag for a contract line

� Field Service
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� Preferred engineers for a service

� Service Core

� Contract details for a given customer such as account, end date, status, 
contract type, contract number

� Usage items may be tracked by one or more counters

� Billing rate for a specified coverage

� Billing types

� Depot Repair

� Details for repairs, exchanges, replacements, and loaners

� Charges

� Details for billing types and billing rates (when applicable, billing rates 
apply to labor)

�

2.7.2 Overview of Entitlements Processing
Once a contract is in effect, Oracle iStore, with its integration with Oracle Service, 
shares the entitlement information for a customer automatically, based on the 
customer’s contract, and shows the amount to be billed after the service has been 
delivered.

Entitlement processing refers to the services that the customer is entitled to once the 
contract is in effect. The entitlements cover the following: 

� Checking for service overlaps

� Performing discount calculations

� Checking for coverage details and reaction times

� Applying requisite billing rates

The entitlements are defined in the contracts window and are automatically 
enforced through Oracle Support. The discounts and reaction times are defined in 
the coverage window in Oracle iStore. For every business process that is covered in 
the contract you can define coverage times and reaction times. For example, an 
onsite preventative maintenance transaction could be part of 9-to-5 service, with 5 
percent material covered in the service. The coverage times for an onsite preventive 
maintenance service can be 9-to-5, five days a week, with a reaction time of two 
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hours for a high severity call. If a high priority call comes in at 10:00 A.M., then the 
service request window would automatically calculate 12:00 P.M. as the time by 
which the call needs to be resolved. 

Similarly, the discounts that are defined in a contract are automatically applied in 
the service request Charges window which the customer service is delivered. 
Therefore, the onsite preventive maintenance service includes a replacement of 
parts transaction type and an upgrade of part transaction type. Once you have the 
necessary entitlements defined in the service contract, you can associate the contract 
with the service request and have the charges and discounts applied to the service 
that is being rendered

 Oracle Contracts determines the entitlement of a customer automatically. It 
accomplishes the following:

� Entitlement processing is integrated with service requests and determines 
deliverables, time frames, and coverage available for the product and serial 
number listed on the service request window. The entitlements also determine 
performance guidelines to be followed such as a 2-hour reaction time, specified 
parts included, and between specified hours. More detailed information 
regarding a contract is available through a drill down on the contract 
deliverables field of the service request. 

� In Oracle Depot Repair, contract entitlements deal with repairs, exchanges, 
replacements, loaners, and returns from customer.

� In service billing, the entitlement engine determines the coverage for each line 
based on the combination of type of billing transaction and the billing type 
associated with the part on the line. It applies the pricing, discounts, and other 
parameters defined in the contract for each billing line to derive the actual price 
to be billed as per the contract.

2.8 Managing Contracts   
After the contract authoring process is complete, the contract will need to be 
managed during it’s life-style. Changes may have to be made to the coverage, 
duration etc. This section describes some of the Contract Management features that 
can be used to help streamline and control this administrative process.

Contract Management consists of the following tasks:

Editing a Contract

Finding a Contract
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Cascade Service Price

Contract Renewal

Termination Procedures

Extending a Contract Line

Grace Period

Mass Change

Reassigning Resources

Reporting

2.8.1 Editing a Contract

2.8.1.1 Handling Change Requests
A contract may be set to a status that does not allow changes to be made on-line 
through the authoring form, but does allow changes through a change request. This 
provides more control over tracking the changes made to a contract through it’s 
life-style. 

If the Active status does not allow “on-line updates'’, then any changes to the 
contract would have to go through the change request process. Once a change 
request has been approved, a notification is sent to the Contract Administrator. 
From the Inbox, the contract may then be opened for update. (Note that in this 
instance the Open for Update button is not visible in the contract itself.) After the 
contract updates have been completed, the contract is run through the QA Check 
and if everything passes, the contract status is set back to Active.

See Oracle Contracts Core Concepts and Procedures for the steps describing entering, 
approving, and closing change requests.

2.8.1.2 Open for Update Button
This button is used to allow updates to a given contract and is applicable to 
contracts having the status Active. If this status allows “on-line updates,” the Open 
for Update button is enabled. If other users try to access the same contract, they will 
be able to display the contract, but unable to do any updates the Open for Update 
button is disabled. For the selected contract, clicking the Open for Update button 
will set the contract status to QA Hold. After the updates are completed, for 
example, pricing, billing attributes or adding a new service line, select Check QA 
from the Actions menu to run the quality assurance check. If it passes, hit cancel 
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and the status will be set back to Active when the QA window closes. Since the 
contract has already been approved and signed, it is not necessary to Submit for 
Approval a second time.

Warranty contracts may not be updated using Open for Update. Extended Warranty 
and Service Agreement contracts may be edited; however, the portion of the 
contract that has already billed (whether via Oracle Service Contracts or Oracle 
Order Management) may not be altered. A billed line may have new sublines added 
to it, but the billing stream applied (periods, uom/period, uom) will be identical to 
the billing stream under which the line has previously been billed. If a new line is 
entered, a new billing stream is entered and may be different than the billing stream 
on any lines that have been previously billed.

If, during the Open for Update action, lines have been added (which are technically 
in an Entered state) those lines can be deleted without having to revert any other 
changes as well. Since entered lines can be deleted from an Entered status contract, 
the same behavior will apply to the new lines on a contract in QA Hold.

2.8.1.3 Revert Update
After a contract has been approved, the contract may be opened for update through 
the Open for Update button. A series of updates (on multiple occasions) may be 
performed on this contract. At any point, Revert Update will “undo” all the 
updates. However, once the contract is has been through the QA check and is set 
back to Active status, it is not possible to “undo” changes that were made prior to 
the QA Check. In other words, the Revert Update feature is available only while the 
contract is QA Hold status.

2.8.1.4 Cascade Attributes
Provides the ability to cascade contract attributes from each level, header to lines 
and lines to sublines. For example, changes to the start and end dates could be 
rolled down to an appropriate level in a contract. The coverage date should be 
adjusted automatically to reflect the changes (previously known as manual option 
Effectivity Adjustment in the Action menu). When making changes to the date in a 
contract, start date or end date range for any level must be within the start date or 
end date range for the parent level (e.g. the covered level date range must be within 
the contract line date range).

When cascading a date change to the next level, the dates will be checked to see if 
the lower level is eligible for change. If the start date is pushed back retroactively, 
then only the lines or covered lines with start date later than the original start date 
of the header will be changed. When multiple contracts or contract lines are to be 
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affected by a cascade action, the option to cascade will be defaulted to Yes. You 
should be able to execute lower levels from the cascade.

2.8.2 Finding a Contract

Using the More Button
The More button provides an enhanced search criteria for finding contracts. It is 
placed on the search window and is activated when a Service Contract category is 
entered. When More is clicked, a separate window will come up that provides the 
ability to search on specific attributes for service contracts. Searchable fields include 
agreement name, date signed, organization, contact e-mail address, order number, 
and bill to name. Select an entry from the list of values for any of these. 

2.8.3 Cascading Service Price
The Cascade Service Price window is accessed from the Actions menu and is used 
to cascade the service line price to the covered level prices at the same proportions. 
The Cascade Service Price function is not available for Subscription lines.

For example in the table below, the current service line price is $2,000 and in this 
case, the percentage of the service price applied to lines L1 & L2 is 75% and 25% 
respectively. The same proportions are cascaded to the lines if $4,000 is applied.

To cascade the service price:
1. From the Authoring form navigate to Actions > Cascade Service Price. 

2. Review Service, Start Date, End Date, and Current Price fields. These are 
display only.

3. Enter the New Price that is to be applied to all line products.

4. Click Apply to save. The new price is cascaded in the appropriate proportions 
to the final price of each covered level.

5. Refresh the billing schedule to reflect the new values.

Current New

S1 $2000 $4000

L1 $1500 $3000

L2 $500 $1000
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2.8.4 Renewing Contract 

2.8.4.1 Contract Renewal
The process of renewing a contract involves making a copy of an existing, active 
contract as of a point in time and changes the new contract dates to reflect a period 
of time similar to the existing contract, beginning on the first day after the existing 
contract expires. Other attributes of the new contract may also be changed such as 
pricing. Because there may be an overlap between the time the existing contract 
creates the renewal contract and the time the renewal contract goes into effect, be 
aware that changes to the existing contract will not update the renewal contract. For 
example, if a contract is renewed 90 days prior to expiration and the customer 
requests changes to their existing contract 15 days after the renewal process has 
begun, the changes made to the existing contract will not be reflected on the 
renewed agreement.

Note: When renewing a Subscription type contract:

� A new instance is NOT created in Install Base and the new contract continues to 
cover the same parent item. However, if you use the Copy function to create a 
new Subscription contract, a new instance is created in Install Base.

� The Fulfillment schedule is copied to the new contract.

The renewal and pricing attributes are optionally maintained in the individual 
contracts and apply to both contract categories Warranties and Extended Warranties 
and Service Agreements. If not specified in contract, the renewal and pricing 
attributes are retrieved from the renewal event or from the Global Contracts 
Defaults in the following order of precedence: 

� Event

� Party

� Organization

� Global

Some of the renewal information is held in profile options which determines what 
information will be obtained from the profile option settings upon contract renewal. 
By setting the profile option OKS: Enable Sales Credits to Derive, the system will 
use the following profile options to create the renewal agreement:

OKS: Sales Person or OKS: Use JTF - determines the sales person for the Sales 
Credit form and for the vendor contact on the contract summary. Either set Use 
JTF to Yes or set a name in the Sales Person profile option. If you do both, Use 
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JTF will take precedence. If you do not set either, the QA check will fail asking 
for a sales person to be assigned. You may manually add additional sales 
people to the Sales Credits form after the renewal agreement has been created.

OKS: Revenue Type Distribution - assigns the percentage of revenue to the 
sales person whose name was determined by the Sales Person or Use JTF profile 
options. Sales Credits must total 100% in order to pass the QA check. If you add 
additional sales people to the Sales Credits form, remember to distribute revenue to 
them until the total is 100%.

OKS: Revenue Type - indicate whether this revenue is quota or non-quota for 
the sales person that was defaulted.

OKS: Vendor Contact - adds a vendor contact role to the renewal agreement. 
This information is in addition to copying any vendor contact roles and names 
that are on the original contract. Ideally, you should set this profile option to 
salesperson, however that is not required. The vendor contact name that will 
populate this role is the person who is identified by the JTF territory assignment 
if OKS: Use JTF is set to yes, or will be the salesperson specified in the Sales 
Person profile option. 

If Enable Sales Credits is set to Drop, the information from these profile options is 
not included in the renewal agreement nor is it copied from the original contract. 
No sales credit information will default to the renewal agreement; it would be 
entered manually.

Contract renewal consists of the following topics:

� Renewal Types

� Renewal Procedures

� Renewal Consolidation

2.8.4.2 Renewal Types
Renewal types have been added so that the renewed contract isn’t automatically 
defaulted to the Entered status, requiring it to go through approval again. You can 
set the renewal type on the Administration tab at the header to be one of four 
options:

� Do Not Renew

� Active Contract

� Notify Salesrep
Using Oracle Service Contracts 2-91



Managing Contracts
� Submit for Approval

� Electronic Renewal

Do Not Renew prevents the contract from being renewed.

Active Contract allows the contract to be renewed automatically and put straight to 
Active, no approval required, no human intervention, this is called Evergreen.

Notify Salesrep places the renewed contract into entered status and sends a 
notification to the sales representative who then must review it, make any necessary 
changes and submit it for approval.

Submit for Approval, creates a contract in entered status, automatically submits it 
for approval and sends a notification to the sales representative.

Electronic Renewal places the renewed contract into entered status and sends a 
notification to both the sales representative and the customer. The customer receives 
notification in the form of an e-mail with a link to a web page where customer can 
review the quote and accept, reject, or request changes to the contract renewal.

Independent Conditions can be used to set the contract to auto renew a certain 
number of days prior to contract expiration. This period of time can be used to 
negotiate the terms of the contract and administer any required changes prior to the 
start date of the new contract. For setting up an Independent Condition, see 
Defining Condition Templates in Oracle Contracts Core Concepts and Procedures. 

2.8.5 Using Renewal Procedures
Once a contract has been renewed, use the processes below to prepare it for 
approval:

� Selecting Party

� Repricing a Contract

� Reviewing Renewal and Administration Rules

� Defining Security Attributes

� Determining Line Duration

� Reviewing Pricing Attributes

2.8.5.1 Selecting Party
Before the renewed contract can be approved, changes may need to be made to the 
parties or contacts. 
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To select a party:
1. Navigate to the Summary tab and select the Parties subtab. 

2. Select the Role from the list of values. The valid values are Vendor, Customer, 
and Third Party.

3. Select the Name from the list of values. The Party Number is automatically 
displayed.

4. Optionally, select the Billing Profile for either the customer or third party.

5. Optionally, enter the party contact Role within the Contracts region.

6. Select the party contact Name from the list of values. The contact address is 
automatically displayed.

7. Select the bill to Account/Party from the list of values within the Bill To region. 
If specified, both customer and third party accounts are listed. Related customer 
accounts, as defined in Oracle Receivables will also be displayed for selection.

8. Select the Location from the list of values.

9. Select the ship to Account/Party from the list of values within the Ship To 
region. If specified, both customer and third party accounts are listed. Related 
customer accounts, as defined in Oracle Receivables will also be displayed for 
selection.

10. Select the Location from the list of values.

2.8.5.2 Repricing a Contract 
Repricing normally occurs at renewal but it is also possible to reprice a contract at 
contract line or covered product level at any time. It could be based on a new price 
list or on a price list in another currency. In the case of repricing in another currency, 
this can be done on condition that no previous billing has been executed for the 
current duration of the contract.

To reprice a contract:
1. Navigate to the Summary > Pricing/Billing.

2. Select a new Price List from the list.

3. If multi-currency repricing is desired, enter the currency code of the price list in 
the header context region.

4. Click Reprice. All service lines are repriced in the new currency and the contract 
total is displayed in the header context region.
Using Oracle Service Contracts 2-93



Managing Contracts
5. Save your work.

2.8.5.3 Reviewing Renewal and Administration Rules
The repricing rules are optionally specified at the time the order is created in Order 
Management. However, if this isn’t the case, the renewal event may specify renewal 
and/or administration rules or they may be retrieved from theGlobal Contracts 
Defaults. These rules are retrieved in the following order of precedence: party, 
organization, and global. If a specific rule is not found at a given level, it is retrieved 
at the subsequent level and ultimately at the global level if they do not exist in the 
other levels. In any case, the renewed contract would have all the elements required 
for renewal and repricing and submit the contract for approval.

To review renewal and administration rules:
1. Navigate to the Summary > Administration.

2. Select or validate the appropriate Quality Assurance Checklist from the list of 
values.

3. Select or validate the appropriate Type (within the Renewal region) from the list 
of values.

4. Select or validate the appropriate Pricing Method from the list of values.

5. If the Pricing Method is Price Book or Markup Percent, validate the Price List by 
selecting the appropriate Price List from the list of values.

6. If the pricing method is Markup Percent, validate the Markup by entering the 
appropriate percent.

7. The PO Required check box may selected from the renewal event or party, 
organization or global levels. If selected, the PO Number field is mandatory. 
Enter the corresponding PO number.

8. Select or validate the appropriate Contract Groups.

9. Select or validate the Process Type Workflow Name, and Workflow Process.

10. Save your work.

2.8.5.4 Defining Security Attributes

To define security attributes:
1. Navigate to the Summary > Security/Text.
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2. Select the security type from the drop down list. The valid values are:

� Group: This specifies contract group security

� User: This specifies user security

3. Select the Group or User Name from the list of values, depending on the 
security type.

4. Select the security level appropriate to the security type. The contract offers 
modify access to any users whose responsibility allows them modify access to 
the application. You can reduce their access by restricting them to read-only for 
this particular contract. However, once you enter information in this security 
field, only the users you name can access the agreement and only with the level 
of security you indicate. If a user has read-only access to the application, 
granting them modify access to a specific contract will give not them access to 
make changes to the agreement. So these security attributes serve only to 
restrict access further, not to grant any additional access. The valid values are:

� Modify: This allows update access to the given contract.

� Read Only: This allows only read access to the given contract.

5. Save your changes.

2.8.5.5 Determining Line Duration
Previously, a single order translated into a single service contract. However, with 
the ability to enter contract details in Order Management, it is possible to merge any 
order line to an existing contract or to the contract on the current order. If a service 
contract has been interfaced via Order Management, the field Order / Line number 
is populated at the service line level on Lines/Accounts tab. If the service contract is 
created manually, this field is disabled.

If customer contacts are entered for the given service line, the address is 
automatically displayed for the corresponding customer contact.

With the ability to merge an order line to an existing contract, the order line 
duration in most cases would be shorter than the contract duration. In order to 
facilitate contract renewal, all the service lines coterminate. In addition, a new line 
attribute has been added to determine the line duration at the time of renewal. This 
attribute would normally be automatically initialized from OM in the Contract 
Details window, however, it may be manually changed during the renewal review. 

To determine the line duration:
1. Navigate to Lines > Effectivities.
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2. If the line duration requires changing, select a duration from the list of values. 
The valid values are:

� Full Duration: At renewal time, the service line would inherit the duration 
of the contract.

� Remaining: At renewal time, the service line duration would remain the 
same but would coterminate with the contract header.

� Do Not Renew: The service line is allowed to expire.

3. Enter Invoice Text. Invoice text may be entered for the invoice imported to AR. 
By default, the invoice text is the same as the product description. However, 
any free text may be entered in this field where there is no validation.

Both attributes are also found at the subline level.

2.8.5.6 Reviewing Pricing Attributes
The upper portion of the Pricing and Products tab includes the pricing attributes for 
the previous contract. If this is the initial contract, the last contract price and 
currency would be null. If this is a renewed contract, the renewal event would have 
populated last contract price and currency. The Final Price is the sum of all the sub 
lines. All three fields are “display only.”

To review the pricing attributes:
1. Navigate to the Lines > Pricing/Products > Effectivities

2. Review the Renewal Type and Invoice Text.

3.  Navigate to Pricing tab.

4. Review the last contract price and currency. Similarly to the upper half of this 
tab, the renewal event would populate these fields but they are null if this is the 
initial contract. 

2.8.6 Renewal Consolidation
Renewing service contracts is an important part of any service business. Each 
contract up for renewal represents an opportunity for revenue that should be easier 
to obtain than a new sale.

Renewing service contracts can be complicated because some organizations will 
always sell a full duration service contract the first time, resulting in a single 
customer having numerous contracts expiring at different times over the course of a 
2-96 Oracle Service Contracts Concepts and Procedures



Managing Contracts
year. This requires the customer be contacted multiple times per year for renewal 
confirmation and perhaps renegotiation. This increases the workload for renewal.

Renewal Consolidation addresses the problem of multiple contracts expiring during 
a year (or other given period) causing multiple renewals. With Renewal 
Consolidation, all the contracts to be renewed over a given period are consolidated 
into a single renewal contract. 

Renewal Consolidation has several benefits:

� The number of renewal contracts is decreased, reducing workload and the 
difficulties imposed by large numbers of contracts.

� Customer relationship is improved. All the customer’s services may be 
included in a single contract, or several consolidated contracts based on how 
the contracts are to be billed.

� It reduces the number of service invoices sent to the customer.

2.8.7 Using Renewal Consolidation 
The renewal consolidation process is initiated after a contract has been renewed, 
which may have been the result of the renewal event where contracts are renewed 
in mass or manually renewed from the Contract Navigator using the right mouse 
click. In both cases the contract is in the “entered” status and is considered the 
“target” contract.

If a contract is not valid for consolidation, you will see the error message “Target 
contract is invalid.” If the target contract is eligible for renewal consolidation, the 
Renewal Consolidation window is displayed and is used to facilitate the selection of 
all the “source” contracts for consolidation. The upper half of the window displays 
all the details of the target contract. The lower half displays all the eligible source 
contracts in a tree structure. The system will by default, automatically select all the 
source contracts for consolidation and place a “**” next to the given source lines. 

The following lines are displayed:

� Service lines

� Sub lines or covered levels, i.e. Party,. Customer,. Site, Product,. Item, 
System

A contract is eligible as a source contract if the following are true:

� Customer account is the same as the target
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� “End date plus one day” of the potential source contract must be prior to the 
new, renewed target contract’s end date

� Potential source contract must be in Active or Expired status

When submitting the renewal consolidation, a concurrent request consolidates all of 
the selected source lines into the target contract. If the services are the same on the 
source and target contracts, the covered levels of those services can be merged into 
one contract line on the target contract. However, it is possible that the coverages 
associated with those services may have been modified by the user. Setting the 
profile option  OKS:Check Coverage Match to “Yes” forces the renewal 
consolidation process to preserve differences in coverage.

The Check Coverage API compares each attribute of the coverage and stops as soon 
as one difference is found. It returns the result to the renewal consolidation process. 
If the coverages are the same, the sublines of the source contract are merged under 
the service of the same name on the target contract. If the coverages are different, a 
new contract line is created on the target contract for the service on the source 
contract. 

The Check Coverage API checks the following attributes:

� Coverage Name

� Coverage Type

� Business Processes

� Preferred Resources

The start dates of the consolidated lines begin one day after the expiration of the 
original source line and all the end dates coterminate with the target contract. When 
the operation instance is reviewed at a later date, i.e. after the concurrent request 
has terminated normally, all the consolidated source lines are identified with “##”. 

When the renewal consolidation or operation instance is created, a source line is 
eligible for consolidation at that point in time. However, between the time it’s 
created and the time it’s submitted, a given source line may have been renewed, 
whether it be by consolidation in another operation instance or renewed manually. 
Therefore, at the time of submission, the system verifies that the source is still 
eligible for consolidation. If not eligible, Oracle Contracts excludes the source line 
from the consolidation.

If a source contract is deselected and the operation instance is submitted for renewal 
consolidation, it may be selected at a later time for consolidation in the same target 
contract as long as the target is still in “entered” status. If the target contract has 
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already been approved and activated, the contract may be consolidated as a source 
in another target contract.

After consolidation has taken place, the target may be opened to verify that all the 
source contracts have been consolidated successfully. The new terms and conditions 
may then be reviewed with the customer. Once the customer agrees with its terms 
and conditions, the contract may be submitted for approval and billed at the 
intervals designated in the contract.

To submit for renewal consolidation:
1. (N) Launch Contracts > Contract Navigator

2. Select a target contract and perform right mouse click to select Renewal 
Consolidation. The Renewal Consolidation window appears.

3. Click Query Source. If there are no contracts eligible as source contracts for the 
target contract, the lower half of the window will remain empty.

4. To deselect a line, highlight the branch and click Deselect Line. If a branch with 
child branches is deselected, all the child branches are also deselected. A single 
child branch may be deselected, as required. If deselected, the source line(s) are 
no longer identified with a “**”. Source lines may be reselected by highlighting 
the line and clicking Select Line. 

5. Verify source lines are valid for consolidation.

6. If you want to save and retrieve the consolidation at a later review, click Save 
(this will create an operation instance).

7. If you want to submit the Renewal Consolidation, click Submit. A concurrent 
request id is immediately displayed. 

8. Open target contract and verify all source contracts have been consolidated 
successfully.

9. Submit contract for approval.

2.8.8 Termination

2.8.8.1 Generate Credit on Termination
While terminating a contract, if billing for a covered level has been run in advance, 
a credit would be generated and sent to AR at that point rather than waiting until 
the end of the contract date. The credit would include the day that the contract is 
terminated (the termination date).  
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For example, a customer has paid for ten days of service in advance (from January 
1st to January 10th), but informs you on January 6th that he wants to end the 
agreement.  If you terminate the contract on January 6th, the customer would be 
credited for 5 days (from January 6th to January 10th

After completing the Termination program, the termination date is displayed and 
the status is changed to Terminated.

2.8.8.2 Contract Termination
Use the following procedures when terminating a contract. 

To terminate a contract:
1. (N) Launch Contracts > Contract Navigator

2. Select the contract(s) that you wish to terminate. Multi selects can be made 
using shift-click, control-click with the mouse.

3. Select Terminate from the menu.

4. Enter the date of termination. The date can be in the past.

5. Select a termination reason from the list of values.

6. A description of the termination reason will be displayed.

7. If terminating multiple contracts, clicking Preview allows you to enter 
additional information regarding the individual contracts being terminated. For 
each contract, you may enter a different termination date and reason. 

8. Click Review to see the information before completing the process.

9. If customer is due a credit for amounts paid prior to the termination date, the 
amount is indicated.

10. Optionally, you may override the calculated amount. The amount entered for 
override cannot be negative and cannot be more than the original credit. 
Entering zero in the override field will not prevent a credit memo from being 
generated, it will generate a credit memo for zero dollars.

11. If you do not wish to generate any credit memo, check the Suppress Credit 
check box.

12. Click Terminate to complete the process.

Having terminated the contract(s), you can run the main billing program to 
generate the necessary billing transactions as a result of the termination.
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2.8.8.3 Terminating a Contract Line 
Use the following procedures when terminating a contract line.

To terminate a contract line:
1. (N) Launch Contracts >Contract Navigator.

2. Select the contract that contains the line to terminate.

3. Double click the contract to open the Contract window.

4. Select the Overview tab. The lines of the contract are displayed in the lower of 
this tabbed window.

5. Select the contract line(s) to terminate.

6. Right mouse click and select Terminate Line from the menu.

7. Enter a termination reason from the list of values. A description of the 
termination reason will be displayed.

8. Click review to see the information before completing the process.

9. If customer is due a credit for amounts paid prior to the termination date, the 
amount is indicated.

10. Optionally, you may override the calculated amount. The amount entered for 
override cannot be negative and cannot be more than the original credit. 
Entering zero in the override field will not prevent a credit memo from being 
generated, it will generate a credit memo for zero dollars.

11. If you do not wish to generate any credit memo, check the Suppress Credit 
check box.

12. Click Terminate to complete the process.

Having terminated the contract line(s), you can run the main billing program to 
generate the necessary billing transactions as a result of the termination.

2.8.8.4 Terminating a Covered Level
Use the following procedures when terminating a covered level (sub line).

To terminate a covered level (subline):
1. (N) Launch Contracts >Contract Navigator.

2. Select the contract in which the covered level needs to be terminated.
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3. Select the individual subline that needs to be terminated.

4. From the Tools menu, select Terminate Subline.

5. Select a termination reason from the list of values. A description of the 
termination reason will be displayed.

6. Click review to see the information before completing the process.

7. If customer is due a credit for amounts paid prior to the termination date, the 
amount is indicated.

8. Optionally, you may override the calculated amount. The amount entered for 
override cannot be negative and cannot be more than the original credit. 
Entering zero in the override field will not prevent a credit memo from being 
generated, it will generate a credit memo for zero dollars.

9. If you do not wish to generate any credit memo, check the Suppress Credit 
check box.

10. Click Terminate to complete the process.

11. Save the contract and run billing.

2.8.9 Extending Contract Line
Anytime the dates of a contract header, line and/or subline are changed, remember 
to verify amounts and billing schedules are updated or retained as appropriate for 
the situation.

To extend a contract line:
1. (N) Launch Contracts >Contract Navigator.

2. Select the contract that contains the line that you wish to extend.

3. Double click the contract to open the Contract window.

4. Select the Overview tab. The lines of the contract are displayed in the lower of 
this tabbed window.

5. Right mouse click and select Extend Line from the menu.

6. Save your changes.
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2.8.10 Grace Period
When a contract is nearing the end date, or has already expired, it may be desirable 
to provide a “grace period” so that service and entitlement may continue while 
progress is made toward negotiating a renewal contract. The grace period is granted 
to the Active or Expired contract, not the renewal contract being negotiated. the 
actual start and end dates of the contract will be unaffected by the decision to add a 
grace period to the contract. The billing schedule also remains unaffected.

You can use the Global Contracts Defaults form to set up a standard grace period 
for the contracts that are renewed.

When an entitlement API is called, it will take into consideration whether a grace 
period has been entered against the contract when calculating entitlement eligibility. 
Entitlement is only extended for those contract lines and sublines that end on the 
same date as the contract end date. For example:

Contract start date   01-JAN-2003   end date   31-DEC-2003

Service 1 start date    01-JAN-2003   end date   31-JAN-2003

Service 2 start date    01-JAN-2003   end date   31-DEC-2003

Service 3 start date    01-OCT-2003   end date   31-DEC-2003

The user updates the contract to add a Grace Period of 30 days, i.e. up to 
30-JAN-2004. Service 2 and Service 3 would be eligible for entitlement during the 
extended period, but not Service 1. 

The same logic applies to sublines and coverage terms. Only those items that end on 
the same day as the contract end date are considered for coverage during the grace 
period. As long as the business processes are eligible for entitlement, the original 
terms associated with the business process (preferred engineer, coverage times, 
reaction times, resolution times, and billing types) will continue through the 
extended period. 

The grace period can be removed from the contract by the user either before the 
contract expires (if the renewal agreement is completed in time) or during the grace 
period once the renewed contract becomes active.

To extend a grace period:
1. Navigate to Summary > Administration.

2. Enter/Remove a Grace Duration (e.g. ‘30’).

3. Enter/Remove a Grace Period (e.g. ‘days’).
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4. Save your work.

Prerequisites
You must set the profile option OKS: Enable Grace Period to Yes at the Site Level to 
update the grace period fields on the contract. 

2.8.11 Mass Change
The Mass Change window allows one attribute of multiple contracts to be updated 
in a single request. The contracts that are eligible for update are based on the scope 
and criteria of mass change. Mass change is allowed for contracts that are in 
appropriate status, where the operation “update online” is permitted. 

2.8.11.1 Mass Change Scope
Mass Change will support changes to a particular instance selected in the update 
level. For example, if changes are to be made at the Organization, it will update 
records pertaining to that Organization.

2.8.11.2 Mass Change Operation Window 
This window allows users to enter scope of mass change request and selection 
criteria. It determines which contracts are to undergo a mass change. The top part of 
the window, the Criteria tab, enables the user to enter the scope (update level and 
update level value), selection criteria (attribute, old value), and the new value for 
the attribute that would be changed. The user will enter the name of the mass 
change to facilitate re-query. Update Level displays the list of values (LOV) to filter 
the contract. Based on the update level, the user selects the value from the LOV. The 
update level is seeded, but may also be restricted by use of the OKS: Mass Change 
Security Level profile option. If the security of the profile option is turned on, the 
list may contain only the Contract and Contract Group levels, otherwise, the 
following is the list of update levels available:

� Organization

� Category

� Contracts Group

� Party

� Contract
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2.8.11.3 Mass Change Attributes 
Mass change permits the following attributes to be changed. Making change on a 
contract has a subsequent cascading effect and therefore needs to be carefully 
considered before allowing such a change. Following attributes are permitted for 
mass change that can be selected from the Attribute’s list of values (LOV) in the 
Mass Change header:

� Contract Group

� Contract Start Date

� Contract End Date

� Price List

� Contract Line Reference

� Product Alias

� Known As

� Coverage Time

� Reaction Time

� Header Bill to Address

� Header Ship to Address

� Sales Person

� Header Billing Contact

� Header Shipping Contact

Field Description

Criteria Tab -

Name Name of the mass change.

Operation Status Status of the mass change request.

Mass Change Details 
Region

 -

Update Level Scope of selecting the contracts for a given mass change 
request.

Value The actual value of the update level.
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Attribute The attribute that is being changed in the mass change.

Old Value The actual value of the attribute that has to be updated. It 
can be a specific value, NULL or ALL.

New Value The value to which the attribute is to be updated.

Results Region  -

Contract Number The number to identify a contract.

Modifier To identify a contract. It goes with the contract number.

Description The description of the contract.

Party Name of the customer party.

Contract Status Current status of the contract. For e.g. entered, signed, 
active etc.

Start Date Start date of the contract.

End Date End date of the contract.

Old Value The actual value of the attribute that has to be updated. It 
can be a specific value, NULL or ALL.

Process Status Status of the mass change operation line

Select To select any particular contracts.

Contract Description Full description of the contract highlighted.

Buttons  -

Deselect All To deselect the contracts.

Select All To select the contracts.

Cancel To cancel the operation

Preview To preview the request. When the button is clicked the 
mass change submission window pops up and 
accordingly you can make selections

View Request Once previewed, you can view your request through 
View Request.

Field Description
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To perform a mass change:
1. Navigate to Mass Change from the Navigator. The Mass Change Operation 

window appears with Criteria window on the top.

2. Enter the Name of mass change. 

3. From Mass Change Details select the value Update Level from the LOV. 

4. Select Value from the LOV. 

5. Select an appropriate Attribute from the LOV. All the attributes supported by 
mass change are listed in this list.

6. Select Old Value and New Value from the LOV.

7. Click Refresh if all entries are correct, or click Cancel and start over.

8. If Refresh button is clicked, all the contracts that meet the criteria are displayed 
in the Result window. By default all the records are selected.

9. To deselect some contracts, check the Select check box.

10. Click Preview. 

11. You have two options: OK or Cancel. 

12. If you click OK, two options are available: Run the Job As Soon As Possible or 
On Specific Day.

13. If Run the Job As Soon As Possible is selected you have the option to View 
request and subsequently View Output. At this stage you can also go back to 
the Mass Change Operation window and make changes to the mass change 
request, if any.

14. Accordingly Submit the request. Again two options will be available: Run the 
Job As Soon As Possible or On Specific Day. If Run the Job As Soon As Possible 
is selected you have the option to View Request and subsequently View Output.

15. Click OK. The mass change concurrent request will be submitted.

16. If you Cancel you will go back to mass change window.

 Submit Submit the mass change request. When the button is 
clicked, the mass change submission window pops up 
and accordingly you can make selections.

Field Description
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2.8.12 Electronic Renewals
Electronic Renewals takes advantage of workflow and XML reporting features to 
offer improved efficiency and improved customer satisfaction. 

This process offers:

� Improved efficiency renewing lower dollar contracts

� Allows resources to be focused on larger contracts and customers

� Improves customer satisfaction by making the renewals process more customer 
driven

2.8.12.1 Overview
Only contracts with the category of Warranty and Extended Warranty are eligible 
for electronic renewals. Contracts of this category may be given a Renewal Rule of 
Electronic Renewal. When the renew contract API recognizes a contract with a 
Renewal Rule of Electronic Renewal, a workflow process is launched and the 
following occurs:

1. A contract is renewed with a status of Entered.

2. A QA Check is run against the contract.

3. If the QA Check fails, a notification is sent to the help desk e-mail address (if 
one has been entered in Global Contracts Defaults).

Once the contract has been corrected, it can be resubmitted and picked up by the 
Autorenew workflow.

4. E-mail notification is sent to the customer (Quote To contact on the contract). 
e-mail contains the following:

Cover Letter (defined in OKC Print Contracts Setup)

A URL for customer to view Quote Letter (defined in OKC Print Contracts 
Setup)

Note: : While submitting the mass change request, if one of the 
request has an error it will display an error message. In this case 
you can resubmit the request after making the changes to that 
request. This can be done till all the contracts in the mass change 
request are successfully processed.
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Account\password that is required to log into the web page and view quote 
(account\password is stored in FND USERS and is associated with the Quote 
To contact)

Upon receipt of the e-mail, the customer may log into the web page to review the 
quote and accept, reject, or request changes to the contract renewal. 

There are two ways for the customer to accept the quote: 

� Payment by Credit Card - the customer provides credit card information. The 
card is validated (via integration to Payment Server). If the card passes 
validation, the contract is put in Signed status.

� Payment by PO – the customer provides a PO Number. A workflow process is 
launched which results in a QA Check being run against the contract. If the QA 
Check passes, the contract status is updated to Submitted for Approval status 
and a notification is sent to the contract approver. If the QA Check fails, a 
notification is sent to the help desk e-mail account.

If the quote is rejected a notification is sent to the help desk e-mail account and the 
contract is placed in Canceled status.

Changes to the quote may be requested by sending an e-mail to the help desk e-mail 
account.

 Prerequisites:
The following prerequisite steps must be performed for Electronic Renewals to 
work properly: 

� Enable the Electronic Renewals option in the Renewal Rule Defaults form. Also 
use this form to set up renewal defaults at the system, party, and organization 
levels. You can set up the threshold amount, currency type, method of payment, 
payment term, help desk e-mail, template set, and billing profile in the Renewal 
Rule Defaults form. The Electronic Renewal rule may also be specified at the 
contract level.

� Create templates for quote letter, cover letter, etc. in OKC Print Contract Setup. 

This is an XML reporting feature supported by Contracts Core. For guidance on 
how to create XML reports, see Oracle Contracts Core Release Notes.

� Define a template set in Define Electronic Renewal Template.

Reports/Templates created in OKC Print Contract Setup are mapped to a 
template set in this setup screen. This is also where you would map reminder 
notices, cancellation notices, or similar reports created in OKC Print Contract 
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Setup that you would like to automatically send to a customer (see 
Autoreminder section).

� Set Profile Option OKS: Electronic Renewal URL to identify the URL that will 
be used for customer responses to Electronic Renewal notifications.

2.8.13 Autoreminder
Service Contracts provides functionality to automate the process of reminding 
customers to renew their contracts. When a contract nears expiration, it may be 
automatically renewed, for example, 90 days prior to its end date. Throughout this 
90 day window, the appropriate level of attention needs to be given to ensure that 
the renewal is secured with the customer. Rather than the sales representative 
having to check for contracts due for renewal and contact customers by phone or 
fax to renew a contract, which would be inefficient, a reminder notice will be 
automatically generated and sent to the customer for review through e-mail. 

Autoreminder notices can automatically be sent by scheduling the Service Contracts 
Autoreminder program to run on a regular basis (for example, nightly). 

The following prerequisite steps must be performed prior to scheduling auto 
reminder notices:

1. Create templates for a quote letter, cover letter, etc. in OKC Print Contract 
Setup. 

This is an XML reporting feature supported by Contracts Core. For guidance on 
how to create XML reports, see Oracle Contracts Core Release Notes Release 11.5.6.01 
(part no. A97257-01).

2. Define a template set using Define Electronic Renewal Template.

Reports/Templates created in OKC Print Contract Setup are mapped to a template 
set in this setup screen. Create templates for a quote letter, cover letter, etc. in OKC 
Print Contract Setup. A Template Set used for Auto reminders may be the same one 
that is used for Electronic Renewals.

3. Associate a Template Set in the Global Contracts Defaults.

Note:  Template JSP files are provided. These files may be used as 
is or modified to achieve the desired look, feel and content in the 
HTML customer interface.
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2.8.14 Reassigning Resources

2.8.14.1 Service Contracts Concurrent Program for Reassigning Resources
Service contracts are generally assigned to a resource that is responsible for 
following through on inquiries from the customer through the life of the contract, 
from the initial sale through the renewal process. If that person moves to another 
department, or leaves the company, the appropriate level of attention may not be 
given to the contract.

This process ensures that contract assignments are correct and that no contract is left 
assigned to an inactive contact.

This concurrent process can be scheduled to run as often as necessary, for example, 
nightly. The process will check all contracts in an ’Entered’ status type. It will 
compare the Vendor Contact resource that is assigned to the contract with the 
resource assigned to the territory that the contract maps to in JTF territory 
management. If the resources are different, the resource associated to the territory 
will overwrite the resource that was assigned to the contract. The resource to which 
the contract is being assigned will receive a workflow notification.

Prerequisites
The JTF Territory assignments will have to be set up. The profile option OKS: Use 
JTF should be set to ’Yes’ to use this process.  The profile option OKS: Enable Sales 
Credits should be set to "Derive".

The resource will have to be assigned to the contract on the Summary Parties tab in 
the Contacts region for the vendor.  

2.8.15 Reporting
Many report programs contain parameters for running the report which enable you 
to narrow down the results that are returned. You can run some reports for as little 
as a single contract to as broad every contract in your database. So where there are 
parameters listed for the reports, this means you can constrain your search to find 
only the contracts that meet criteria in those fields.

2.8.15.1 Contracts QA Report
Use this report to run QA for multiple contracts. The user can select a range of 
contracts based on the following parameters:

� Contract Number range
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� Start Date range

� Contract Status

The user can also choose a report which details the results of the QA for all 
contracts selected, or just for contracts which passed or failed. The report includes 
details of the data checked including whether the checked data had warnings and 
errors and if so, what results where found.

2.8.15.2 OKS Products Not Renewed Report 
This report lists products on contracts that have expired and not been renewed. 
Parameters include organization, range of contract end dates, sales rep, and 
customer. 

2.8.15.3 Service Contract Bookings Report 
This report lists the service contracts booked in a stated period along with the 
corresponding invoice details (if applicable). Parameters are organization, sales 
representative, range of approved dates or start dates, and contract value. You can 
choose to sort this report by any of these parameters as well as the customer name, 
invoice date, invoice number, invoice value, modifier, contract number, or start date.

2.8.15.4 Service Contracts by Status Report
This report allows the sales representative to track contracts by status. Parameters 
include organization, sales rep, customer number or name, currency code, range of 
start dates, range of end dates, status code, and status type.

2.8.15.5 Service Contracts Detail Report
This report will display key details of the contract headers, contract lines, and 
covered products for contracts in the Warranty and Extended Warranty category. It 
will not be possible to extract all Service Agreement information into this report, 
since it is focused on covered products. Parameters include Contract number, 
Customer, Status type, Status code, Start Date (From and To), and End Date (From 
and To).

2.8.15.6 Service Contract Forecast Management Report 
This report allows the sales representative and management to track the anticipated 
close of contract renewals. Parameters include organization, sales rep, status, 
forecast period start and end, minimum and maximum contract values, currency 
code, and revenue recognition date. 
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It can be sorted in two different ways: 

� Sales representative, contract value, status type, customer name

� Status type, status code, contract value, and customer name

2.8.15.7 Service Contract Forecast Summary Report 
This report lists the contracts eligible for renewal for a given period along with the 
recognized revenue date. Parameters are organization, currency code, start and end 
dates, minimum and maximum contract value, and recognized revenue date.

2.8.15.8 Service Contracts Setup Report
The Service Contracts Setup Report is a diagnostic tool provided to facilitate 
debugging of implementation issues. This report also helps in implementation by 
summarizing the set ups and providing information on mandatory set up items. It 
provides a comprehensive report on the set up done in any application environment 
and highlights incomplete mandatory setup steps in red. The output from this 
report is a PDF which can be seen by clicking View Output on the concurrent 
request form after the report is complete.

Profiles Setup: 

This section provides a list of User Profile Option Names and Values set for them. If 
any of the mandatory settings are missing or not properly set, they will be 
highlighted in red. The Profile Setup values and mandatory column are as follows. 

Transaction Type Setup:

For this setup, the report checks for Batch Transaction Source OKS_
CONTRACTS and Transaction Type “Invoice-OKS” and “Credit-OKS.”

Service Key Flexfield Setup: 

Checks whether the key Flexfield Code SERV has been set up. 

Category Setup:

Under Category set up, the report displays the categories and responsibilities 
set and the access level for Service and Warranty Categories.

Oracle Quoting Integration Setup: 

Validates that “OKS” is set for Oracle Quoting Integration.

Time Units Mapping: 

The report displays the user defined time code units.
Using Oracle Service Contracts 2-113



Managing Contracts
Global Contracts Defaults: 

The report shows the values set in the Global Contracts Defaults set up. 

Coverage Template Setup: 

The report shows if any coverage template have been defined for warranty as 
well as service items.

Statuses and Operations:

The report displays all the contract statuses and operations for each status type.

2.8.15.9 Service Contracts Summary Report
This report allows the sales representative to track all contracts by customer. 
Parameters include organization, sales representative, customer name or number, 
and from and to dates.

2.8.15.10 Service Contracts Quote Printing Program for US
This will generate a printed quote for a selection of contracts by country, party, or 
organization for a given X number of days before expiration. The program does not 
create the renewal agreement but prints the details of the entered status renewal 
contract in a report along with a cover letter. This is designed to be a sample report 
that can be tailored to meet the needs of the organization. 

2.8.15.11 Unsupported Install Base Items (Install Base report)
This report lists products in the Install Base which are not currently covered by 
contracts. The purpose of this report is to help the sales reps locate prospects. 
Parameters include territory, sales rep, customer, order source, and a range order 
dates. The order source could be order management, a contract renewal, order 
capture, iStore, etc.

2.8.15.12 Service Contracts Billing Report
When the Contracts Main Billing program completes, a log file is generated. That 
information contains the total value processed, total value successful, and total 
value rejected. For all unsuccessful transactions, further contract information will be 
displayed so that the user can pinpoint the contract and/or line that caused the 
issue. The information includes:

� Contract number and modifier

� Customer bill to account name and number
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� Contract group

� Contract line and subline number

� Item name

� Line amount

� Reason for failure of main billing
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Implementing Oracle Service Contracts

This section describes the setup forms and gives references that help understand the 
underlying dependencies.

The implementation section consists of the following topics:

� Confirming Setups of Oracle Applications

� Setting Up Service Contracts
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3.1 Confirming Setups of Oracle Applications

3.1.0.1 Setup Flowchart
The following flowchart shows the setup process for Service Contracts:

Figure 3–1 Setup Process for Service Contracts
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Complete the following steps in the order shown in this table:

3.1.1 Confirm Setup Steps

Step 1: Setup System Administrator
This step involves the following tasks:

� Define responsibilities. See: Oracle Applications System Administrator’s Guide.

� Set up printers (optional). See: Setting Up Your Printers, Oracle Applications 
System Administrator’s Guide.

Required Step Title

Yes Setup System Administrator

Yes Define Key Flexfields

Yes Define, Calendar, Currency, and Set of Books

Yes Setup Organizations

Optional Setup Locations

Yes Setup Employees

Yes Setup of Inventory

Optional Setup of BOM

Optional Setup of WIP

Yes Setup of Order Management

Yes Setup of Pricing

Optional Setup of Service Request

Optional Setup of Charges

Optional Setup of Knowledge Base

Optional Setup of Notes

Yes Setup of Resources

Yes Setup of Installed Base

Yes Setup of Contracts Core

Optional Setup of Depot Repair
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Step 2: Define Key Flexfields 
When fully installing other applications, such as Oracle Human Resource 
Management or Oracle Inventory, be sure to coordinate the flexfield setup for these 
products before defining the key flexfields for this application. It is not 
recommended to change flexfields frequently.   See Oracle Applications Flexfields 
Guide.

For each key flexfield, perform the following tasks (some are optional):

Define the flexfield structure

Define value sets

Define flexfield segments

Define flexfield segment values

Define security rules

Assign security rules

Define roll–up groups

Define cross–validation rules

Set up the following Accounting flexfield (you may not need to perform this step if 
you have already installed and set up Oracle General Ledger or performed a 
common–applications setup. For additional information, see Oracle General Ledger 
User’s Guide. 

Set up the following Human Resources key flexfields (you may not need to set up 
these key flexfields if you have already installed and set up Oracle Human Resource 
Management Systems or performed a common–applications setup. For additional 
information see Oracle Human Resources User’s Guide.

Grade

Job

Position 

People Group

Step 3: Define Calendars, Currencies, and Set of Books 
If you have defined your calendars, currencies, and set of books while setting up a 
different Oracle Applications product, proceed to the next step. However, if you are 
performing a Multi–Org implementation, see the note below.
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This step involves the following tasks:

� Set up calendars:

� Define period types. See: Defining Period Types in Oracle General Ledger User’s 
Guide.

� Define accounting calendar. See: Defining Calendars in Oracle General Ledger 
User’s Guide.

� Define transaction calendar. See: Defining Transaction Calendars in Oracle General 
Ledger User’s Guide. (Optional)

� Define workday calendar. See: Overview of Workday Calendar in Oracle Bills of 
Materials User’s Guide. (Optional)

� Define exception templates. See: Creating a Workday Exception Template in Oracle 
Bills of Materials User’s Guide. (Optional)

� Define currencies. See: Defining Currencies in Oracle General Ledger User’s Guide.

� Define conversion rate types. See: Defining Conversion Rate Types in Oracle 
General Ledger User’s Guide.

� Assign your set of books to a responsibility. See: Assigning Responsibility to Set of 
Books in Oracle General Ledger User’s Guide.

� Set up currency rates.

� Set up accounting code combinations. See: Setting up Accounting Code 
Combinations in Oracle General Ledger User’s Guide.

� Open and close accounting periods. See: Opening and Closing Accounting Periods 
in Oracle General Ledger User’s Guide.

Step 4: Setup Organizations 
You may not need to perform this step if you have already installed and set up 
Oracle Inventory or performed a common–applications setup. For the following 
tasks relating to setting up organization, See: Oracle Human Resources User’s Guide.

Define organization QuickCodes

Note::  If you are performing a Multi–Org implementation, you 
may optionally create more than one calendar, currency, or set of 
books.   See: Multiple Organizations in Oracle Applications.
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Define business groups (if you want to define new business groups rather than 
using the default Setup Business Group, see the section View–all Responsibility in: 
Setting Up Security for Applications Using Some HRMS windows.

Define organizations

Define human resources organizations

Define legal entities organizations

Define Oracle users for operating–unit organizations

Assign operating units to legal entities

Set up inventory organizations. For the tasks relating to setting up inventory 
organizations, see: Oracle Inventory User’s Guide

Define organization hierarchies. See: Oracle Human Resources User’s Guide

Assign business groups and operating units to responsibilities (make sure that 
the profile option HR: Business Group is set at the responsibility level to the 
business group for that responsibility. See: Oracle Human Resources User’s Guide

Define profile options:

� MO: Security Profile

� Top Reporting Level

Step 5: Setup Locations 
If you are also setting up other Oracle applications, you may already have defined 
locations when you set up those applications.

In Oracle Purchasing, define locations for where you ship, deliver internally, or bill 
the goods and services you order. This is a necessary setup if you plan on importing 
purchase requisitions from the Planner Workbench into Oracle Purchasing. See: 
Setting Up Locations, Oracle Human Resources User’s Guide.

Step 6: Setup Employees 
If you do not install Oracle Human Resource Management Systems with Depot 
Repair, use the Enter Employee form to define and maintain employees in Oracle 
Purchasing, otherwise, the forms in Oracle Human Resource Management Systems 
are used to enter and maintain employees.
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Step 7: Confirm Setup of Inventory
Ensure that all the setups listed below have been reviewed and completed as 
necessary. See: Overview of Setting Up in the Oracle Inventory User’s Guide.

Item flexfield, Account aliases flexfield, Receiving options, Unit of Measure classes, 
Stock locators, Default category set, Item templates, Cost types, Material overhead 
rates, Movement statistics parameters, Transaction types, Interface managers, 
Customer items, Category, Sales orders flexfield, Picking rules, Transaction source 
types, Shortage parameter, Unit of Measure, Item attribute controls, Statuses, Items, 
Cost activities, Freight carriers, Economic zones, Transaction reasons, Profile 
options, Customer items cross reference, Catalog group flexfield, Change 
organization, ATP, Unit of Measure Conversion, Categories, Item catalog groups, 
Accounting periods, Cross-reference types, Material sub-elements, Organization 
shipping network, Account aliases, Purchasing options, Container types, 
Notification list, Stock locator flexfield, Intercompany relations, Planners, Sub 
inventories, Category set, Item types, Item delete constraints, Material overheads, 
Shipping method, and Commodity codes.

Step 8: Confirm Setup of BOM
Ensure that all the following setups have been reviewed and completed as 
necessary. See: Overview of Setting Up in Oracle Bills of Materials User’s Guide.

Profile options, Workday calendar for organization, Resource groups, Departments, 
Overheads with departments, Standard instructions, Exception tables, Define 
parameters, Simulation sets, Resource and resource shifts to departments, 
Alternates, Change order types, Workday calendar, Resources, Locations, 
Overheads, Standard BOM comments, and Delete constraints.

Step 9: Confirm Setup of WIP
Ensure that all the following setups have been reviewed and completed as 
necessary. See: Overview of Setting Up in the Oracle Work in Process User’s Guide.

Profile Options, WIP parameters, WIP accounting class, Schedule Groups, Labor 
Rates, Job and Schedule Documents, and Operation Documents.

Step 10: Confirm Setup of Order Management
Ensure that all the following setups displayed in the table below have been 
reviewed and completed as necessary. See: Overview of Setting Up in the Oracle Order 
Management User’s Guide.
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Profile options, Sales persons, Workflow, Customer classes, Cost of goods sold, 
Credit checking, Freight changes and carriers, Parameters, Tax, Document 
sequences, Customers, Processing constraints, Holds, Pricing, Invoicing, Quick 
codes, Order import sources, Transaction types, Defaulting rules, Attachments, and 
Shipping.

Step 11: Confirm Setup of Pricing
While there may be a few, very limited, instances where a customer would not need 
to use Oracle (Advanced) Pricing when implementing Oracle Service Contracts, in 
the majority of situations it will be needed for discounts or price breaks. In addition, 
the APIs which Oracle Service Contracts calls for pricing covered products are part 
of Oracle (Advanced) Pricing and therefore the product is required if that feature 
will be used. Ensure that all the setups displayed below have been reviewed and 
completed as necessary. See: Overview of Setting Up in the Oracle Pricing User’s Guide. 

Profile options, Pricing attributes, Pricing lookup, Shipping lookup, Line types, 
Freight cost, types, System sourcing, Qualifiers, Attribute sourcing, Order 
Management lookup, Order types, Freight terms, Payment terms, and Event 
phasing.

Step 12: Confirm Setup of Service Request
Ensure that all the following setups displayed in the table below have been 
reviewed and completed as necessary (see the Oracle Service Implementation Guide):

Profile options, Service request types, Business processes, Lookup codes, Problem 
and resolution codes, Billing types, Request status, Request severity and urgencies, 
and Billing rates.

Step 13: Confirm Setup of Charges
Ensure that all the following setups have been reviewed and completed as 
necessary (see the Oracle Charges Implementation Guide): 

Profile Options, Lookup Codes, Billing Types, and Billing Rates.

Step 14: Confirm Setup of Knowledge Base
Ensure that all the following setups have been reviewed and completed as 
necessary (see the Oracle Knowledge Base Implementation Guide): 

Profile Options, and Lookups.
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Step 15: Confirm Setup of Notes
Ensure that all the following setups have been reviewed and completed as 
necessary (see the Oracle Notes Implementation Guide):

Profile Options, Source Type And Note Type Mapping, and Note Types.

Step 16: Confirm Setup of Resources
Ensure that all the following steps have been reviewed and completed as necessary 
(see the Oracle Resources Implementation Guide):

Profile Options, Lookup Codes, Roles, and Role Types.

Step 17: Confirm Setup of Install Base
Ensure that all the following setups displayed below have been reviewed and 
completed as necessary (see the Oracle Install Base Implementation Guide):

Profile options, Product types, System types, Lookup codes, Business processes, 
Split product reasons, Product status codes, Transaction billing types, and Customer 
product configuration.

Step 18: Confirm Setup of Contracts Core
Ensure that all the following setups have been reviewed and completed as 
necessary (see the implementing section of Oracle Contracts Core Concepts and 
Procedures): 

Profile Options, Events, Process Definitions, Quality assurance checklist, Categories, 
Party Role, Contact Role, Lookup Codes, Status and Operations, Sources, 
Termination Reasons, and Managing Change Requests.

Step 19: Confirm Setup of Depot Repair
Ensure that all the following setups have been reviewed and completed as 
necessary (see the Oracle Depot Repair Implementation Guide):

Profile Options, Depot Repair Types, and Depot Repair Reason Codes.

3.2 Service Contracts Setups
Follow the guidelines in this table for setting up Service Contracts.
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3.3 Defining Lookup Codes
To locate Lookup Codes from the navigator, choose Service Contracts Manager > 
Setup > Others > System > Lookups. 

Use the list displayed in the table below to identify lookup codes (QuickCodes) you 
need to define for your implementation. You can enter them in any order. Please 
follow the standard procedure outlined in the Oracle Applications Users Guide.

Step Title

Defining Lookup Codes

Registering Order Capture 

Mapping Time Units of Measure

Setting Up Status and Operations

Defining Quality Assurance Checklist

Defining Access to a Category

Defining Coverage Templates

Defining Contract Groups

Setting Up Library of Articles

Defining a Billing Profile

Defining Service Availability

Defining Service Cotermination

Setting Up Service Pricing and Billing

Setting Up System Profile Options

Defining Key Flexfields

Setting Up Renewal Rule Defaults

Setting Up Subscription Templates

Setting Up Report

Code Description

OKC_ARTICLE_SET Defines sets of articles
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OKC_BILLING_RATE_
CODE_RDF

Billing rate code

OKC_CHANGE_REQUEST_
STATUS

Change request status

OKC_CONTACT ROLE Defines contact roles

OKC_CONTINGENT_
EVENTS

Contingent events

OKC_INHERITANCE_TYPE_
RDF

Inheritance type

OKC_LINE_TYPES Defines top line styles

OKC_PRICE_TYPE Pricing types

OKC_PROCESS_USAGE_
TYPES

Process usage type

OKC_REL_OBJ Related object types

OKC_LINE_RENEWAL_TYPE Defines renewals for line types

OKC_RENEWAL_PRICING_
TYPE

Defines renewal pricing types

OKC_RENEWAL_TYPE Defines renewal types

OKC_ROLE Party contract roles

OKC_RULE_DEF Rule definitions

OKC_RULE_DEF Rule group definitions

OKC_STATUS_TYPE Contract status types

OKC_SUBJECT Standard article subject types

OKC_TERMINATION_ 
REASON

Users must specify a reason for terminating a 
contract

OKC_TIME Seeded time units of measure

OKC_WINDOW_TITLES Dynamic window titles

OKS_CVE_TYPE Coverage type rule

OKS_WHE_TYPE Warranty inheritance rule type

OKS_BILL_ACTIONS Billing action rules

OKS_MEDIA_DEF Invoice media definitions

Code Description
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3.4 Registering Order Capture 
Registration to order capture is required for creating warranty contracts for 
products ordered through Order Management.

Prerequisites
You must define Oracle Service Contracts as an application (System Administrator).

To define registering order capture:
1. From the Navigator, choose Order Capture Sales Manager > Quick Codes.

2. Query lookup: ASO_ORDER_FEEDBACK_CRM_APPS.

3. Enter the code OKS.

4. Enter the code meaning.

5. Optionally, enter the description.

6. Enter the effective dates (from/to dates).

7. Select the enabled check box (if applicable).

8. Save your work.

Guidelines
OKS must be registered to enable contracts to be created for any immediate services 
or delayed services as well as warranties and extended warranties originating from 
Order Management.

OKS_SC_DISTRIBUTION Sales credit definition

OKS_SC_YES_NO Service Contracts yes/no

OKS_SVC_PERIOD Service periods

OKS_USAGE_TYPE Billing types for usage items

OKS_SUB_TYPE Available subscription type items

OKS_MED_PRTY_TYPE Subscription media and property types

Code Description
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3.5 Mapping Time Units of Measure
Oracle Contracts defines unit of measure conversion for time differently from 
Oracle Applications. This helps ensure that the scheduling is more accurate than a 
simple conversion such as 1 month = 30 days, which is only correct for 5 out of the 
12 months. To define your own time unit conversions for extending a contract or for 
scheduling, you must define your own time unit conversions. 

There are five internal time units: minutes, hours, days, months, and years. Make 
sure to map each time unit you want to use in Oracle Service Contracts. An example 
of a mapping: Day (your definition) = 1 day (base definition). 

To map time units of measure:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract > 

Time Units of Measure. 

2. Select a user unit of measure from the list of units of measure.

3. Select the base unit of measure that equals the user unit of measure.

4. If needed, enter conversion information.

5. Optionally, enter a description.

6. Save your work.

For additional information please refer to Maintaining Time Units of Measure in 
Oracle Contracts Core Concepts and Procedures.

3.6 Setting Up Status and Operations
Oracle Contracts enables you to control the operations (such as update on line and 
delete contract) that can be performed on a contract depending upon the category 
assigned to the contract when it is created and the status of the contract (such as 
active or terminated). For example if you define a new status for the status type 
Active then you have to make sure that you specifically allow operations such as 
on-line update. If you create a new status without specifying any allowed 
operations, then you implicitly allow no operations for this contract status. In order 
for the concurrent program Status Change to automatically update contract status 
you must define a default status for each status type.

To define status and operations:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract > 

Status and Operations. 
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2. Select a status type.

3. Optionally, enter additional statuses for the status type, enter the text to display 
in application windows in the Meanings field, and select the default status for 
the contract when it first reaches the stage of the selected status type.

4. For each status, select every category, operation, and level (header or line level) 
combination you want to relate to the status.

5. For each line you created in the Allowed Operations by Category section, select 
Allowed to allow the operation. Clear Allowed to prohibit the operation. 

6. Save your work.

For additional information please refer to Setting Up Status and Operations in Oracle 
Contracts Core Concepts and Procedures.

3.7 Defining Quality Assurance Checklist
Service Contracts validates a contract before you can submit it for approval using a 
quality assurance (QA) checklist. Each checklist consists of one or more processes 
which have been defined in the Setup > Contract > Process Definition screen prior 
to selecting them for the QA Checklist.

In addition to the seeded QA checklist, you can define additional checklists for 
Service Contracts. The seeded QA checklist is executed automatically for any 
contract, even if you create another checklist for the contract. You cannot modify or 
update the default checklist. If you create an additional checklist and would like it 
to default to your contracts during authoring, make sure to set the profile options 
OKS: Default QA Checklist. 

To define a quality assurance checklist:
1. A new checklist can be defined by navigating to Service Contracts Manager > 

Setup > Contract > Quality Assurance. 

2. Enter a name and a description.

3. In the Processes region, select the process that will become a part of the QA 
checklist.

4. Make sure the Active check box is selected.

5. From the Severity list, select one of the following levels:

� Warning: The contract passes Approval.
3-14 Oracle Service Contracts Concepts and Procedures



Defining Coverage Templates
� Stop: The contract does not pass Quality Assurance if this process fails

6. Optionally, override the default values for the parameters.

7. Save your work.

For additional information, please refer to Defining Quality Assurance Checklist in 
Oracle Contracts Core Implementation Guide. 

3.8 Defining Access to a Category
A category is a type of contract, such as a service agreement, subscription 
agreement, or warranty contract. Contract categories are seeded in Oracle Service 
Contracts and do not need to be setup. User defined categories are not supported 
for Service Contracts because certain processes in the application are dependent 
upon data being present that may be missing in a user defined category. The 
structure of the contract is conducive to the needs of the industry for which the 
module is designed and enables a more functionality rich application. 
Responsibilities that have been defined need to be assigned access to a category 
before they can read or modify service contracts. 

Prerequisites
You must define the Responsibilities in System Administrator

To define access to a category:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract > 

Define Categories.

2. Hit F11 to enter the query mode.

3. Select Service Agreement for Class. The class you select determines what 
authoring window is used.

4. In the Responsibilities tab, select at least one name and assign access level rights 
to the name along with effective dates.

5. Save your work.

3.9 Defining Coverage Templates
Service Coverage describes the situations under which the customer is covered for a 
Service. Services are broken down into business processes, that can apply to the 
Service (such as Customer Support or Depot Repair). Coverage Terms are then 
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defined for these Transaction Groups. The information you enter to define coverage 
terms include:

� Coverage Name: This includes coverage name, type, importance level, effective 
dates, warranty inheritance, etc.

� Coverage Times: The days of the week and hours during the day that the 
customer can request service.

� Reaction Times: The amount of time allowed by which action must be initiated 
for a particular process being requested.

� Resolution Times: A fixed time per contract by which a normal operation 
should be restored. 

� Preferred Resources: This is the list of preferred resources that are eligible to 
work on a specific task when a service request is created.

� Billing Types and Rates: For each Business Process, define what types of billing 
are allowed, with limits, as well as labor rates. Billing Types are also available if 
the Coverage Template is identified as a warranty.

Prerequisites
The following must be defined:

Coverage type lookup code (Service Contracts)

Business processes (Customer Support)

Price List (Order Management)

Time zone 

Service Request Severity (Customer Support)

Resource types (Customer Support)

Resources (Customer Support)

Billing types (Customer Support)

Billing rates (Customer Support)

Preventive Maintenance program with the "Complete" status (Advanced 
Service Online)

References
For Coverage Templates field descriptions, see Coverage Template Fields.
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For using Coverage Templates, see Coverage Templates in Using Oracle Service 
Contracts

For setting up Preventive Maintenance program, see Oracle Advanced Service 
Online User Guide.

Entering Coverage Name

To define a coverage template:
1. From the Navigator, choose Service Contracts Manager > Coverage Templates. 

The user can change Coverage Name, Description, Suitable as Exception check 
boxes, and Exception Coverage. Duplicate coverage names are not allowed. In 
the case of an actual Service Coverage, the user will not be able to change 
Coverage dates, Suitable as Exception, and Warranty fields.

2. Enter the name of the coverage template. A duplicate coverage name is not 
allowed.

3. Enter the type of coverage from the list of values.

4. Enter a date range for the effective dates if you want the coverage template to 
expire after a certain time frame. The effective Start Date is mandatory and the 
End date is optional.

5. Enter a brief description of the template.

6. Select an Exception Coverage (optional) from the list of Service Coverage 
Templates.

7. Select the Suitable as Exception check box if this coverage is suitable to use as 
Exception Coverage for another coverage.

8. If applicable, select the Warranty check box. If selected, warranty inheritance 
may be entered. In the case of a coverage template, the Warranty check box may 
be updated, as required. However, if an Inheritance has been entered in 
conjunction with the Warranty check box, the Inheritance must be set to NULL 
before the Warranty check box can be unchecked. Billing Types may be set up 
for warranties as for any other type of coverage.

9. Enter the inheritance criteria if the product can be replaced. This is applicable 
only to Warranty lines. This rule is used whenever a customer product is 
replaced. The replaced customer product will be determined by the inheritance 
type: “R” is the remaining period duration, and “F” is the full new period 
duration. If the inheritance type is “R,” then the replacement product’s 
warranty is the remaining duration of the original warranty. If the inheritance 
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type is “F,” then the replacement product’s warranty is a brand new warranty 
duration.

10. If applicable, select a Preventive Maintenance program from the list of values. 
The list of values displays all Preventive Maintenance programs, with the 
"Complele" status. 

11. Select a Business Process from the list of values, for example, “Hotline Support” 
or “On-Site Support.” 

12. Enter the offset duration or amount of time you would like the service to be 
offset from the service start date. For example, if you want onsite support to 
start one month after the service goes into effect and you may want Hotline 
support to be available immediately.

13. Specify the offset period for the Offset Duration, for example, “hour.” For a 
coverage template, these values are automatically inserted when you specify an 
offset period. The transaction group dates must be within the service dates. For 
an actual instance (access from the Service Contract Authoring form), these 
dates may be changed. If the Offset Duration is modified, the Start and End 
dates are automatically adjusted as long as they’re within the range of the 
service coverage dates, and conversely, if the Start and End dates are modified, 
the Offset Duration is automatically adjusted.

14. Enter a default price list to be used to perform a service from the list of values.

15. Enter the percentage of discount allowed for the transaction group, for example, 
“10%” from the list of values.

Entering Coverage Times

To enter coverage times:
1. Select the Coverage Times subtab.

2. For specific times, enter the desired coverage times. Valid time values range 
from 00:00 to 23:59. Leaving blanks indicates that there is no coverage for a 
given day. For a given business process, the coverage time for, at least, one day 
must be entered.

3. Select a time zone from the list of values. This is a mandatory field.

4. If applicable, click Populate All to set the Start Time and End Time for all days 
as 00:00 and 23:59 respectively.

5. If applicable, select Clear All to set the Start Time and End Time to blanks for all 
weekdays.
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6. If applicable, select the day and click Populate Day to set the Start Time and 
End Time of the selected weekday to 00:00 and 23:59.

Entering Reaction Times

To enter reaction times:
1. Select the Reaction Times subtab.

2. Enter a name for the severity definition, for example, “Level 1” or “Important.”

3. Specify the level of severity, for example, “High” from a list of values.

4. Select the Work Through to override the normal coverage times for that 
transaction. For example, suppose you have 9-to-5 support, five days a week, 
with a 2-hour response time. If a customer calls for support at 4:45 P.M., the 
Work Through feature will allow the customer to receive support by 6:45 that 
evening. If Work Through is deselected the customer will receive support by 
10:45 the next morning.

5. Select the Active check box to allow the entitlements feature to be used for the 
current service’s reaction time. 

6. Enter specific reaction times for each applicable day.
 

Entering Resolution Times

To enter resolution times:
1. Select the Resolution Times subtab.

2. Enter a name for the severity definition, for example, “Level 1” or “Important.”

3. Specify the level of severity, for example, “High” or “Low” from a list of values.

4. Select the Active check box to allow the entitlements feature to be used for the 
current service’s resolution time. 

5. Enter specific resolution times for each applicable day. 

Note: The Workflow field is reserved for future functionality.

Note: : The Resolution Times will be made available to other 
functions (e.g Service Request).
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Entering Preferred Resources
A preferred resource can be retrieved when responding to a service request so that 
the correct resource is assigned when resolving an issue. 

To enter a preferred resource:
1. Select the Preferred Resources subtab.

2. Select the resource Type from the LOV.

3. Enter a resource name or group name.

Entering Billing Types and Billing Rates
The billing types and rates are used when calculating the amount to charge a 
customer when work has been performed. For example, if new parts have been 
installed to fix a problem at a customer site, the bill for the work needs to be 
calculated, taking the coverage on the service contract into account. If parts are 
covered 50% up to a maximum of $300, and the charge for parts was $800, after 
applying the rates agreed on the contract, the charge would be calculated as $500, 
after the maximum discount of $300 has been applied. For the same contract rates, if 
the charge for parts came to $500, the customer would receive the full 50% discount 
($250) since the discount is below the $300 maximum.

To enter billing types and billing rates:
1. Select the Billing Types subtab.

2. Select the billing type from the LOV. Duplicates are not allowed. If the Billing 
Type is labor, the Billing Rates region is enabled.

3. Enter the maximum allowed amount. If you leave this field blank, the upper 
limit would only be restricted by the percentage covered or discount you enter 
in step 4 (below).

4. Enter the percentage covered or discount.

5. Select the Billing Rate Name from the LOV, for example, normal or overtime.

6. Select the UOM from the LOV.

7. Enter the flat rate.

8. Enter the allowed percentage over list price.
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Guidelines
To set up a coverage when creating service contract lines, at least one coverage 
template must be created and linked to the service items defined in Oracle 
Inventory. The number of coverage templates should reflect the number of 
coverages that are applicable to the types of coverages offered.

3.9.1 Coverage Template Fields
The following table displays the fields and field descriptions for the Coverage 
Template window.

Field Description

Name Allows you to enter a coverage name.

Type Enables you to select coverage type such as Gold, Silver, or 
Bronze.

Importance Level Displays Importance Level of the selected Coverage Type. 
Importance Level is mapped to Coverage Type and is a numeric 
indication of coverage priority, with highest priority being ‘1.’ 
Importance Level determines the coverage that will be selected 
when an entitlement call to OKS returns multiple coverages.

Effective Dates Displays effective dates for coverage.

Description Enables you to enter a description for the coverage.

Exception Exception coverage is applicable between the time that a 
coverage expires and the time it is renewed. An exception cover 
can be selected from an LOV.

Suitable as Exception When creating a coverage, you can identify the selected 
coverage “Suitable as Exception” for another coverage. When 
another coverage template is created, the LOV for Exception 
would show the coverage template identified as “Suitable as 
Exception.”

Warranty Select if this is a warranty. Warranty may be updated, as 
required. However, if an inheritance has been entered in 
conjunction with Warranty, then the inheritance must be set to 
NULL before Warranty can be cleared.

Inheritance If the inheritance type is R, then the replacement product 
warranty is the remaining duration of the original warranty. If 
the inheritance type is F, then the replacement product warranty 
is a brand new warranty duration.

Free Upgrade Select the check box if a free upgrade is allowed.
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Transfer Allowed If the coverage is to be transferred when the product is 
transferred to another customer, then select the check box.

Preventive Maintenance 
Program Name

If applicable, select a program from the list of values. The 
Preventive Maintenance programs listed are created in 
Advanced Service Online.

Preventive Maintenance 
Program Description

Displays the description for the Preventive Maintenance 
program.

Schedule button The Schedule button is enabled only when a Preventive 
Maintenance program is associated to the coverage template. 
Click this button to open the Preventive Maintenance Schedule 
form and view or modify the information related to the selected 
Preventive Maintenance program.

Business Process region  -

Offset Duration Enter the offset duration or amount of time you would like the 
service to be offset from the authored contract’s start date. For 
example, set onsite support to start one month after the contract 
comes into effect and set hotline support to be available 
immediately.

Offset Period The unit of measure for the offset duration, such as hour or day.

Start and End Dates These values are automatically inserted when you specify an 
offset period. The transaction group dates may not be outside of 
the service dates. For an actual instance (access from the Service 
Contract Authoring window), these dates may be changed. If 
the Offset Duration is modified, then the start and end dates are 
automatically adjusted as long as they’re within the range of the 
service coverage dates, and conversely, if the start and end dates 
are modified, the offset duration is automatically adjusted.

Price List Enter a default price list to be used to perform a service.

Discount Enter the percentage of discount allowed for the transaction 
group, for example, 10%.

Coverage Times tab  -

Start and End For specific times, enter the desired coverage times. Valid time 
values range from 00:00 to 23:59. Leaving blanks indicates that 
there is no coverage for a given day. For a given business 
process, the coverage time for at least one day must be entered.

Time Zone Identifies time zone for coverage.

Populate All Populates coverage times 7 days per week @ 23:59 hours each 
day.

Field Description
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Clear All Clears all coverage times.

Populate Day Populates selected day @ 23:59 hours

Reaction Times tab  -

Name Enter a name for the severity definition, for example, Level 1 or 
Important.

Severity Specify the level of severity, for example High, from a list of 
values.

Work Through Select Work Through to override the normal coverage times for 
that transaction. For example, suppose you have 9-to-5 support, 
five days a week, with a 2-hour reaction time. If a customer calls 
midweek for support at 4:45 P.M., the Work Through feature 
requires the customer to receive support by 6:45 that evening. If 
Work Through is disabled, then the support representative must 
react to the call by 10:45 the next morning.

Active Select Active to allow the entitlements feature to be used for the 
current service reaction time.

Reaction Times Enter specific reaction times for each applicable day.

Workflow Enter the applicable workflow for each reaction time name 
specified.

Resolution Times tab -

Name Enter a name for the severity definition, for example, Level 1 or 
Important.

Severity Specify the level of severity, for example High, from a list of 
values.

Work Through Select Work Through to override the normal coverage times for 
that transaction.

Active Select Active to allow the entitlements feature to be used for the 
current service resolution time.

Resolution Times Enter specific resolution times for each applicable day.

Preferred Resources tab -

Type Enables you to select a type of resource such as “Engineer.”

Name Identifies preferred resource by name.

Field Description
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3.10 Defining Contract Groups
Contract groups are used to logically group contracts into folders for easy access 
and may be defined as private or public. For example, a set of contracts may be 
grouped by customer or by persons administering the contracts. In addition, a 
contract may exist in multiple groups. The system requirement is that at least one 
group must be defined for the contract. Contracts created via integration with Order 
Management as well as warranties created when a product is created in the Install 
Base are assigned a contract group based on the information provided in the Global 
Contract Defaults. When manually authoring contracts, any contract group can be 
selected from the list of values on the Summary > Administration tab under 
Groups.

From the Navigator, choose Service Contracts Manager > Contract Groups > Define 
Contract Groups. 

For more information please refer to Contract Groups in Oracle Contracts Core 
Concepts and Procedures.

3.11 Setting Up Library of Articles.
Service Contracts supports article management in the same manner as Contracts 
Core. For guidance on how to setup the library of articles, see Oracle Contracts Core 
Concepts and Procedures. 

Billing Types tab -

Service Activity Billing 
Type

Enter the billing type from the list of values. Duplicates are not 
allowed. If the billing type is Labor, then the Billing Rates region 
is enabled showing Flat Rate field.

Up To Amount Enter the maximum allowed amount. Note: There would be no 
upper limit, if you do not enter a value in this field.

% Covered Enter the percentage covered or discount.

Allow Full Discount When checked on the template, provides 100% coverage for 
warranties without requiring setup of billing types. If 
unchecked on the template, the box will be grayed out on the 
contract. Any bill types data populated on the template will 
override the use of this checkbox.

Field Description
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3.12 Setting Up Automatic or Manual Contract Numbering
Service Contracts supports the same contract numbering processes used by 
Contracts Core. Ranges of numbers, prefixes and/or suffixes, manual numbering, 
and number lengths maybe set up for different business groups, operating units, 
classes or categories. For guidance on how to set up automatic and manual contract 
number see Oracle Contracts Core Concepts and Procedures.

3.13 Defining a Billing Profile
All customer account information is set up in Oracle Receivables, which includes a 
single billing profile that is applicable to all customer billings. You can set up 
multiple, ad hoc billing profiles in Oracle Service Contracts. Billing profiles include 
information about accounting and invoicing rules, type of billing, and its frequency. 
Invoices are generated according to the billing profile attributes. The billing engine 
accesses the billing profile and bills accordingly.

You can use the billing profile to overwrite any existing line level billing schedule 
information on the contract authoring form by selecting it in the Cascade Attributes 
form. You can also default billing profile information onto the contract by associate 
a billing profile template to a customer in the Global Contract Defaults form.

Prerequisites
The following options must be defined:

� Accounting Rules

� Invoicing Rules

� Billing Levels

� Recurring Intervals.

To define billing profiles:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract > 

Billing Profile

2. Enter an alphanumeric profile number.

3. Enter the profile description.

4. Select an Accounting Rule from the list of values.

5. Select an Invoicing Rule from the list of values. 
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6. Select a Billing Level from the list of values. 

7. Select One Time or Recurring as the Billing Type option.

8. For the Recurring billing, select a billing Interval from the list of values, for 
example, Month.

9. In the Invoice Offset field, enter the number of days to move forward or push 
back the invoice date.

10. In the Interface Offset field, enter the number of days to move forward or push 
back the date that the billing period will interface to Oracle Receivables.

Guidelines
A billing profile should be defined according to the billing requirements. If multiple 
customer accounts have different billing requirements, the number of billing 
profiles should be defined accordingly. There are no restrictions on the number of 
billing profiles.

3.14 Defining Service Availability
Service availability is used to define the available services for service programs, 
warranties, and extended warranties. For party and for product, it lists exceptions. 
The Generally Available check box determines whether the entries in Product and 
Party tabs are inclusions or exclusions. By selecting the Generally Available check 
box for a service, all products and parties listed will be excluded from receiving that 
service. By leaving the Generally Available check box unselected, the products and 
parties listed will be the only ones eligible to receive that service.

Prerequisites
You must define Service items as well as Serviceable Products in Inventory and 
define Parties in AR.

To define service availability:
1. From the Navigator, choose Service Contracts Manager > Setup > Contract > 

Service Availability.

2. Select a service item from the LOV.

3. Access the Party tab and select the Generally Available check box (if applicable).

4. Enter the effective dates.

5. Select a Party from the LOV.
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6. Enter the start and end dates.

7. Access the Product tab and select the Generally Available check box (if 
applicable).

8. Enter the effective dates.

9. Select a Product from the LOV.

10. Enter the low and high revision numbers (if applicable). 

11. Enter the start and end dates.

12. Save your changes.

3.15 Defining Service Cotermination
The Service Cotermination option enables you to set any or all of a customer’s 
service lines to a pre-determined end date. You can set up the Service 
Cotermination for Parties or Systems. When using Cotermination for a party, set up 
the Cotermination as described below. Then when entering Service Lines for any 
contracts belonging to that party, the end date of the lines can be set to the 
established cotermination date by clicking the Coterminate or Coterminate All 
buttons on the Lines>Effectivities tab.

Any order entered in Oracle Order Management for that party, such as a warranty 
or extended warranty would also take this date into account and should price the 
service accordingly. 

The system level Cotermination is set up in Customer Support and will apply to 
any new items added to the system going forward.

Prerequisites
You must define the parties and their customer accounts in advance.

To define service cotermination:
� For Party Level:

1. From the Navigator, choose Service Contracts Manager > Setup > Contract 
>Service Cotermination.

2. Select a Party from the LOV. The corresponding customer account is displayed.

3. Enter the cotermination day.

4. Enter the cotermination month.
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5. Save your work.

� For System Level:

1. From the Navigator, choose Customer Support > Installed Base > Maintain 
Systems.

2. Select System from the LOV.

3. Enter the cotermination day.

4. Select the cotermination month.

5. Save your work.

3.16 Setting Up Service Pricing and Billing
This topic covers the following set up processes for service pricing and billing:

Invoice Level Loading (Parallel Worker)

Invoice Preview

Transaction Type Setup

Setting Up Batch Transaction Sources

Setting Up Transaction Flexfield Segments

Pricing Service and Usage

The procedures for executing service contract billing involves the following 
concurrent requests:

� Service Contracts Main Billing: According to pricing attributes set up in the 
contract and billing schedule, detailed transactions are generated in the OKS 
billing interface table. 

� Autoinvoice Import Program: The billing transactions are then imported into 
AR. 

Prerequisites
You must define the following:

Transaction Types (AR)

Credit Memo Batch Sources (optional) (AR)

Grouping Rules (optional) (AR)
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Service items Inventory (Inventory)

Applicable service items must be included on one or more price lists (Order 
Management)

Party and customer accounts must be defined (AR)

3.16.1 Invoice Level Loading 
Main Billing utilizes Invoice Level Loading, a parallel program to assign groups of 
invoices to different concurrent programs. The program first determines the 
COUNT for all of the contract lines that qualify for the master request submission. If 
the COUNT is greater than the threshold value (currently set to 500) the program 
splits up the master request into subrequests. There is no setup for this functionality 
other than to enable the profile option. Refer to the OKS: Parallel Worker profile 
option in Implementing Service Contracts Concepts and Procedures for more 
details.

3.16.2 Invoice Preview
In addition to sending billing transactions directly to the Accounts Receivable 
interface table, users have the option of seeing an Invoice Preview. Billing 
transactions can be sent to a separate set of Service Contracts tables. These tables 
will mirror the billing transaction tables used during the normal main billing 
process. Since the invoicing requirements differ at each customer site, a custom 
report should be created to access the required information in these tables.

The tables used for Invoice Preview are:

oks_bcl_pr

oks_bsl_pr

oks_btn_pr

oks_bsd_pr

oks_btl_pr

The preview process will run in much the same way as the normal billing process. It 
will include only those contracts that meet the same criteria that need to be met to 
be included in the actual contract billing process (e.g. status is eligible for invoicing, 
bill on date is due). The process will not include invoices for services not covered 
under contract and not normally billed by the Contracts application (e.g. time and 
material charges).
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If potential billing errors are found in the pre-invoice process, the user would make 
adjustments manually in the appropriate application, e.g. Contracts or Install Base, 
and re-run the pre-invoice report. This iterative process would continue until the 
pre-invoice process gives the expected results, at which point the user may choose 
to run the actual billing process.

The billing process would use the latest data in calculating the invoices, so it should 
be recognized that the actual invoices created may be different from those included 
in the last pre-invoice process, if there is sufficient delay between running the 
process and the actual billing process. Changes may have occurred such as counters 
updated, contracts terminated, new products added to coverage, all of which will 
affect the actual invoices created from the Contracts application.

Contracts data (e.g. contract statuses) will not be automatically updated as a result 
of running the pre-invoice process, e.g. to identify them as ready to bill or not.

The process will include the same information that would normally be sent to AR 
during the actual billing process. Contracts sends either detailed or summary 
information to AR, depending on the value of the OKS: Summary Transactions 
profile option and the value of the Summarized check box on billing profiles that 
may be set up for certain customers.

3.16.3 Transaction Type Setup
Transaction types are used to define the accounting for the debit memos, charge 
backs, commitments, and invoices you create in Receivables. Transaction types also 
determine whether your transaction entries update your customer’s balances and 
whether Receivables posts these transactions to your general ledger. To bill from 
OKS, invoices from OKS must be defined. This is case sensitive and must be entered 
using the exact case.

To define transaction types:
1. From the Responsibilities menu, choose Receivables Manager > Setup > 

Transactions > Transaction Types.

2. Enter a transaction name: Invoice-OKS (this OKS transaction type is case 
sensitive and must be entered as “Invoice-OKS”). Optionally enter a 
description. 

3. Select Invoice as transaction class for this transaction type.

4. Select the Open Receivable check box. This updates your customer balances 
each time you create a complete debit memo, chargeback, or on–account credit 
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with this transaction type. Receivables also includes these transactions in the 
standard aging and collection processes.

5. Select the Post To GL check box to be able to post transactions with this type to 
your general ledger. 

6. Choose a default Printing Option for transactions with this transaction type. 
Select Print or Do Not Print. You can override this value when entering 
transactions.

7. Choose a Transaction Status of Open, Closed, Pending, or Void. Use these 
statuses to implement your own invoice approval system.

8. Select the Allow Freight check box to allow freight to be entered for transactions 
with this transaction type.

9. Select the Tax Calculation check box to let Receivables calculate tax for 
transactions with this transaction type. 

10. Choose a Creation Sign. The default is Positive Sign for transaction types with a 
class of either Guarantee or Deposit. If you are using the Cash Basis accounting 
method, your transaction’s creation sign must be either Positive or Negative. 
You cannot update this field after you enter transactions with this type.

11. If this transaction type’s class is not Deposit or Guarantee and you want to 
restrict the direction in which items with this transaction type can be updated 
by applications entered against them select the Natural Application Only check 
box. If you select this box, Receivables sets Allow Overapplication to No. You 
cannot update this option after you save this transaction type.

12. Enter an Application Rule Set for this transaction type or select one from the list 
of values (optional). An Application Rule Set determines the default payment 
steps when you use the Applications window or AutoLockbox to apply receipts 
to transactions using this type. If you do not enter a rule set, Receivables uses 
the rule set in the System Options window as the default. 

13. If this transaction type’s class is not Deposit or Guarantee, and you did not 
select the Natural Application Only check box, choose whether to Allow 
Overapplication against items with this transaction type by selecting or 
deselecting this box. If you select this check box, Receivables sets Natural 
Application to No and you cannot update it after you save this transaction type. 
If you use the Cash Basis accounting method, the default value is No and you 
cannot change it. 

14. Enter the Receivable Account for transactions with this transaction type. 
Receivables uses this information, along with your AutoAccounting definition, 
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to determine the receivable accounts for transactions with these types. 
Receivables creates a transaction record using this account so you can transfer 
to your general ledger and create a journal entry if the Post To GL check box is 
selected for this transaction type.

15. Enter a Freight Account for transactions with this transaction type. Receivables 
uses this information, along with your AutoAccounting definition to determine 
the freight account for transactions with this transaction type. Receivables skips 
this field if this transaction type’s class is Deposit or Guarantee or if the Allow 
Freight check box is not selected. 

16. Enter a Revenue Account for transactions with this transaction type. 
Receivables skips this field if the Allow Freight is not selected. Receivables uses 
this information, along with your AutoAccounting definition, to determine the 
revenue account for transactions with this transaction type.

17. If this transaction type’s class is Invoice or Debit Memo, enter a Clearing 
Account for transactions with this transaction type. Receivables uses this 
account to hold any difference between the revenue amount specified for the 
Revenue Account and the selling price times the quantity for imported invoice 
lines. Receivables only uses the Clearing Account if you have enabled this 
feature for transaction sources that you use for your imported transactions.

18. If this transaction type’s class is Invoice or Credit Memo, enter an Unbilled 
Receivable Account. When you use the Bill In Arrears invoicing rule, 
Receivables uses this information, along with your AutoAccounting definition, 
to determine the Unbilled Receivable account for transactions with this 
transaction type.

19. If this transaction type’s class is Invoice or Credit Memo, enter an Unearned 
Revenue Account. Receivables uses this information, along with your 
AutoAccounting definition, to determine the unearned revenue account for 
transactions with this transaction type. Receivables only uses this account when 
your transaction’s invoicing rule is Bill In Advance.

20. If this transaction type’s class is Invoice, Credit Memo, or Debit Memo, enter a 
Tax Account. Receivables uses this information along with your 
AutoAccounting definition to determine the tax account for transactions with 
this transaction type. 

21. If this transaction type’s class is either Deposit or Guarantee, enter the Invoice 
Type to use for invoices entered against commitments or deposits with this 
transaction type. When you enter an invoice against either a deposit or a 
guarantee with this transaction type, the value you enter here is the default 
invoice transaction type. 
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22. If this transaction type’s class is Deposit, Guarantee, Debit Memo, or Invoice, 
enter the Credit Memo Type to use when crediting items with this transaction 
type (optional). When you enter a credit memo against an invoice with this 
transaction type, the value you enter here is the default credit memo transaction 
type.

23. Enter the range of dates that this transaction type will be active. The default 
Start Date is today’s date, but you can change it. If you do not enter an End 
Date, this transaction type will be active indefinitely.

24. Save your work.

3.16.4 Setting Up Batch Transaction Sources 
Batch sources control the standard transaction type assigned to a transaction and 
determine whether Receivables automatically numbers your transactions and 
transaction batches. Active transaction batch sources appear as list of values choices 
in the Transactions, Transactions Summary, and Credit Transactions windows.

You can define two types of transaction batch sources:

� Manual: Use manual batch sources with transactions that you enter manually in 
the Transaction and Transactions Summary windows.

� Imported: Use imported batch sources to import transactions into Receivables 
using AutoInvoice.

You can make a batch source inactive by deselecting the Active check box and 
saving your work. Receivables does not display inactive transaction batch sources 
as list of values choices or let you assign them to your transactions.

Suggestion: If you have installed multiple organization support (multi–org), define 
an imported batch source with the same name in each organization (these sources 
can have the same or different settings). This enables you to import order lines that 
belong to different organizations in Oracle Order Management into Receivables.

To set up batch transaction sources:
1. From the Responsibilities menu, choose Receivables Manager > Setup > 

Transactions > Sources.

2. Select the Batch Source tab.

3. Enter OKS_CONTRACTS as the name.

4. Select Imported as the type.
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5. Enter a description.

6. Enter the range of Effective Dates for this source. The Start date is the current 
date, but you can change it. If you do not enter an end date, this transaction 
batch source will be active indefinitely.

7. If this is a Manual source, and you want to automatically number new batches 
you create using this source, select the Automatic Batch Numbering check box 
and enter a Last Number. For example, to start numbering your batches with 
1000, enter 999 in the Last Number field. If you are defining an Imported 
transaction batch source, Receivables automatically numbers the batch with the 
batch source name – request ID.

8. Select the Automatic Transaction Numbering check box and enter a Last 
Number to automatically number new transactions you create using this source. 
You can use automatic transaction numbering with both Imported and Manual 
sources.

9. Select the Copy Document Number to Transaction Number check box 
(optional) to use the same value for both the document number and the 
transaction number for transactions assigned to this source. 

10. Enter Invoice-OKS as the Standard Transaction Type for this batch source. 
When you choose a batch source during transaction entry, this is the default 
transaction type. You can define new transaction types in the Transaction Types 
window.

11. Select the AutoInvoice Options tab.

12. Specify how you want AutoInvoice to handle imported transactions that have 
Invalid Tax Rates. An invalid tax rate is one in which the imported transaction’s 
tax rate does not match its tax code. Enter “Correct” if you want AutoInvoice to 
automatically update the tax rate that you supplied to the one that you defined 
previously for the tax code. Enter “Reject” if you want AutoInvoice to reject the 
transaction. 

13. Specify how you want AutoInvoice to handle imported transactions with 
Invalid Lines by entering either “Reject Invoice” or “Create Invoice.” 

14. Specify how you want AutoInvoice to handle imported transactions that have 
lines in the Interface Lines table that are in a closed period. To have AutoInvoice 
automatically adjust the GL dates to the first GL date of the next open or future 
enterable period, enter “Adjust” in the GL Date in a Closed Period field. This 
attribute is called “GL Date in a Closed Period.” Enter “Reject” to reject these 
transactions. 
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15. Enter a Grouping Rule to use for a transaction line (optional). If you do not 
enter a grouping rule, AutoInvoice uses the following hierarchy to determine 
which rule to use: 

� The grouping rule specified in the Transaction Sources window for the 
batch source of the transaction line. 

� The grouping rule specified in the Customer Profile Classes window for the 
bill–to customer and bill–to site of the transaction line. 

� The grouping rule specified in the Customer Profile Classes window for the 
bill–to customer of the transaction line. 

� The default grouping rule specified in the System Options window.

16. If you want AutoInvoice to require that the revenue amount for each 
transaction line is equal to the selling price times the quantity specified for that 
line, select the Create Clearing check box. Use this option to distribute revenue 
on an transaction in an amount that is not equal to the transaction line amount. 
If you select this check box, AutoInvoice puts any difference between the 
revenue amount and the selling price times the quantity for a transaction into 
the AutoInvoice Clearing account that you have defined. Otherwise, 
AutoInvoice requires that the revenue amount be equal to the selling price 
times the quantity for all of the transactions it is processing. Define your 
clearing account in the Automatic Accounting window. 

17. Indicate whether sales credits can be entered for transactions using this source 
by selecting or deselecting the Allow Sales Credit check box. This option and 
the Require Salesreps option in the System Options window determine whether 
sales credits are optional or required.

18. Select the Customer Information tab.

19. Select "Id" for each option to indicate that AutoInvoice validates your customer 
information for this batch source using an identifier. Choose Value if you use 
this source to import data from a non–Oracle system.

20. Select the Accounting Information tab.

21. Select “Id” to indicate how AutoInvoice validates your Invoice and Accounting 
Rule data for this batch source. 

22. Select “Id” to indicate whether you want AutoInvoice to validate the identifier 
for this batch source.

23. Select the Derive Date check box to derive the default rule start date and default 
GL date from the ship date, rule start date, order date and the default date that 
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you supply when you submit AutoInvoice. If Oracle Inventory is installed, this 
must be selected.

24. Select “Id” to indicate that AutoInvoice validates your Payment Terms for this 
batch source using identifiers.

25. Select “Percent” to indicate that AutoInvoice validates your Revenue Account 
Allocation data for this batch source.

26. Select the Other Information tab.

27. Select “Id” to validate other data except for Agreement, Sales Territory, and 
Related Document. 

28. Select the Sales Credit Validation tab.

29. Select “Id” for first two options to validate information using identifiers for this 
batch source.

30. Select Percent to validate sales credits based on percent.

31. Save your work.

3.16.5 Setting Up Transaction FlexField Segments
Transaction flexfields are descriptive flexfields that AutoInvoice uses to uniquely 
identify transaction lines. Receivables lets you determine how to build your 
transaction flexfield structure and what information you want to capture. To define 
the line-level Transaction Flexfield, query “Line transaction Flexfield” in the title 
field of the Descriptive Flexfield Segments window and enter the text and segments 
associated with this transaction flexfield. 

The table below shows the values for the transaction flexfields.

Column Name Segment Name Value Set Req

INTERFACE_LINE_ATTRIBUTE1 CONTRACT_
NUMBER

OKS_K_
NUMBER

Y

INTERFACE_LINE_ATTRIBUTE2 CONTRACT_
MODIFIER

OKS_K_
NUMBER

N

INTERFACE_LINE_ATTRIBUTE3 INSTANCE_NO CE_
NUMBER30

Y

INTERFACE_LINE_ATTRIBUTE4 BILLED_FROM CE_DATE Y

INTERFACE_LINE_ATTRIBUTE5 BILLED_TO CE_DATE Y
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To set up transaction flexfield segments:
1. From the Responsibilities menu, choose System Administrator > Application > 

FlexField > Descriptive > Segments.

2. Select Oracle Receivables as the application and Line Transaction Flexfield for 
the Title. 

3. Deselect the Freeze Flexfield Definition check box (otherwise you cannot create 
a new record).

4. Select OKS CONTRACTS in the Context Field Values region.

5. Click Segments to edit the definition.

6. Enter the values listed in the above table. Note: These must be entered in upper 
case.

7. Compile the flexfield by selecting Compile.

8. Select the Freeze Flexfield Definition check box to freeze the definition.

3.17 Define Print Contract Setup
Service Contracts supports XML reporting in the same manner as Contracts Core. If 
you are planning to use Electronic Renewals or Autoreminder functionality, you 
need to set up report templates for cover letters, quote letters, and reminder notices. 
For guidance on how to create XML reports, see Oracle Contracts Core Release Notes 
Release 11.5.6.01 (part no. A97257-01).

3.18 Setting up System Profile Options
Use this list to identify profile options you need to change for your implementation. 
You can set these profile options in any order you like. You can access the profile 
option window by navigating to: Service Contracts Manager > Control > Profile 
Option.

To change profile options, please follow the standard procedure outlined in the 
Oracle Applications Users Guide.

INTERFACE_LINE_ATTRIBUTE6 AMOUNT CE_
NUMBER30

Y

Column Name Segment Name Value Set Req
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Option Sample Values Required Description

Sequential Numbering Partially Y Sequential Numbering assigns numbers to 
documents created by forms in Oracle 
financial products and provides a method of 
checking whether documents have been 
posted or lost. This profile option must be 
set at the application level to Always Used. 
Do not set this option at the Responsibility 
level.

OKC: Batch size  N Determines the number of records to be 
updated before they are saved in the 
database (this parameter should be 
fine-tuned by the database administrator).

OKC: Change Request 
Approver

 Able, Marsha N Default change request approver and 
overrides the workflow approver.

OKC: Contract Approver Sysadmin N Default contract approver and overrides 
workflow approver.

OKC: Public Group Creator  Able, Marsha N Privilege to create a public group in Oracle 
Contracts.

OKC: Renewed Contract 
Identifier

R N This identifier will be a prefix attached to 
the system date and shown as a modifier of 
the renewed contract.

OKC: Schedule Rule Alert 
Window

 3 N The number of days before a due task, the 
user is notified of upcoming task.

OKC: Schedule Rule Escalate  1 N Escalate number of days after task has 
missed due date when escalation begins.

OKC: Time UOM Class Time Y Limits the units in the Map Time Units 
window. Note: This is case sensitive and 
"Time" should be entered using the exact 
case.

QP: Time UOM Conversion Oracle Contracts N Allows users to price for service based on 
the calendar, as used by Service Contracts, 
or the standard Oracle Applications 
conversion. If set to Service Contracts, 
pricing will take the calendar into account, 
including irregular length months or leap 
years. 

OKS: Billing Schedule Level Top Level N Default level for billing schedule. Options 
include Equal Amount, Covered Level, Top 
Level.
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OKS: Check Coverage Match Yes N This profile option in used in the renewal 
consolidation. If set to Yes, the renewal 
consolidation process will not consolidate 
lines with different coverage attributes.

OKS: Contract Group for 
Warranties/Ext. Warranty

Service Y This profile option is for setting up the 
contract groups for contracts created from 
Order Management.

OKS: Contracts Validation 
Source

Install Base N Allows the user to define the org 
information that should be referenced when 
creating a contract via Order Management 
(e.g. warranty). Values are Ship from 
Org-Order Management, Sold from 
Org-Order Management, Install Base, and 
Master Org.

OKS: Credit Card Privileges Limited N Contract authoring user interface will use 
these values to determine how much of the 
credit card number to display on the screen.

Valid values are:

All: Complete credit card number is 
displayed.

Limited: The last four digits are 
displayed.

None: The card number is not 
displayed. 

OKS: Credit Processing QA 
Level

 Validate N The QA process uses this to value to 
determine whether to validate the entered 
credit card number by calculating the 
checksum or obtaining authorization.

OKS: Counter Validate Yes N This profile option is used for the Usage 
Counter Validate flag.

OKS: Debug Error Log No N If set to Yes, it will generate a debug file. 
Should remain set to No unless directed by a 
support analyst.

OKS: Default Line Style  Service Y Defines the default line style of a service 
contract. Must be set to Service or Usage. No 
other line styles are supported for Service 
Contracts.

Option Sample Values Required Description
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OKS: Default Pricing Date Subline start date N Defines the date to be used to determine the 
proper price list and pricing effectivity. May 
be contract subline (covered level) start date, 
contract signed date, contract (header) start 
date, sysdate, or top line (service line) start 
date. If not defined, sysdate will be used.

OKS: Default QA Checklist  Default Y The QA checklist specified in this profile 
option is used as the default when authoring 
new contracts. This is different from the 
default QA checklist defined in the Global 
Contract Defaults form, which would be 
used to approve the renewed contract. This 
profile option is for new contracts, created 
during authoring. 

OKS: Default Time Zone EST N Defines default time zone for a coverage 
while authoring (not required, but 
recommended).

OKS: Discounting Privileges Full N Defines the discounting privileges for the 
user. Values are Full, Non-Overridable Only, 
None, and Unlimited.

OKS: Electronic Renewal URL http:// 
webpage.yourcor
p.com:port/jtflog
in.jsp

N URL for web page that will be provided to 
Electronic Renewal Customers to allow 
them to review & respond to renewal 
notifications.

OKS: Enable Install Base 
Integration Messages

Y N Determines if notifications is enabled when 
a warranty or extended warranty has been 
created or updated. If yes, the profile option 
OKS: User name to send install base 
integration messages” must be setup.

OKS: Enable 

 Billing

Yes N If yes, a negative billing (credit) is 
generated. If no, negative values are 
invoiced at zero.

Option Sample Values Required Description
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OKS: Enable Sales Credits  Derive N If set to Derive, upon renewal of the 
contract, this profile option will refer to the 
following other profile options to obtain 
information with which to populate the new 
contract:                                                  -Sales 
Person (unless Use JTF - Yes)

 -Revenue Type Distribution                

 -Revenue Type                                    

 -Vendor Contact                                   

If set to Retain, existing information will be 
copied into the renewed contract.

If this profile option is set to Drop, none of 
this information will populate in the new 
contract. Sales person and sales credit 
information do not copy from the expiring 
contract.

OKS: Enable Grace Period Yes N Indicates whether users should be able set 
up a Grace Period when authoring or 
updating a contract. This site level profile 
option defaults to No which causes Grace 
Period fields on the Contracts authoring 
form to be grayed out. If set to yes, users 
will be able to populate the Grace Duration 
and Grace Period fields.

OKS: Item Display Preference Description Y Use this profile option to specify the display 
order of the Inventory items in Covered 
Product and Covered Item selection of the 
list of values, while creating a subline in the 
Authoring form.

OKS: Mass Change Security 
Level

Basic Y Defines the list of update levels available to 
the user when making the mass change. If 
set to Basic then only the Contract and 
Contract Group level are available to be 
selected for updates. When set to Advanced 
the user can perform mass change updates 
at All levels.

OKS: Minimum Authorized 
Amount

100 N Minimum amount to block if QA level is 
authorize. Refer to profile option OKS: 
Credit Processing QA Level.

OKS: Minimum Service 
Duration

 1 N Defines the minimum duration of a service 
for Order Management.

Option Sample Values Required Description
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OKS: Minimum Service Period  1 N Defines the minimum period of a service for 
Order Management.

OKS: Notify Contract Admin Marsha Able Required 
for 
reassign
ment of 
sales reps

If unable to reassign the sales rep on the 
contract, notification is sent to the contract 
administrator identified here.

OKS: Notify Setup Admin Marsha Able Required 
for 
reassign
ment of 
sales reps

If sales rep setup is incomplete, a 
notification is sent to the user defined here.

OKS: Notify Territory Admin Marsha Able Required 
for 
reassign
ment of 
sales reps

If the Territory setup is incomplete, a 
notification is sent to this user.

OKS: Parallel Worker Yes N If set to Yes, will spawn multiple concurrent 
requests when the Service Contracts Main 
Billing program is run in order to distribute 
the billing load for more efficient handling. 
Only occurs when the billing load exceeds 
500 lines.

OKS: Payment Method for 
Credit Card Transactions

 Credit Card N Mode of payment required for AR interface.

OKS: Raise Credit Memo for IB 
Instance Termination

Yes N This profile option determines if a credit 
memo should to be raised when a contract 
subline is terminated, in case of return, 
termination of a customer product.

OKS: Reprice Warning Message 
Y/N

Yes N Used to suppress warning message while 
repricing or manually overriding the final 
price. If set to NO, warning message “This 
action is irreversible. Do you wish to 
Continue? will be suppressed. Seeded 
default value is YES.

OKS: Revenue Type Dist  100 N This is used for setting the credit percentage 
on a renewal contract for a salesrep. In order 
to pass QA, revenue distribution must equal 
100%. If Enable Sales Credits is set to no, this 
profile option will be ignored. 

Option Sample Values Required Description
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OKS: Revenue Type  Quota N This Profile Option is for setting the Sales 
Credit type, e.g. quota or non-quota, for 
creating the sales credits during renewal. If 
Enable Sales Credits is set to Drop, this 
profile option will be ignored.

OKS: Sales Person  Able, Marsha N This Profile Option sets the default sales 
person for sales credits on a renewal 
contract. It also populates this name into the 
Vendor Contact in the 
Summary>Parties>Party Contact Role. If 
OKS: Use JTF = “Y”, the sales rep is 
retrieved from JTF resources instead of from 
this profile option. If Enable Sales Credits is 
set to Drop this profile option will be 
ignored. 

OKS: Sales Credit Distribution Full N Allows to define total percentage of 
distribution among sales credits.

OKS: Service Request Creator Name Y 

(if using 
automate
d service 
request 
creation)

Sets default username for automated 
creation of service requests.

OKS: SMTP Domain oracle.com Required 
for e-mail 
quote

Domain name of the local (sending) host.

OKS: SMTP Host xyx.oracle.com Required 
for e-mail 
quote

Name of the remote host to which the 
connection is established.

OKS: SMTP Port 25 Required 
for e-mail 
quote

Port number of the remote SMTP server.

OKS: Summary Transactions Yes Y If not specified at the billing profile or 
contract header level, this determines if the 
summary or detailed transactions are sent to 
AR.

OKS: Day UOM Code - - Not in use.

OKS: Month UOM Code - - Not in use.

OKS: Quarter UOM Code - - Not in use.

OKS: Week UOM Code - - Not in use.

Option Sample Values Required Description
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OKS: Year UOM Code - - Not in use.

OKS: Use JTF Y N This Profile Option determines whether to 
use JTF Resources to get the salesrep for a 
renewal contract. If set to “N”, the sales rep 
is retrieved from OKS: Sales Person.If set to 
yes it will retrieve the sales person assigned 
by territory. Must setup territories. Must be 
set to yes if using the Concurrent Program 
for Reassigning Resources. If Enable Sales 
Credits is set to Drop, this profile option is 
not used to populate the sales person 
renewal agreement.

OKS: Use QP for Manual 
Adjustment

Yes N Used to control the integration with QP for 
manual override of the final price. If NO, QP 
will not be used to create or derive price 
adjustments. Whatever final price is entered 
will be stored and no adjustments will be 
recorded. If YES, QP will be used to derive 
price adjustments. All adjustments will be 
stored in OKS, and can be viewed through 
pricing adjustment window. No manual 
override is possible if the service item is not 
priced in the price list. Seeded default value 
is yes.

OKS: User Name to Send 
Contract Transfer Messages

Marsha Able Required 
for 
customer 
product 
transfers

Identifies user to be notified of customer 
product transfers.

OKS: User Name to Send Install 
Base Integration Messages

 Able, Marsha N Identifies the e-mail address of the person to 
be notified whenever a warranty or 
extended warranty has been created or 
updated.

Option Sample Values Required Description
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OKS: Vendor Contact Role  Admin N This profile option sets the role for creating 
contacts during contract renewal. Select any 
role from the LOV to be added to the party 
role contacts which will be copied from the 
expiring contract. This profile option 
populates only the role. The person assigned 
to this role is named in the profile option 
OKS: Sales Person. The Concurrent Process 
for Reassigning Resources looks to the 
Vendor Contact Role of SalesPerson to 
validate the name of the sales rep indicated 
in the territory assignment. Therefore, 
consider setting this profile option to 
SalesPerson. If Use JTF is set to yes and the 
vendor contact role is SalesPerson, this party 
role contact name may be changed to match 
the territory assignment. If Enable Sales 
Credit is set to no, this profile option will be 
ignored. 

OKS: OM Interface Contract 
Category

Service N This profile option determines the Contract 
category for the contracts created from 
Order Management such as Service, 
Warranty, and Subscription.

OKS: Subscription Item Filter All N This profile option determines which items 
the user can select in a subscription line 
under a subscription agreement. If the value 
is "Subscription", only subscription items 
can be selected. If the value is "All", the user 
can select any subscription or products (all 
items except service warranty and usage 
items) at subscription line. This is to enable 
the user to enter charges in subscription 
lines. 

OKS: UOM Code Each N This profile option sets the UOM code for 
covered party, site, system, and customer.

OKS: Unit Price Precision Type 2 N This profile option determines the number 
of digits after the decimal point for Unit 
price.

OKS: Valueset lookup Filter - - Not in use.

OKS: Workflow Success 
Notification

- - Not in use.

OKS: Tolerance Allowed for 
Counter Base Reading

- - Not in use.

Option Sample Values Required Description
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3.19 Setup for Service Key Flexfields 
This key flexfield allows the storage of pricing attributes at the covered product 
level in the contract authoring form. This function is available from the Actions 
menu.

Key Flexfield Registration

To register key flexfields:
1. Log on to Application Developer. 

2. Navigate to Flexfields > Key > Register.

3. Double Click Register to open Key Flexfields form. 

4. Enter Oracle Inventory as the Application. 

5. Enter the code: SERV.

6. Enter the title: ORACLE_SERVICE_ITEM_FLEXFIELD.

7. Enter a description: Item Flex Field that displays segments in different 
sequence. 

8. Enter the Table Application: Oracle Inventory.

9. Enter the Table Name: MTL_SYSTEM_ITEMS_B.

10. Enter the Unique ID Column: INVENTORY_ITEM_ID.

11. Enter the Structure Column: ORGANIZATION_ID.

12. Deselect the Dynamic Inserts Feasible check box. 

13. Select the Check Allow ID Value Sets check box. 

14. Save your work. 

OKS: Check Cov Levels in QA - - Not in use.

Option Sample Values Required Description
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Default Segment Structure

To enter the default segment structure:
1. Navigate to Flexfields > Key > Segments and select View > Query by Example > 

Enter.

2. Enter the Application: Oracle Inventory.

3. Enter the Title: ORACLE_SERVICE_ITEM_FLEXFIELD.

4. Select View > Query by Example > Run. 

5. Deselect the Freeze Flexfield Definition check box.

6. Click Segments.

7. Enter Name: Service Name

8. Enter Column: Segment1

9. Save your work.

10. Close Segment Summary window.

11. Select the Freeze Flexfield Definition check box.

12. Click Compile.

Bug #1408962
Follow this procedure to avoid Bug #1408962

To avoid bug #1408962:
1. Navigate to Flexfields > Key > Segments >View > Query by Example > Enter.

2. Enter the Application: Oracle Inventory

3. Enter the Title: System Items

4. Select View > Query by Example > Run. 

5. Deselect the Freeze Flexfield Definition check box.

6. Select the Freeze Flexfield Definition check box.

7. Click Compile.
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3.20 Setting Up Global Contract Defaults
If renewal rules are not specified in Order Management, a contract will be created 
without any renewal criteria. To renew a contract, renewal criteria should be 
retrieved from the defaults defined at the contract, event, party, organization, and 
global levels. The Renewal Event evaluates the renewal criteria in the following 
precedence and applies them to a renewed contract:

� Contract

� Event

� Party

� Organization

� Global

If a specific rule is not found at a given level, it is retrieved at the subsequent level 
and ultimately at the global level if they do not exist in the other levels. In any case, 
the renewed contract would have all the elements required for renewal and 
repricing and to submit the contract for approval.

Use the Renewal Rule Defaults form to set up renewal defaults at the system, party, 
and organization levels. You can set up the defaults at the system level in the Global 
region of the form. The defaults at the organization and party levels are set up in the 
Parties and Organization tabs respectively. The Administration tab is the same for 
both.

To set up renewal rule defaults:
1. Access the Renewal Rule Defaults form by navigating to Service Contracts 

Manager > Setup > Contract> Global Contracts Defaults.

2. Select the Renewal Type from the drop down list. The valid values are:

� Notify Sales Rep: This will sends a notification to the sales rep, based on the 
territory in which he/she resides, to facilitate the renewal. For example, 
when the sales rep needs to negotiate the pricing with the customer prior to 
sending the contract for approval. 

� Submit for Approval: This will create a renewed contract in an entered state 
awaiting review and approval before it can become active. If the 
autorenewal process has been implemented, a contract with an Active 
Contract renewal type will either become signed or active, depending on 
whether the start date has passed. If the contract has not passed QA 
however, it will remain in an entered state.
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� Active Contract: The renewal event automatically approves and activates 
the contract.

� Do Not Renew: The contract is allowed to expire.

� Electronic Renewal: Places the renewed contract into the Entered status and 
sends a notification to both the sales representative and the customer. The 
customer receives notification in the form of an e-mail with a link to a web 
page. From that page, the customer can review the quote and accept, reject, 
or request changes to the contract renewal.

3. Select the PO Required check box to specify that a purchase order is required 
during the renewal process. If selected, the renewal cannot be sent for approval 
without a purchase order. 

4. Select the Pricing Method from the drop down list. This determines how pricing 
is to take place in contracts during renewals. The valid values are:

� Price List: Renewal pricing is based on the current price list.

� Index: Renewal pricing is based on a markup percentage (%) and a cap 
price list. For example last year’s negotiated markup % is subject to a 
capped list price.

� Manual: Renewal pricing uses last year’s negotiated price. 

5. If either the Price List or Index Pricing methods are selected, then the Price List 
field is enabled. Select a Price List from the list of values. 

6. If the Index Pricing Method is selected, then the Markup% field is enabled. This 
represents the percentage that is to be used to markup or markdown the 
contract lines during contract renewal. The value may be entered as a positive 
or negative percent.

7. Select the Approval Workflow. This workflow is used to approve the renewed 
contract.

8. Select the QA Checklist. This QA Checklist will be used to QA the renewed 
contract.

9. Select a Role from the list of values. The valid values include:

� Customer

� Merchant

� Subscriber

� Third party
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10. Select the Help Desk Email account that should receive notifications when an 
Electronic Renewal contract notification cannot be sent to a customer due to 
problems with the contract renewal.

11. Select the Template Set that will be used for Electronic Renewals.

12. Select the Billing Profile that will be used for Electronic Renewal contracts.

13. Select a group from the LOV for New Order within the Contract Group region.

14. Select a group from the LOV for Renewal.

15. Enter the percentage revenue for Estimated % within the Revenue region. This 
is an estimate to be achieved for the renewed contract.

16. Enter Duration. This represents the duration before the expiration of the 
contract for when it is predicted the percentage revenue will be achieved.

17. Select the period from the list of values.

18. In the Electronic Renewal region, select the Enable check box to enable 
Electronic Renewals.

19. Use the Payment Terms Credit Card field to set up the default payment terms 
for credit card orders. When customers log into the portal web page to respond 
to an Electronic Renewal notification, they may select the Credit Card payment 
method in the process of accepting the contract renewal. When the Credit Card 
payment method is selected, the payment term that is entered in this field is 
defaulted as the payment terms on the contract. 

20. Enter the Threshold Currency and Threshold Amount if the Enable check box 
has been selected. The amount entered will be the threshold amount used to 
determine whether or not a contract qualifies for Electronic Renewals. All 
contracts having a total value less than or equal to the amount entered will 
generate an Electronic Renewal.

21. Use the Grace region to set up a standard grace period for the contracts that are 
renewed. Enter the Duration and Period type.

22. Use the Credit Card Threshold region to specify a threshold amount that would 
make credit card the only available method of payment. In the Credit Card 
Threshold region, enter the threshold Amount and Currency type.

23. You can use the Evergreen Threshold region to set a threshold amount for 
Evergreen renewals such that all contracts below the threshold amount would 
renew and invoice customers automatically. In the Evergreen Threshold region, 
enter the threshold Amount and Currency type.
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24. Navigate to the Organizations > Renewal Rules tab. This tab is used to specify 
the renewal and pricing attributes at the organization level. 

25. Select the Organization Number from the list of values. The Organization Name 
is automatically displayed.

26. Enter the effective Start and End dates for the organization. These fields are 
mandatory. The end date must be greater than the start date.

27. Select the renewal rules per Global defaults. In this tab, the renewal and pricing 
rules are optional.

28. Navigate to the Organizations > Admin tab. The Organization Name and 
effective Start and End dates are displayed.

29. Select the Contract Group, QA Checklist, Approval Workflow, and Role. These 
values are optional.

30. Navigate to the Organizations > Revenue tab. The Organization Name and 
effective Start and End dates are displayed.

31.  Select the Revenue Estimated %, Duration and Period. These values are 
optional.

32. Select the Credit Card Threshold Amount and Currency type. These values are 
optional.

33. Navigate to the Organizations > Electronic Renewal tab. The Organization 
Name and effective Start and End dates are displayed.

34. Enter the Threshold Amount and Currency, Payment Terms for Credit Card, 
Help Desk Email, Template Set, and Billing Profile. These values are optional.

35. Navigate to the Organizations > Preferences tab. The Organization Name and 
effective Start and End dates are displayed.

36. Enter the Evergreen Threshold Amount and Currency type. These values are 
optional.

37. Enter the Grace Duration and Period type. These values are optional.

38. Use the Parties tab to specify the renewal and pricing attributes at the party 
level. Navigate to the Parties > Renewal Rules tab.

39. Select the Party Number from the list of values. The Party Name is 
automatically displayed. 

40. Enter the effective Start and End dates. These dates are mandatory. The end 
date must be greater than the start date.
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41. Select the Renewal Type and Pricing Method. If applicable, enter the Markup% 
and Price List. These values are optional.

42. Navigate to the Parties > Admin tab. This tab has the same administration 
attributes as the Organization > Admin tab. 

43. Select the QA checklist, Approval Workflow and Role. These values are 
optional.

44. Navigate to the Parties > Revenue tab. The Organization Name and effective 
Start and End dates are displayed.

45.  In the Revenue region, enter the Estimated percent, Duration, and Period. 
These values are optional.

46. In the Credit Card Threshold region, enter the Currency type and threshold 
Amount. These values are optional.

47. Navigate to the Parties > Electronic Renewal tab. The Organization Name and 
effective Start and End dates are displayed.

48. Select the threshold Amount and Currency, Help Desk Email, Template Set, and 
Billing Profile. These values are optional.

49. Navigate to the Parties> Preferences tab. The Organization Name and effective 
Start and End dates are displayed.

50. Enter the Evergreen Threshold Amount and Currency type. These values are 
optional.

51. Enter the Grace Duration and Period type. These values are optional.

52. Save your work

3.21 Setting Up Subscription Templates
Subscription items are created in the Inventory Master Items form. Before creating 
the subscription items, a Subscription Template must be created. To set up a 
subscription templates:

1. Open the Subscription Template form by navigating to Service Contracts 
Manager > Subscription Template.

2. In the Name filed, enter a name for the template.

3. In the Description field, enter a description for the template.
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4. In the Subscription Type field, select the type of subscription such as Journals, 
Magazines, and News Letters from the list of values.

5. In the Media Type field, select the type of medium such as Document, Image, 
and Audio from the list of values.

6. In the Fulfillment Channel filed, select of one the following options:

� Order Management: for tangible items that need to shipped

� None: for intangible items

7. In the Frequency field, select one of the following subscription frequency 
options:

� Daily

� Weekly

� Monthly

� Yearly

8. Enter any additional information in the Comments field.

3.22 Service Contracts Setup Report
Service Contracts Setup Report is a diagnostic tool provided to facilitate debugging 
the issues reported in Oracle Service Contracts module. This report also helps in 
implementing Service Contracts by summarizing the set ups. A comprehensive 
report is provided on the setup done in any application environment. This report 
not only summarizes all the setups at one place, but also provides information on 
any mandatory setup that need to be done in that environment for Service 
Contracts to function effectively. This report is part of the Oracle Service Contracts 
module and is applicable only to Service Contracts.

To run the Service Contract Setup report:
1) From the responsibility menu, choose Service Contracts Manager >

Request >Run> Single Request

2) In Name choose “Service Contracts Setup report.”

3) Click Submit.

The report can be viewed from the “View Output” of the concurrent request. The 
output of this report is in PDF format and it gives all the setups done for the Service 
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Contracts Module. If any of the setups are mandatory and are not set, the report will 
highlight them in red. This report consists of mandatory and non-mandatory 
settings. 

� Profiles Setup: This section provides a list of User Profile Option Names and 
Values set for them. If any of the mandatory settings are missing or not properly 
set, they will be highlighted in Red. The Profile Setup values and Mandatory 
column are as follows. 

� Transaction Type Setup: For this setup, the report checks for Batch Transaction 
Source OKS_CONTRACTS and Transaction Type “Invoice-OKS” and 
“Credit-OKS.”

� Service Key Flexfield Setup: Verifies whether the key Flexfield Code SERV has 
been set up. 

� Category Setup: Displays the categories and responsibilities that have been 
setup and the access level for Service and Warranty Categories.

� Oracle Quoting Integration Setup: “OKS” must be set for the Order Quoting 
Integration.

� Time Units Mapping: The report display the user defined time code units.

� Global Contracts Defaults: The report shows the values in the Global Contracts 
Defaults setup. 

� Coverage Template Setup: Shows any coverage templates that have been 
defined for warranty as well as service item.

� Statuses and Operations: Displays all the contract statuses and operations for 
each status type.
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